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Overview

Introduction to scripting in After Effects
A script is a series of commands that tells an application to perform a series of operations. You can use scripts 
in most Adobe applications to automate repetitive tasks, perform complex calculations, and even use some 
functionality not directly exposed through the graphical user interface. For example, you can direct After 
Effects to reorder the layers in a composition, find and replace source text in text layers, or send an e-mail 
message when rendering is complete.

See “Examples” on page 191 for examples of what scripts can do. 

Although both the After Effects expressions language and the After Effects ExtendScript scripting language are 
based on JavaScript, the expressions features and scripting features of After Effects are separate and distinct. 
Expressions cannot access information from scripts (such as variables and functions). Whereas a script tells an 
application to do something, an expression says that a property is something. However, because the After 
Effects expression language and ExtendScript are both based on JavaScript, familiarity with either one is very 
helpful in understanding the other.

The heart of a scriptable application is the object model. When you use Adobe After Effects, you create projects, 
compositions, and render queue items along with all of the elements that they contain: footage, images, solids, 
layers, masks, effects, and properties. Each of these items, in scripting terms, is an object. This guide describes 
the ExtendScript objects that have been defined for After Effects projects. 

The After Effects object model is composed of a project, items, compositions, layers, and render queue items. 
Each object has its own special attributes, and every object in an After Effects project has its own identity 
(although not all are accessible to scripting). You should be familiar with the After Effects object model in order 
to create scripts.

NOTE: JavaScript objects normally referred to as “properties” are consistently called “attributes” in this guide, to 
avoid confusion with After Effects’ own definition of a property (an animatable value of an effect, mask, or 
transform within an individual layer).

Nearly all of what scripting can accomplish replicates what can be done by means of the After Effects graphical 
user interface. A thorough knowledge of the application itself and its graphical user interface is essential to 
understanding how to use scripting in After Effects.

The ExtendScript language
After Effects scripts use the Adobe ExtendScript language, which is an extended form of JavaScript used by 
several Adobe applications, including Photoshop, Illustrator, and InDesign. ExtendScript implements the 
JavaScript language according to the ECMA-262 specification. The After Effects scripting engine supports the 
3rd Edition of the ECMA-262 Standard, including its notational and lexical conventions, types, objects, expres-
sions, and statements. ExtendScript also implements the E4X ECMA-357 specification, which defines access 
to data in XML format.

ExtendScript defines a global debugging object, the dollar ($) object, and a reporting utility for ExtendScript 
elements, the ExtendScript Reflection interface.
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File and Folder Objects: Because path name syntax is very different in different operating systems, Adobe 
ExtendScript defines Fi le  and Folder  objects to provide platform-independent access to the underlying file 
system.

ScriptUI User Interface Module: The ExtendScript ScriptUI module provides the ability to create and interact 
with user interface elements. ScriptUI provides an object model for windows and UI control elements that you 
can use to create a user interface for your scripts. 

Tools and Utilities: In addition, ExtendScript provides tools and features such as a localization utility for 
providing user-interface string values in different languages and global functions for displaying short 
messages in dialog boxes (a ler t , conf irm, and prompt).

External Communication: ExtendScript provides a Socket  object that allows you to communicate with remote 
systems from your After Effects scripts. 

Interapplication Communication: ExtendScript provides a common scripting environment for all Adobe 
applications, and allows interapplication communication through scripts. 

The ExtendScript Toolkit (ESTK)
After Effects includes a script editor and debugger, the ExtendScript Toolkit (ESTK), which provides a conve-
nient interface for creating and testing your own scripts.

To start the ESTK, choose File > Scripts > Open Script Editor. 

If you choose to use another text editor to create, edit, and save scripts, be sure to choose an application that 
does not automatically add header information when saving files and that saves with Unicode (UTF-8) 
encoding. In many text editors, you can set preferences for saving with UTF-8 encoding. Some applications 
(such as Microsoft Word) by default add header information to files that can cause “line 0” errors in scripts, 
causing them to fail.

For detailed information on the ExtendScript Toolkit, see the JavaScript Tools Guide.

The .jsx and .jsxbin file-name extensions
ExtendScript script files are distinguished by the . j sx  file-name extension, a variation on the standard . js  
extension used with JavaScript files. After Effects scripts must include the . j sx file extension in order to be 
properly recognized by the application. Any UTF-8-encoded text file with the . j sx extension is recognized as 
an ExtendScript file.

You can use the ExtendScript Toolkit to export a binary version of an ExtendScript file, which has the 
extension . j sxbin. Such a binary file may not be usable with all of the scripting integration features in After 
Effects.

Activating full scripting features
The default is for scripts to not be allowed to write files or send or receive communication over a network. To 
allow scripts to write files and communicate over a network, choose Edit > Preferences > General (Windows) 
or After Effects > Preferences > General (Mac OS), and select the Allow Scripts To Write Files And Access 
Network option.
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Any After Effects script that contains an error preventing it from being completed generates an error message 
from the application. This error message includes information about the nature of the error and the line of the 
script on which it occurred. The ExtendScript Toolkit (ESTK) debugger can open automatically when the 
application encounters a script error. This feature is disabled by default so that casual users do not encounter 
it. To activate this feature, choose Preferences > General, and select Enable JavaScript Debugger.

Loading and running scripts 

Running scripts directly from the File > Scripts menu
When After Effects starts, it searches the Scripts folder for scripts to load. Loaded scripts are available from 
the File > Scripts menu. 

To run a loaded script, choose File > Scripts > [script name].

If you edit a script while After Effects is running, you must save your changes for the changes to be applied. If 
you place a script in the Scripts folder while After Effects is running, you must restart After Effects for the 
script to appear in the Scripts menu, though you can immediately run the new script using the Run Script File 
command.

Running scripts using File > Scripts > Run Script File
To run a script that has not been loaded, choose File > Scripts > Run Script File, locate and select a script, and 
click Open.

Running scripts from the command line, a batch file, or an AppleScript script
If you are familiar with how to run a script from the command line in Windows or via AppleScript, you can 
send a script directly to the open After Effects application, so that the application automatically runs the script.

To run a script from the command line, call afterfx.exe from the command line. Use the -r switch and the full 
path of the script to run as arguments. This command does not open a new instance of the After Effects appli-
cation; it runs the script in the existing instance.

Example (for Windows):

af ter fx  -r  c : \ scr ipt_path\example_scr ipt . j sx

You can use this command-line technique—together with the software that comes with a customizable 
keyboard—to bind the invocation of a script to a keyboard shortcut.

Following are examples of Windows command-line entries that will send an After Effects script to the appli-
cation without using the After Effects user interface to execute the script.

In the first example, you copy and paste your After Effects script directly on the command line and then run 
it. The script text appears in quotation marks following the af ter fx .exe  -s  command:

af ter fx .exe  -s  "a ler t( "You just  sent  an a ler t  to  After  Ef fec ts") "

Alternatively, you can specify the location of the JSX file to be executed. For example:

af ter fx .exe  -r  c : \myDocuments\Scr ipts \yourAEScriptHere. j sx
af ter fx .exe  -r  "c : \myDo cuments\S cr ipts\Scr ipt  Name with Spaces . j sx"
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How to include After Effects scripting in an AppleScript (Mac OS)
Following are three examples of AppleScript scripts that will send an existing JSX file containing an After 
Effects script to the application without using the After Effects user interface to execute the script.

In the first example, you copy your After Effects script directly into the Script Editor and then run it. The script 
text appears within quotation marks following the DoScript command, so internal quotes in the script must 
be escaped using the backslash escape character, as follows:

te l l  appl icat ion "Adobe After  Ef fec ts  CS6"
DoScript  "a ler t( \"You just  sent  an  a ler t  to  Af ter  Ef fects\" ) "

end te l l

Alternatively, you could display a dialog box asking for the location of the JSX file to be executed, as follows:

set  theFi le  to  choos e  f i le
te l l  appl icat ion "Adobe After  Ef fec ts  CS6"

DoScr ipt  theFi le
end te l l

Finally, this script is perhaps most useful when you are working directly on editing a JSX script and want to 
send it to After Effects for testing or to run. To use it effectively you must enter the application that contains 
the open JSX file (in this example it is TextEdit); if you do not know the proper name of the application, type 
in your best guess to replace “TextEdit” and AppleScript prompts you to locate it.

Simply highlight the script text that you want to run, and then activate this AppleScript:

(*
This  scr ipt  sends  the  current  se lec t ion to  Af ter  Ef fects  as  a  scr ipt .
*)

te l l  appl icat ion "TextEdit "
set  the_scr ipt  to  text  of  f ront  document

end te l l

te l l  appl icat ion "Adobe After  Ef fec ts  CS6"
ac t ivate
DoScr ipt  the_scr ipt

end te l l

Running scripts automatically during application startup or shutdown
Within the Scripts folder are two folders called Startup and Shutdown. After Effects runs scripts in these 
folders automatically, in alphabetical order, on starting and quitting, respectively.

In the Startup folder you can place scripts that you wish to execute at startup of the application. They are 
executed after the application is initialized and all plug-ins are loaded.

Scripting shares a global environment, so any script executed at startup can define variables and functions that 
are available to all scripts. In all cases, variables and functions, once defined by running a script that contains 
them, persist in subsequent scripts during a given After Effects session. Once the application is quit, all such 
globally defined variables and functions are cleared. Be sure to give variables in scripts unique names, so that 
a script does not inadvertently reassign global variables intended to persist throughout a session.

Attributes can also be added to existing objects such as the Application object (see “Application object” on 
page 17) to extend the application for other scripts. 
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The Shutdown folder scripts are executed as the application quits. This occurs after the project is closed but 
before any other application shutdown occurs.

Running scripts from the Window menu
Scripts in the ScriptUI Panels folder are available from the bottom of the Window menu. If a script has been 
written to provide a user interface in a dockable panel, the script should be put in the ScriptUI folder. ScriptUI 
panels work much the same as the default panels in the After Effects user interface.

Instead of creating a Window object and adding controls to it, a ScriptUI Panels script uses the th is  object that 
represents the panel. For example, the following code adds a button to a panel:

var  myPanel  =  this ;
myPanel .add("button" ,  [10 ,  10 ,  100,  30] ,  "To ol  #1") ;

If your script creates its user interface in a function, you cannot use this  as it will refer to the function itself, 
not the panel. In this case, you should pass the this  object as an argument to your function. For example:

funct ion createUI(thisObj)  {
var  myPanel  =  thisObj ;
myPanel .add("button" ,  [10 ,  10 ,  100,  30] ,  "To ol  #1") ;
return  myPanel ;
}

var  myToolsPanel  =  createUI(this) ;

You cannot use the File > Scripts > Run Script File menu command to run a script that refers to this . To make 
your script work with either a Window object (accessible from the File > Scripts menu) or a native panel 
(accessible from the Window menu), check whether this  is a Panel object. For example:

funct ion createUI(thisObj)  {
var  myPanel  =  ( thisObj  instanceof  Panel)  ?  thisObj  :  new Window("pa lette" ,  "My Tools " ,  

[100,  100 ,  300 ,  300]) ;
myPanel .add("button" ,  [10 ,  10 ,  100,  30] ,  "To ol  #1") ;
return  myPanel ;
}

var  myToolsPanel  =  createUI(this) ;

Stopping a running script
A script can be stopped by pressing Esc or Cmd+period (in Mac OS) when the After Effects or the script’s user 
interface has focus. However, a script that is busy processing a lot of data might not be very responsive.
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After Effects scripting reference

This chapter lists and describes JavaScript classes, objects, methods, attributes, and global functions defined by 
After Effects.

The After Effects scripting engine supports ExtendScript, Adobe’s extended version of JavaScript, which imple-
ments the 3rd Edition of the ECMA-262 Standard, including its notational and lexical conventions, types, 
objects, expressions and statements. For a complete listing of the keywords and operators included with 
ECMAScript, refer to ECMA-262.pdf, available at www.ecma-international.org/publications/standards/Ecma-
262.htm. For an overview of the most common keywords and statements available from ECMA-262, see 
“JavaScript keywords and statement syntax” on page 8.

Elements of basic JavaScript relevant to After Effects scripting

JavaScript variables
Scripting shares a global environment, so any script executed at startup can define variables and functions that 
are available to all scripts. In all cases, variables and functions, once defined by running a script that contains 
them, persist in subsequent scripts during a given After Effects session. Once the application is quit, all such 
globally defined variables and functions are cleared. Scripters should be careful about giving variables in scripts 
unique names, so that a script does not inadvertently reassign global variables intended to persist throughout 
a session.

JavaScript keywords and statement syntax
Although it is not possible to provide an exhaustive resource describing usage of JavaScript, the following tables 
provide an overview of keywords, statements, operators, precedence, and associativity.

The following table lists and describes all keywords and statements recognized by the After Effects scripting 
engine.

Table 1 Keywords and Statement Syntax

Keyword/Statement Description

break Standard JavaScript; exit the currently executing loop.

continue Standard JavaScript; cease execution of the current loop iteration.

case Label used in a switch  statement.

default Label used in a switch  statement when a cas e  label is not found.

do. . .whi le Standard JavaScript construct. Similar to the whi le  loop, except loop condition evaluation occurs 
at the end of the loop.

fa ls e Literal representing the Boolean false value.

for  Standard JavaScript loop construct.

http://www.ecma-international.org/publications/standards/Ecma-262.htm
http://www.ecma-international.org/publications/standards/Ecma-262.htm
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JavaScript operators
The following tables list and describe all operators recognized by the After Effects scripting engine and show 
the precedence and associativity for all operators.

Table 2 Description of Operators

for. . . in Standard JavaScript construct. Provides a way to easily loop through the properties of an object.

funct ion Used to define a function.

i f / i f . . . e l se Standard JavaScript conditional constructs.

new Standard JavaScript constructor statement.

nul l Assigned to a variable, array element, or object property to indicate that it does not contain a legal 
value.

return Standard JavaScript way of returning a value from a function or exiting a function.

switch Standard JavaScript way of evaluating a JavaScript expression and attempting to match the expres-
sion’s value to a case  label. 

this Standard JavaScript method of indicating the current object.

t rue Literal representing the Boolean true value.

undef ined Indicates that the variable, array element, or object property has not yet been assigned a value.

var Standard JavaScript syntax used to declare a local variable.

whi le Standard JavaScript construct. Similar to the do ...whi le  loop, except loop condition evaluation 
occurs at the beginning of the loop.

with Standard JavaScript construct used to specify an object to use in subsequent statements.

Operators Description

new Allocate object.

delete Deallocate object.

typeof Returns data type.

void Returns undefined value.

. Structure member.

[] Array element.

( ) Function call.

++ Pre- or post-increment.

–– Pre- or post-decrement.

– Unary negation or subtraction.

~ Bitwise NOT.

! Logical NOT.

* Multiply.

/ Divide.

Keyword/Statement Description
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% Modulo division.

+ Add.

<< Bitwise left shift.

>> Bitwise right shift.

>>> Unsigned bitwise right shift.

< Less than.

<= Less than or equal.

> Greater than.

>= Greater than or equal.

== Equal.

!= Not equal.

& Bitwise AND.

^ Bitwise XOR.

| Bitwise OR.

&& Logical AND.

| | Logical OR.

? : Conditional (ternary).

= Assignment.

+= Assignment with add operation.

–= Assignment with subtract operation.

*= Assignment with multiply operation.

/= Assignment with divide operation.

%= Assignment with modulo division operation.

<<= Assignment with bitwise left shift operation.

>>= Assignment with bitwise right shift operation.

>>>= Assignment with unsigned bitwise right shift operation.

&= Assignment with bitwise AND operation.

^= Assignment with bitwise XOR operation.

|= Assignment with bitwise OR operation.

, Multiple evaluation.

Operators Description
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Table 3 Operator Precedence

The After Effects Object Model
As you look through this reference section, which is organized alphabetically by object, you can refer to the 
following diagrams for an overview of where the various objects fall within the hierarchy, and their correspon-
dence to the user interface.

Hierarchy diagram of the main After Effects scripting objects

Operators (highest precedence to lowest) Associativity

[] ,  ( ) ,  . left to right

new,  delete ,  –  (unar y  negat ion) ,  ! ,  typ eof ,  void ,  ++,  –– right to left

* ,  / ,  % left to right

+,  –  ( subtract ion) left to right

<<,  >>,  >>> left to right

<,  <=,  > ,  >= left to right

==,  != left to right

& left to right

^ left to right

| left to right

&& left to right

| | left to right

? : right to left

=,  /=,  %=,  <<=,  >>=,  >>>=,  &=,  ^=,  |=,  +=,  –=,  *= right to left

, left to right
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Note that the File, Folder, and Socket objects are defined by ExtendScript, and are documented in the JavaS-
cript Tools Guide. ExtendScript also defines the ScriptUI module, a set of window and user-interface control 
objects, which are available to After Effects scripts. These are also documented in the JavaScript Tools Guide. 

The hierarchy of objects in scripting corresponds to the hierarchy in the user interface.

The application contains a Project panel, which displays a project. The project contains compositions, which 
contain layers. The source for a layer can be a footage file, placeholder, or solid, also listed in the Project panel. 
Each layer contains settings known as properties, and these can contain markers and keyframes. The render 
queue contains render-queue items as well as render settings and output modules. All of these entities are repre-
sented by objects in scripting.

NOTE: To avoid ambiguity, this manual uses the term “attribute” to refer to JavaScript object properties, and the 
term “property” or “AE property” to refer to After Effects layer properties.

Object summary
The following table lists all objects alphabetically, with links to the documentation page for each.

Object Description

“Global functions” on page 14 Globally available functions that allow you to display text for script debugging purposes, 
and help convert time values between seconds and frames.

“Application object” on page 17 A single global object, available by its name (app ), that provides access to objects and 
application settings within the After Effects application. 

“AVItem object” on page 30 Represents audio/visual files imported into After Effects.

“AVLayer object” on page 38 Represents those layers that contain AVItem objects (composition layers, footage layers, 
solid layers, text layers, and sound layers).

“CameraLayer object” on page 50 Represents a camera layer within a composition. 

“Collection object” on page 51 Associates a set of objects or values as a logical group and provides access to them by 
index. 

“CompItem object” on page 52 Represents a composition, and allows you to manipulate it and get information about it.
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“FileSource object” on page 61 Describes footage that comes from a file.

“FolderItem object” on page 63 Represents a folder in the Project panel.

“FootageItem object” on page 65 Represents a footage item imported into a project, which appears in the Project panel. 

“FootageSource object” on page 69 Describes the file source of some footage. 

“ImportOptions object” on page 75 Encapsulates options for importing files into After Effects.

“Item object” on page 78 Represents an item in a project that appears in the Project panel. 

“ItemCollection object” on page 82 Collects items in a project.

“KeyframeEase object” on page 84 Encapsulates keyframe ease values in an After Effects property.

“Layer object” on page 86 A base class for layer classes.

“LayerCollection object” on page 95 Collects layers in a project.

“LightLayer object” on page 100 Represents a light layer within a composition.

“MarkerValue object” on page 102 Encapsulates marker values in an After Effects property.

“MaskPropertyGroup object” on 
page 106

Encapsulates mask attributes in a layer.

“OMCollection object” on page 109 Collects output modules in a render queue.

“OutputModule object” on page 110 Represents an output module for a render queue.

“PlaceholderSource object” on page 113 Describes a placeholder for footage.

“Project object” on page 114 Represents an After Effects project.

“Property object” on page 124 Represents an After Effects property.

“PropertyBase object” on page 148 A base class for After Effects property and property group classes.

“PropertyGroup object” on page 155 Represents an After Effects property group.

“RenderQueue object” on page 160 Represents the After Effects render queue.

“RenderQueueItem object” on page 163 Represents a renderable item in a render queue.

“RenderQueueItem object” on page 163 Collects render-queue items in a render queue.

“RQItemCollection object” on page 169 Provides access to application settings and preferences.

“Shape object” on page 172 Encapsulates the outline shape information for a mask.

“ShapeLayer object” on page 178 Represents a shape layer within a composition. 

“SolidSource object” on page 179 Describes a solid color that is the source of some footage.

“System object” on page 180 Provides access to the operating system from the application.

“TextDocument object” on page 182 Encapsulates the text in a text layer.

“TextLayer object” on page 188 Represents a text layer within a composition.

“Viewer object” on page 189 Represents a Composition, Layer, or Footage panel.

Object Description
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Global functions
These globally available functions that are specific to After Effects. Any JavaScript object or function can call 
these functions, which allow you to display text in a small (3-line) area of the Info panel, and to convert 
numeric time values to and from string values.

Additional global functions for standard user I/O (aler t , conf irm, and prompt) and static functions for file
I/O, are defined by ExtendScript; for detailed reference information, see the JavaScript Tools Guide (available 
from the ExtendScript Toolkit’s Help menu). 

clearOutput() global function
clearOutput()

Description

Clears the output in the Info panel.

Parameters

None.

Returns

Nothing.

currentFormatToTime() global function
currentFormatToTime( formattedTime,  fps ,  i sDuration)

Description

Converts a formatted string for a frame time value to a number of seconds, given a specified frame rate. For 
example, if the formatted frame time value is 0:00:12 (the exact string format is determined by a project 
setting), and the frame rate is 24 fps, the time would be 0.5 seconds (12/24). If the frame rate is 30 fps, the time 
would be 0.4 seconds (12/30).

If the time is a duration, the frames are counted from 0. Otherwise, the frames are counted from the project’s 
starting frame (see “Project displayStartFrame attribute” on page 117).

Parameters

Global function Description

clearOutput() Clears text from the Info panel.

currentFormatToTime() Converts string time value to a numeric time value.

t imeToCurrentFormat() Converts a numeric time value to a string time value.

write() Writes text to the Info panel, with no line break added.

writeLn() Writes text to the Info panel, adding a line break at the end.

i sVal id() When true, the specified object exists.

formattedTime The frame time value, a string specifying a number of frames in the project’s current time display format.

fps The frames-per-second, a floating-point value.
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Returns

Floating-point value, the number of seconds.

isValid() global function
i sVal id(obj)

Description

Determines if the specified After Effects object (e.g., composition, layer, mask, etc.) still exists. Some opera-
tions, such as the Prop er tyBase  moveTo()  method, might invalidate existing variable assignments to related 
objects. This function allows you to test whether those assignments are still valid before attempting to access 
them.

Parameters

Returns

Boolean.

Example

var  layer  = app.projec t .ac t iveItem. layer(1) ; / /  assume layer  has  three  masks
a ler t( i sVal id( layer)) ; / /  d isplays  “t rue”
var  mask1 = layer.mask(1) ;
var  mask2 = layer.mask(2) ;
var  mask3 = layer.mask(3) ;
mask3.moveTo(1) ; / /  move the  third mask to  the  top  of  the  mask stack
a ler t( isVal id(mask1)) ; / /  displays  “fa ls e” ;  mask2 and mask3 do  as  wel l

timeToCurrentFormat() global function
t imeToCurrentFormat( t ime,  fps ,  i sDuration)

Description

Converts a numeric time value (a number of seconds) to a frame time value; that is, a formatted string that 
shows which frame corresponds to that time, at the specified rate. For example, if the time is 0.5 seconds, and 
the frame rate is 24 fps, the frame would be 0:00:12 (when the project is set to display as timecode). If the frame 
rate is 30 fps, the frame would be 0:00:15. The format of the timecode string is determined by a project setting.

If the time is a duration, the frames are counted from 0. Otherwise, the frames are counted from the project’s 
starting frame (see “Project displayStartFrame attribute” on page 117).

Parameters

i sDurat ion Optional. When true, the time is a duration (measured from frame 0). When false (the default), the time is 
measured from the project’s starting frame. 

obj The After Effects object to check for validity.

t ime The number of seconds, a floating-point value.

fps The frames-per-second, a floating-point value.
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Returns

String in the project’s current time display format.

write() global function
write( text)

Description

Writes output to the Info panel, with no line break added.

Parameters

Returns

Nothing.

Example

write( "This  text  appears  in  Info panel  " ) ;
wr ite( "with more on same l ine." ) ;

writeLn() global function
writeLn( text)

Description

Writes output to the Info panel and adds a line break at the end.

Parameters

Returns

Nothing.

Example

write ln("This  text  appears  on f i rs t  l ine") ;
wr ite ln("This  text  appears  on second l ine") ;

i sDurat ion Optional. When true, the time is a duration (measured from frame 0). When false (the default), the time is 
measured from the project’s starting frame. 

text The string to display. Truncated if too long for the Info panel.

text The string to display. 
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Application object
app

Description

Provides access to objects and application settings within the After Effects application. The single global object 
is always available by its name, app. 

Attributes of the Application object provide access to specific objects within After Effects. Methods of the 
Application object can create a project, open an existing project, control Watch Folder mode, purge memory, 
and quit the After Effects application. When the After Effects application quits, it closes the open project, 
prompting the user to save or discard changes as necessary, and creates a project file as necessary.

Attributes

Attribute Reference Description

projec t “Application project attribute” on 
page 26 and “Project object” on 
page 114

The current After Effects project.

i soL anguage “Application isoLanguage attribute” on 
page 22

The locale (language and region) in which the applica-
tion is running.

vers ion “Application version attribute” on 
page 29

The version number of the After Effects application.

bui ldName “Application buildName attribute” on 
page 19

The name of this build of the application.

bui ldNumber “Application buildNumber attribute” on 
page 20

The number of this build of the application.

i sWatchFolder “Application isWatchFolder attribute” on 
page 23

When true, the local application is running in Watch 
Folder mode.

i sRenderEngine “Application isRenderEngine attribute” 
on page 23

When true, the local After Effects application is running 
as a render engine.

sett ings “Application settings attribute” on 
page 28 and “RQItemCollection object” 
on page 169

Application settings that can be set via scripting.

onError “Application onError attribute” on 
page 24

A callback function that is called when an error occurs 
in the application.

exitC ode “Application exitCode attribute” on 
page 22

A numeric status code used when executing a script 
externally (that is, from a command line or AppleScript). 
0 if no error occurred. A positive number indicates an 
error that occurred while running the script.

exitAfterL aunchAndEval “Application exitAfterLaunchAndEval 
attribute” on page 22

When true, the application remains open after running 
a script from the command line on Windows.

saveProjec tOnCrash “Application saveProjectOnCrash attri-
bute” on page 27

When true, the project is saved if the application closes 
unexpectedly.

memor yInUse “Application memoryInUse attribute” on 
page 23

Memory in use by this application.

ef fec ts “Application effects attribute” on 
page 20

The effects available in the application.

ac t iveViewer “Application activeViewer attribute” on 
page 19

The currently focused or last-focused viewer panel.
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Methods

Application activate() method
app.ac t ivate()

Description

Opens the application main window if it is minimized or iconified, and brings it to the front of the desktop.

Parameters

None.

Method Reference Description

newProjec t() “Application newProject() method” on 
page 24

Creates a new project in After Effects.

open() “Application open() method” on page 24 Opens a project or an Open Project dialog box.

quit() “Application quit() method” on page 27 Quits the application.

watchFolder() “Application watchFolder() method” on 
page 29

Starts Watch Folder mode; does not return 
until Watch Folder mode is turned off.

pauseWatchFolder() “Application pauseWatchFolder() method” 
on page 26

Pauses a current watch-folder process.

endWatchFolder() “Application endWatchFolder() method” on 
page 21

Ends a current watch-folder process.

purge() “Application purge() method” on page 26 Purges a targeted type of cached information 
(replicates Purge options in the Edit menu).

beginUndoGroup() “Application beginUndoGroup() method” 
on page 19

Groups the actions that follow it into a single 
undoable step.

endUndoGroup() “Application endUndoGroup() method” on 
page 21

Ends an undo group; needed only when a 
script contains more than one undo group.

beg inSuppressDialogs() “Application beginSuppressDialogs() 
method” on page 19

Begins suppression of dialogs in the user inter-
face.

endSuppressDia logs() “Application endSuppressDialogs() 
method” on page 21

Ends suppression of dialogs in the user inter-
face.

setMemor yUsageLimits() “Application setMemoryUsageLimits() 
method” on page 28

Sets memory usage limits as in the Memory & 
Cache preferences area.

setSavePreferencesOnQuit() “Application setSavePreferencesOnQuit() 
method” on page 28

Sets whether preferences are saved when the 
application is quit.

ac t ivate() “Application activate() method” on page 18 Brings the After Effects main window to the 
front of the screen.

scheduleTask() “Application scheduleTask() method” on 
page 27

Schedules a JavaScript script for delayed exe-
cution.

cancelTask() “Application cancelTask() method” on 
page 20

Cancels a scheduled task.

parseSwatchFi le() “Application parseSwatchFile() method” on 
page 25

Loads a color swatch from an Adobe Swatch 
Exchange (ASE) file.
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Returns

Nothing.

Application activeViewer attribute
app.ac t iveViewer

Description

The Viewer object for the currently focused or active-focused viewer (Composition, Layer, or Footage) panel. 
Returns null if no viewers are open.

Type

Viewer object; read-only.

Application beginSuppressDialogs() method
app.beg inSuppressDialogs()

Description

Begins suppression of script error dialog boxes in the user interface. Use endSuppressDia logs() to resume the 
display of error dialogs. See “Application endSuppressDialogs() method” on page 21.

Parameters

None.

Returns

Nothing.

Application beginUndoGroup() method
app.beg inUndoGroup(undoStr ing )

Description

Marks the beginning of an undo group, which allows a script to logically group all of its actions as a single 
undoable action (for use with the Edit > Undo/Redo menu items). Use the endUndoGroup() method to mark 
the end of the group. (See “Application endUndoGroup() method” on page 21.)

beginUndoGroup() and endUndoGroup() pairs can be nested. Groups within groups become part of the 
larger group, and will undo correctly. In this case, the names of inner groups are ignored.

Parameters

Returns

Nothing.

Application buildName attribute
app.bui ldName

undoStr ing The text that will appear for the Undo command in the Edit menu (that is, “Undo <undoStr ing>”)
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Description

The name of the build of After Effects being run, used internally by Adobe for testing and troubleshooting.

Type

String; read-only.

Application buildNumber attribute
app.bui ldNumber

Description

The number of the build of After Effects being run, used internally by Adobe for testing and troubleshooting.

Type

Integer; read-only.

Application cancelTask() method
app.cancelTask( taskID )

Description

Removes the specified task from the queue of tasks scheduled for delayed execution.

Parameters

Returns

Nothing.

Application effects attribute
app.ef fec ts

Description

The effects available in the application.

Type

Array, with each element containing the following properties; read-only:

Example

var  e f fec tName = app.ef fects [12] .d isplayName;

taskID An integer that identifies the task, as returned by app.s cheduleTask() .

displayName String representing the localized display name of the effect as seen in the Effect menu.

categor y String representing the localized category label as seen in the Effect menu. This can be "" for synthetic 
effects that aren’t normally shown to the user.

matchName String representing the internal unique name for the effect. This name does not change between ver-
sions of After Effects. Use this value to apply the effect.
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Application endSuppressDialogs() method
app.endSuppressDia logs(aler t)

Description

Ends the suppression of script error dialog boxes in the user interface. Error dialogs are displayed by default; 
call this method only if b eginSuppressDia logs()  has previously been called. See “Application beginSuppress-
Dialogs() method” on page 19.

Parameters

Returns

Nothing.

Application endUndoGroup() method
app.endUndoGroup()

Description

Marks the end of an undo group begun with the app.b eginUndoGroup()  method. You can use this method to 
place an end to an undo group in the middle of a script, should you wish to use more than one undo group for 
a single script.

If you are using only a single undo group for a given script, you do not need to use this method; in its absence 
at the end of a script, the system will close the undo group automatically.

Calling this method without having set a beg inUndoGroup()  method yields an error.

Parameters

None.

Returns

Nothing.

Application endWatchFolder() method
app.endWatchFolder()

Description

Ends Watch Folder mode.

Parameters

None.

Returns

Nothing.

a ler t Boolean; when true, errors that have occurred following the call to beginSuppressDia logs()  are displayed in a 
dialog box.
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See also

“Application watchFolder() method” on page 29
“Application parseSwatchFile() method” on page 25
“Application isWatchFolder attribute” on page 23

Application exitAfterLaunchAndEval attribute
app.exitAfterL aunchAndEval

Description

This attribute is used only when executing a script from a command line on Windows. When the application 
is launched from the command line, the –r or –s  command line flag causes the application to run a script 
(from a file or from a string, respectively). 

If this attribute is set to true, After Effects will exit after the script is run; if it is false, the application will remain 
open.

This attribute only has an effect when After Effects is run from the Windows command line. It has no effect 
in Mac OS.

Type

Boolean; read/write.

Application exitCode attribute
app.exitC ode

Description

A numeric status code used when executing a script externally (that is, from a command line or AppleScript). 

• In Windows, the value is returned on the command line when After Effects was launched on the command 
line (using the af ter fx or af ter fx  –m command), and a script was specified with the –r  or –s option.

• in Mac OS, the value is returned as the AppleScript DoS cr ipt  result for each script.

In both Mac OS and Windows, the value is set to 0 (EXIT_SUCCESS) at the beginning of each script evalu-
ation. In the event of an error while the script is running, the script can set this to a positive integer that 
indicates what error occurred. 

Type

Integer; read/write.

Example

app.exitC ode = 2 ;  / /on quit ,  i f  va lue  is  2 ,  an  error  has  o ccurred

Application isoLanguage attribute
app. isoL anguage

Description

A string indicating the locale (language and regional designations) After Effects is running.

NOTE: $ . loca le  returns the operating system language, not the language of the After Effects application.
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Type

String; read-only. Some common values include:

• en_US for English (United States)

• de_DE for German (Germany)

• es_ES for Spanish (Spain)

• f r_FR for French (France)

• i t_IT for Italian (Italy)

• ja_JP for Japanese (Japan)

• ko_KR for Korean (Korea)

Example

var  lang  = app. isoL anguage;
i f  ( lang == "en_US")

a ler t( "Af ter  Ef fec ts  is  running in  Engl ish . ") ;
e ls e  i f  ( lang == " f r_FR")

a ler t( "Af ter  Ef fec ts  is  running in  French.") ;
e ls e

a ler t( "Af ter  Ef fec ts  is  not  running in  Engl ish or  French.") ;

Application isRenderEngine attribute
app. isRenderEngine

Description

True if After Effects is running as a render engine.

Type

Boolean; read-only.

Application isWatchFolder attribute
app. isWatchFolder

Description

True if the Watch Folder dialog box is currently displayed and the application is currently watching a folder 
for rendering. 

Type

Boolean; read-only.

Application memoryInUse attribute
app.memor yInUse

Description

The number of bytes of memory currently used by this application. 
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Type

Number; read-only.

Application newProject() method
app.newProjec t()

Description

Creates a new project in After Effects, replicating the File > New > New Project menu command. 

If the current project has been edited, the user is prompted to save it. If the user cancels out of the Save dialog 
box, the new project is not created and the method returns null. Use app.projec t .c lose(Clos eOp-
t ions .D O_NOT_SAVE_CHANGES) to close the current project before opening a new one. See “Project 
close() method” on page 116.

Parameters

None.

Returns

A new Project object, or null if no new project is created.

Example

app.projec t .c lose(CloseOpt ions .D O_NOT_SAVE_CHANGES);
app.newProjec t() ;

Application onError attribute
app.onError

Description

The name of a callback function that is called when an error occurs. By creating a function and assigning it to 
this attribute, you can respond to errors systematically; for example, you can close and restart the application, 
noting the error in a log file if it occurred during rendering. See “RenderQueue render() method” on page 161.

The callback function is passed the error string and a severity string. It should not return any value.

Type

A function name string, or null if no function is assigned; read/write.

Example

funct ion err(errStr ing)  {
a ler t(errStr ing) ;  
}

app.onError  = err ;

Application open() method
app.open()
app.open( f i le)



25

After Effects scripting reference Application object 

25 

Description

Opens a project. 

Parameters

Returns

A new Project object for the specified project, or null if the user cancels the Open dialog box.

Example

var  my_f i le  =  new Fi le( " . . /my_folder/my_test .aep") ;
i f  (my_f i le .exists){

new_project  = app.open(my_f i le) ;
i f  (new_project){

a ler t(new_project . f i le .name) ;
}

}

Application parseSwatchFile() method
app.parseSwatchFi le( f i le)

Description

Loads color swatch data from an Adobe Swatch Exchange (ASE) file.

Parameters

Returns

The swatch data, in this format:

f i le Optional. An ExtendScript File object for the project file to open. If not supplied, the method prompts the 
user to select a project file.

f i le The file specification, an ExtendScript Fi le  object.

data .majorVersion
data .minorVersion

The ASE version number.

data .va lues An array of SwatchValue .

SwatchValue. type One of "RGB" ,  "CMYK",  "LAB",  "Gray"

SwatchValue.r
SwatchValue.g
SwatchValue.b

When typ e  = "RGB", the color values in the range [0.0..1.0]. 

0, 0, 0 is Black.

SwatchValue.c
SwatchValue.m
SwatchValue.y
SwatchValue.k

When typ e  = "CMYK", the color values in the range [0.0..1.0]. 

0, 0, 0, 0 is White.
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Application pauseWatchFolder() method
app.pauseWatchFolder(pause)

Description

Pauses or resumes the search of the target watch folder for items to render.

Parameters

Returns

Nothing.

See also

“Application isWatchFolder attribute” on page 23
“Application watchFolder() method” on page 29
“Application endWatchFolder() method” on page 21

Application project attribute
app.projec t

Description

The project that is currently loaded. See “Project object” on page 114.

Type

Project object; read-only.

Application purge() method
app.purge( target )

Description

Purges unused data of the specified types from memory. Replicates the Purge options in the Edit menu.

SwatchValue.L
SwatchValue.a
SwatchValue.b

When typ e  = "L AB", the color values. 

L  is in the range [0.0..1.0]. a  and b  are in the range [-128.0..+128.0]

0, 0, 0 is Black.

SwatchValue.va lue When typ e  = "Gray", the va lue  range is [0.0..1.0]. 

0.0 is Black.

pause True to pause, false to resume.
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Parameters

Returns

Nothing.

Application quit() method
app.quit()

Description

Quits the After Effects application.

Parameters

None.

Returns

Nothing.

Application saveProjectOnCrash attribute
app.saveProjec tOnCrash

Description

When true (the default), After Effects attempts to display a dialog box that allows you to save the current 
project if an error causes the application to quit unexpectedly. Set to false to suppress this dialog box and quit 
without saving.

Type

Boolean; read/write.

Application scheduleTask() method
app.scheduleTask(str ingToE xecute ,  delay,  repeat )

Description

Schedules the specified JavaScript for delayed execution.

Parameters

target The type of elements to purge from memory; a PurgeTarget  enumerated value, one of:

• PurgeTarget .ALL_CACHES : Purges all data that After Effects has cached to physical memory.

• PurgeTarget .UND O_CACHES : Purges all data saved in the undo cache.

• PurgeTarget .SNAPSHOT_CACHES : Purges all data cached as composition/layer snapshots.

• PurgeTarget . IMAGE_CACHES : Purges all saved image data.

str ingToExecute A string containing JavaScript to be executed.

delay A number of milliseconds to wait before executing the JavaScript. A floating-point value.
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Returns

Integer, a unique identifier for this task, which can be used to cancel it with app.cancelTask() .

Application setMemoryUsageLimits() method
app.setMemor yUsageLimits( imageCachePercentage ,  maximumMemor yPercentage )

Description

Sets memory usage limits as in the Memory & Cache preferences area. For both values, if installed RAM is less 
than a given amount (n gigabytes), the value is a percentage of the installed RAM, and is otherwise a 
percentage of n. The value of n is: 2 GB for 32-bit Windows, 4 GB for 64-bit Windows, 3.5 GB for Mac OS.

Parameters

Returns

Nothing.

Application setSavePreferencesOnQuit() method
app.setSavePreferencesOnQuit(doSave)

Description

Set or clears the flag that determines whether preferences are saved when the application is closed.

Parameters

Returns

Nothing.

Application settings attribute
app.sett ings

Description

The currently loaded settings. See “Settings object” on page 170.

Type

Settings object; read-only.

rep eat When true, execute the script repeatedly, with the specified delay between each execution. When false 
the script is executed only once.

imageCachePercentage Floating-point value, the percentage of memory assigned to image cache.

maximumMemor yPercentage Floating-point value, the maximum usable percentage of memory.

doSave When true, preferences saved on quit, when false they are not.
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Application version attribute
app.vers ion

Description

An alphanumeric string indicating which version of After Effects is running.

Type

String; read-only.

Example

var  ver  =  app.vers ion;
a ler t("This  machine  i s  running vers ion "  + ver  +  "  of  After  Ef fec ts . " ) ;

Application watchFolder() method
app.watchFolder( fo lder_objec t_to_watch )

Description

Starts a Watch Folder (network rendering) process pointed at a specified folder.

Parameters

Returns

Nothing.

Example

var  theFolder  = new Folder(“c : / tool”) ;
app.watchFolder(theFolder) ;

See also

“Application endWatchFolder() method” on page 21
“Application parseSwatchFile() method” on page 25
“Application isWatchFolder attribute” on page 23

folder_object_to_watch The ExtendScript Folder object for the folder to watch.
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AVItem object
app.projec t . item( index)

Description

The AVItem object provides access to attributes and methods of audio/visual files imported into After Effects.

• AVItem is a subclass of Item. All methods and attributes of Item, in addition to those listed below, are 
available when working with AVItem. See “Item object” on page 78.

• AVItem is the base class for both CompItem and FootageItem, so AVItem attributes and methods are also 
available when working with CompItem and FootageItem objects. See “CompItem object” on page 52 and 
“FootageItem object” on page 65.

Attributes

Methods

Attribute Reference Description

name “AVItem name attribute” on page 33 The name of the object as shown in the Project panel.

width “AVItem width attribute” on page 37 The width of the item.

height “AVItem height attribute” on page 32 The height of the item.

pixelAsp ect  “AVItem pixelAspect attribute” on page 33 The pixel aspect ratio of the item.

f rameR ate “AVItem frameRate attribute” on page 32 The frame rate of the item.

f rameDurat ion “AVItem frameDuration attribute” on page 31 The frame duration for the item.

durat ion “AVItem duration attribute” on page 31 The total duration of the item.

useProxy “AVItem useProxy attribute” on page 36 When true, a proxy source is used for this item.

proxySource “AVItem proxySource attribute” on page 34 The FootageItem object used as proxy for the item.

t ime “AVItem time attribute” on page 36 Current time of the item.

usedIn “AVItem usedIn attribute” on page 36 The CompItem objects that use this item.

hasVideo “AVItem hasVideo attribute” on page 32 When true, the item has a video component.

hasAudio “AVItem hasAudio attribute” on page 32 When true, the item has an audio component.

footageMissing “AVItem footageMissing attribute” on 
page 31

When true, the item cannot be found or is a placeholder.

Method Reference Description

setProxy() “AVItem setProxy() method” on page 34 Sets a proxy for the item.

setProxyWithSequence() “AVItem setProxyWithSequence() method” on 
page 35

Sets a sequence as a proxy for the item.

setProxyWithSol id() “AVItem setProxyWithSolid() method” on 
page 35

Sets a solid as a proxy for the item.

setProxyWithPlaceholder() “AVItem setProxyWithPlaceholder() method” on 
page 35

Sets a placeholder as a proxy for the item.

setProxyToNone() “AVItem setProxyToNone() method” on page 34 Removes the proxy for the item.
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AVItem duration attribute
app.projec t . item(index) .durat ion

Description

Returns the duration, in seconds, of the item. Still footage items have a duration of 0.

• In a CompItem, the value is linked to the durat ion of the composition, and is read/write. 

• In a FootageItem, the value is linked to the durat ion of the mainSource object, and is read-only. 

Type

Floating-point value in the range [0.0..10800.0]; read/write for a CompItem; otherwise, read-only.

AVItem footageMissing attribute
app.projec t . item(index) . footageMiss ing

Description

When true, the AVItem is a placeholder, or represents footage with a source file that cannot be found. In this 
case, the path of the missing source file is in the miss ingFo otagePath attribute of the footage item’s source-file 
object. See “FootageItem mainSource attribute” on page 66 and “FileSource missingFootagePath attribute” on 
page 61.

Type

Boolean; read-only.

AVItem frameDuration attribute
app.projec t . item(index) . f rameDurat ion

Description

Returns the length of a frame for this AVItem, in seconds. This is the reciprocal of f rameR ate. When set, the 
reciprocal is automatically set as a new f rameR ate value. 

This attribute returns the reciprocal of the f rameR ate, which may not be identical to a value you set, if that 
value is not evenly divisible into 1.0 (for example, 0.3). Due to numerical limitations, (1 / (1 / 0.3)) is close to, 
but not exactly, 0.3. 

If the AVItem is a FootageItem, this value is linked to the mainSource, and is read-only. To change it, set the 
conformFrameR ate of the mainSource object. This sets both the f rameR ate and f rameDurat ion of the 
FootageItem.

Type

Floating-point value in the range [1/99.. 1.0]; read-only for a FootageItem, otherwise read/write.
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AVItem frameRate attribute
app.projec t . item(index) . f rameR ate

Description

The frame rate of the AVItem, in frames-per-second. This is the reciprocal of the f rameDurat ion. When set, 
the reciprocal is automatically set as a new frameDurat ion value.

• In a CompItem, the value is linked to the f rameR ate of the composition, and is read/write. 

• In a FootageItem, the value is linked to the f rameR ate of the mainSource object, and is read-only. To change 
it, set the conformFrameR ate of the mainS ource object. This sets both the f rameR ate and f rameDurat ion 
of the FootageItem.

Type

Floating-point value in the range [1.0..99.0]; read-only for a FootageItem, otherwise read/write.

AVItem hasAudio attribute
app.projec t . item(index) .hasAudio

Description

When true, the AVItem has an audio component. 

• In a CompItem, the value is linked to the composition. 

• In a FootageItem, the value is linked to the mainS ource object. 

Type

Boolean; read-only.

AVItem hasVideo attribute
app.projec t . item(index) .hasVideo

Description

When true, the AVItem has an video component. 

• In a CompItem, the value is linked to the composition. 

• In a FootageItem, the value is linked to the mainS ource object. 

Type

Boolean; read-only.

AVItem height attribute
app.projec t . item(index) .height

Description

The height of the item in pixels. 

• In a CompItem, the value is linked to the composition, and is read/write. 
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• In a FootageItem, the value is linked to the mainS ource object, and is read/write only if the mainSource 
object is a SolidSource. Otherwise, it is read-only.

Type

Integer in the range [1...30000]; read/write, except as noted.

AVItem name attribute
app.projec t . item(index) .name 

Description

The name of the item, as shown in the Project panel. 

• In a FootageItem, the value is linked to the mainSource object. If the mainSource object is a FileSource, this 
value controls the display name in the Project panel, but does not affect the file name.

Type

String; read/write.

AVItem pixelAspect attribute
app.projec t . item(index) .pixelAsp ect  

Description

The pixel aspect ratio (PAR) of the item.

• In a CompItem, the value is linked to the composition. 

• In a FootageItem, the value is linked to the mainS ource object. 

The value you retrieve after setting may be slightly different from the value you supplied. The following table 
compares the value as it appears in the UI with the more-accurate value returned by this attribute.

Type

Floating-point value, in the range [0.01..100.0]; read/write.

PAR in the After Effects UI PAR returned by the pixelAspect attribute

0.91 0.90909090909091

1 1

1.5 1.5

1.09 1.09401709401709

1.21 1.21212121212121

1.33 1.33333333333333

1.46 1.45868945868946

2 2
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AVItem proxySource attribute
app.projec t . item(index) .proxySource  

Description

The FootageSource being used as a proxy. The attribute is read-only; to change it, call any of the AVItem 
methods that change the proxy source: setProxy() , s etProxyWithSequence() , s etProxyWithSol id(), or 
setProxyWithPlaceholder() .

Type

FootageSource object; read-only.

AVItem setProxy() method
app.projec t . item(index) .setProxy( f i le)

Description

Sets a file as the proxy of this AVItem. Loads the specified file into a new FileSource object, sets this as the 
value of the proxySource attribute, and sets useProxy to true. It does not preserve the interpretation param-
eters, instead using the user preferences. If the file has an unlabeled alpha channel, and the user preference 
says to ask the user what to do, the method estimates the alpha interpretation, rather than asking the user. 

This differs from setting a FootageItem's main source, but both actions are performed as in the user interface.

Parameters

Returns

None.

AVItem setProxyToNone() method
app.projec t . item(index) .setProxyToNone()

Description

Removes the proxy from this AVItem, sets the value of proxyS ource to null, and sets the value of useProxy to 
fa lse.

Parameters

None.

Returns

Nothing.

f i le An ExtendScript File object for the file to be used as a proxy.
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AVItem setProxyWithPlaceholder() method
app.projec t . item(index) .setProxyWithPlaceholder(name,  width,  he ight ,  f rameRate ,  duration )

Description

Creates a PlaceholderSource object with specified values, sets this as the value of the proxyS ource attribute, 
and sets useProxy to true. It does not preserve the interpretation parameters, instead using the user prefer-
ences. 

NOTE: There is no direct way to set a placeholder as a proxy in the user interface; this behavior occurs when a 
proxy has been set and then moved or deleted.

Parameters

Returns

Nothing.

AVItem setProxyWithSequence() method
app.projec t . item(index) .setProxyWithS equence( f i le ,  forceAlphabetical )

Description

Sets a sequence of files as the proxy of this AVItem, with the option of forcing alphabetical order. Loads the 
specified file sequence into a new FileSource object, sets this as the value of the proxyS ource attribute, and sets 
useProxy to true. It does not preserve the interpretation parameters, instead using the user preferences. If any 
file has an unlabeled alpha channel, and the user preference says to ask the user what to do, the method 
estimates the alpha interpretation, rather than asking the user. 

Parameters

Returns

Nothing.

AVItem setProxyWithSolid() method
app.projec t . item(index) .setProxyWithS ol id(color,  name,  w idth ,  height ,  pixelAspec t)

Description

Creates a SolidSource object with specified values, sets this as the value of the proxySource attribute, and sets 
useProxy to true. It does not preserve the interpretation parameters, instead using the user preferences. 

name A string containing the name of the new object.

width,  height The pixel dimensions of the placeholder, an integer in the range [4..30000].

f rameR ate The frames-per-second, an integer in the range [1..99].

durat ion The total length in seconds, up to 3 hours. An integer in the range [0.0..10800.0].

f i le An ExtendScript File object for the first file in the sequence.

forceAlphabet ica l When true, use the “Force alphabetical order” option. 
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NOTE: There is no way, using the user interface, to set a solid as a proxy; this feature is available only through 
scripting.

Parameters

Returns

Nothing.

AVItem time attribute
app.projec t . item(index) . t ime

Description

The current time of the item when it is being previewed directly from the Project panel. This value is a number 
of seconds. Use the global method t imeToCurrentFormat to convert it to a string value that expresses the time 
in terms of frames; see “timeToCurrentFormat() global function” on page 15.

It is an error to set this value for a FootageItem whose mainSource is still (i tem .mainSource . isSt i l l  is true).

Type

Floating-point value; read/write.

AVItem usedIn attribute
app.projec t . item(index) .usedIn

Description

All the compositions that use this AVItem. 

Note that upon retrieval, the array value is copied, so it is not automatically updated. If you get this value, then 
add this item into another composition, you must retrieve the value again to get an array that includes the new 
item.

Type

Array of CompItem objects; read-only.

AVItem useProxy attribute
app.projec t . item(index) .useProxy

Description

When true, a proxy is used for the item. It is set to true by all the S etProxy methods, and to false by the 
S etProxyToNone()  method.

color The color of the solid, an array of 3 floating-point values, [R, G, B], in the range [0.0..1.0].

name A string containing the name of the new object.

width,  height The pixel dimensions of the placeholder, an integer in the range [1...30000].

pixelAsp ect The pixel aspect of the solid, a floating-point value in the range [0.01... 100.0].
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Type

Boolean; read/write.

AVItem width attribute
app.projec t . item(index) .width

Description

The width of the item, in pixels. 

• In a CompItem, the value is linked to the composition, and is read/write. 

• In a FootageItem, the value is linked to the mainS ource object, and is read/write only if the mainSource 
object is a SolidSource. Otherwise, it is read-only.

Type

Integer in the range [1...30000]; read/write, except as noted.
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AVLayer object
app.projec t . item(index) . layer( index)

Description

The AVLayer object provides an interface to those layers that contain AVItem objects (composition layers, 
footage layers, solid layers, text layers, and sound layers).

• AVLayer is a subclass of Layer. All methods and attributes of Layer, in addition to those listed below, are 
available when working with AVLayer. See “Layer object” on page 86.

• AVLayer is a base class for TextLayer, so AVLayer attributes and methods are available when working with 
TextLayer objects. See “TextLayer object” on page 188.

AE Properties

Different types of layers have different AE properties. AVLayer has the following properties and property 
groups:

Marker  
Time Remap 
Motion Trackers  
Masks  
Ef fects  
Transform 

Anchor  Point  
Posit ion 
S ca le  
Or ientat ion 
X Rotat ion 
Y Rotat ion  
Rotat ion 
Opacity  

L ayer  Sty les
Geometr y  Options //  R ay-traced 3D
Mater ia l  Options  

Casts  Shadows 
L ight  Transmiss ion 
Accepts  Shadows 
Accepts  L ights  
Appears  in  Ref lec t ions //  R ay-traced 3D
Ambient  
Dif fuse  
Specular  Intens ity
Specular  Shininess  
Meta l  
Ref lec t ion Intensity //  R ay-traced  3D
Ref lec t ion Shar pness //  R ay-traced 3D
Ref lec t ion Rol lof f //  R ay-traced  3D
Transparenc y //  R ay-traced 3D
Transparenc y Rol lof f / /  R ay-traced 3D
Index of  Refrac t ion //  R ay-traced  3D

Audio 
Audio Levels



39

After Effects scripting reference AVLayer object 

39 

Example

If the first item in the project is a CompItem, and the first layer of that CompItem is an AVLayer, the following 
sets the layer qual ity, s tar tTime, and inPoint .

var  f i rs tL ayer  = app.project . item(1) . layer(1) ;
f i rs tL ayer.qua l ity  =  L ayerQual ity.BEST;
f irs tL ayer. star tTime = 1 ;
f i rs tL ayer. inPoint  =  2 ;

Attributes

Attribute Reference Description

source “AVLayer source attribute” on page 47 The source item for this layer.

i sNameFromS ource  “AVLayer isNameFromSource attribute” 
on page 46

When true, the layer has no expressly set name, 
but contains a named source.

height  “AVLayer height attribute” on page 45 The height of the layer.

width “AVLayer width attribute” on page 49 The width of the layer.

audioEnabled “AVLayer audioEnabled attribute” on 
page 41

When true, the layer's audio is enabled.

motionBlur  “AVLayer motionBlur attribute” on 
page 46

When true, the layer's motion blur is enabled.

ef fec tsAct ive  “AVLayer effectsActive attribute” on 
page 44

When true, the layer's effects are active.

adjustmentL ayer  “AVLayer adjustmentLayer attribute” on 
page 40

When true, this is an adjustment layer.

guideL ayer “AVLayer guideLayer attribute” on 
page 45

When true, this is a guide layer.

threeDL ayer  “AVLayer threeDLayer attribute” on 
page 48

When true, this is a 3D layer.

threeDPerChar “AVLayer threeDPerChar attribute” on 
page 48

When true, 3D is set on a per-character basis in 
this text layer.

environmentL ayer “AVLayer environmentLayer attribute” 
on page 44

When true, this is an environment layer.

canSetC ol laps eTransformat ion “AVLayer canSetCollapseTransformation 
attribute” on page 43

When true, it is legal to change the value of 
col lapseTransformat ion .

col lapseTransformation “AVLayer collapseTransformation attri-
bute” on page 44

When true, collapse transformation is on.

f rameBlending “AVLayer frameBlending attribute” on 
page 44

When true, frame blending is enabled.

f rameBlendingTyp e “AVLayer frameBlendingType attribute” 
on page 44

The type of frame blending for the layer.

canSetTimeRemapEnabled “AVLayer canSetTimeRemapEnabled 
attribute” on page 43

When true, it is legal to change the value of 
t imeRemapEnabled .

t imeRemapEnabled “AVLayer timeRemapEnabled attribute” 
on page 48

When true, time remapping is enabled on this 
layer.

hasAudio “AVLayer hasAudio attribute” on 
page 45

When true, the layer contains an audio compo-
nent.
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Methods

AVLayer adjustmentLayer attribute
app.projec t . item(index) . layer( index) .adjustmentL ayer

Description

True if the layer is an adjustment layer. 

Type

Boolean; read/write.

AVLayer audioActive attribute
app.projec t . item(index) . layer( index) .audioAct ive

Description

True if the layer's audio is active at the current time. 

audioAct ive  “AVLayer audioActive attribute” on 
page 40

When true, the layer's audio is active at the cur-
rent time.

blendingMo de “AVLayer blendingMode attribute” on 
page 42

The blending mode of the layer.

preser veTransparenc y  “AVLayer preserveTransparency attri-
bute” on page 47

When true, preserve transparency is enabled.

t rackMatteType “AVLayer trackMatteType attribute” on 
page 49

if layer has a track matte, specifies the way it is 
applied.

i sTrackMatte  “AVLayer isTrackMatte attribute” on 
page 46

When true, this layer is being used as a track 
matte for the layer below it.

hasTrackMatte “AVLayer hasTrackMatte attribute” on 
page 45

When true, the layer above is being used as a 
track matte on this layer.

qual ity  “AVLayer quality attribute” on page 47 The layer quality setting.

autoOrient “AVLayer autoOrient attribute” on 
page 41

The type of automatic orientation for the layer.

Method Reference Description

audioAct iveAtTime() “AVLayer audioActiveAtTime() method” 
on page 41

Reports whether this layer's audio is 
active at a given time.

ca lculateTransformFromPoints() “AVLayer calculateTransform-
FromPoints() method” on page 43

Calculates a transformation from a set of 
points in this layer.

replaceS ource() “AVLayer replaceSource() method” on 
page 47

Changes the source item for this layer.

sourceRectAtTime() “AVLayer sourceRectAtTime() method” 
on page 48

Retrieves the source rectangle of a layer.

openInViewer() “AVLayer openInViewer() method” on 
page 46

Opens the layer in a Layer panel.

Attribute Reference Description
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For this value to be true, audioEnabled must be true, no other layer with audio may be soloing unless this layer 
is soloed too, and the time must be between the inPoint  and outPoint  of this layer.

Type

Boolean; read-only.

AVLayer audioActiveAtTime() method
app.projec t . item(index) . layer( index) .audioAct iveAtTime( t ime)

Description

Returns true if this layer's audio will be active at the specified time. 

For this method to return true, audioEnabled must be true, no other layer with audio may be soloing unless 
this layer is soloed too, and the time must be between the inPoint  and outPoint  of this layer.

Parameters

Returns

Boolean.

AVLayer audioEnabled attribute
app.projec t . item(index) . layer( index) .audioEnabled

Description

When true, the layer's audio is enabled. This value corresponds to the audio toggle switch in the Timeline 
panel. 

Type

Boolean; read/write.

AVLayer autoOrient attribute
app.projec t . item(index) . layer( index) .autoOrient

Description

The type of automatic orientation to perform for the layer. 

Type

An AutoOrientType enumerated value; read/write. One of:

t ime The time, in seconds. A floating-point value.

AutoOrientType.ALONG_PATH Layer faces in the direction of the motion path.

AutoOrientType.CAMERA_OR_POINT_OF_INTEREST Layer always faces the active camera or points at its 
point of interest.

AutoOrientType.CHARACTERS_TOWARD_CAMERA Each character in a per-character 3D text layer auto-
matically faces the active camera.
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AVLayer blendingMode attribute
app.projec t . item(index) . layer( index) .b lendingMo de

Description

The blending mode of the layer.

Type

A BlendingMo de enumerated value; read/write. One of:

BlendingMode.ADD 
BlendingMode.ALPHA_ADD 
BlendingMode.CLASSIC_COLOR_BURN 
BlendingMode.CLASSIC_COLOR_D OD GE 
BlendingMode.CLASSIC_DIFFERENCE 
BlendingMode.COLOR 
BlendingMode.COLOR_BURN 
BlendingMode.COLOR_D OD GE 
BlendingMode.DANCING_DISSOLVE 
BlendingMode.DARKEN 
BlendingMode.DARKER_COLOR
BlendingMode.DIFFERENCE 
BlendingMode.DISSOLVE 
BlendingMode.EXCLUSION 
BlendingMode.HARD_LIGHT 
BlendingMode.HARD_MIX 
BlendingMode.HUE 
BlendingMode.LIGHTEN 
BlendingMode.LIGHTER_COLOR
BlendingMode.LINEAR_BURN 
BlendingMode.LINEAR_D OD GE 
BlendingMode.LINEAR_LIGHT 
BlendingMode.LUMINESCENT_PREMUL 
BlendingMode.LUMINOSIT Y 
BlendingMode.MULTIPLY 
BlendingMode.NORMAL
BlendingMode.OVERLAY 
BlendingMode.PIN_LIGHT 
BlendingMode.SATURATION 
BlendingMode.SCREEN 
BlendingMode.SILHOUETE_ALPHA 
BlendingMode.SILHOUET TE_LUMA 
BlendingMode.SOFT_LIGHT 
BlendingMode.STENCIL_ALPHA 
BlendingMode.STENCIL_LUMA 
BlendingMode.VIVID_LIGHT

AutoOrientType.NO_AUTO_ORIENT Layer rotates freely, independent of any motion 
path, point of interest, or other layers.
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AVLayer calculateTransformFromPoints() method
app.projec t . item(index) . layer( index) .ca lcu lateTransformFromPoints(pointTopLef t ,  pointTopRight ,  point-
Bot tomRight)

Description

Calculates a transformation from a set of points in this layer. 

Parameters

Returns

An Object with the transformation properties set.

Example

var  newL ayer  = comp.layers .add(newFootage) ;
newL ayer. threeDL ayer  =  t rue ;

newL ayer.b lendingMode = BlendingMo de.ALPHA_ADD;
var  t ransform = newL ayer.ca lculateTransformFromPoints( t l ,  t r,  b l ) ;
for(var  sel  in  t ransform) {

newL ayer. t ransform[sel] .s etValue( transform[se l]) ;
}

AVLayer canSetCollapseTransformation attribute
app.projec t . item(index) . layer( index) .canS etC ol lapseTransformation

Description

True if it is legal to change the value of the col laps eTransformat ion attribute on this layer. 

Type

Boolean; read-only.

AVLayer canSetTimeRemapEnabled attribute
app.projec t . item(index) . layer( index) .canS etTimeRemapEnabled

Description

True if it is legal to change the value of the t imeRemapEnabled attribute on this layer. 

Type

Boolean; read-only.

p ointTopL eft The top left point coordinates in the form of an array, [x ,  y,  z] .

pointTopRight The top right point coordinates in the form of an array, [x ,  y,  z ] .

p ointB ottomRight The bottom right point coordinates in the form of an array, [x ,  y,  z ] .
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AVLayer collapseTransformation attribute
app.projec t . item(index) . layer( index) .col lapseTransformat ion

Description

True if collapse transformation is on for this layer.

Type

Boolean; read/write.

AVLayer effectsActive attribute
app.projec t . item(index) . layer( index) .e f fectsAct ive

Description

True if the layer's effects are active, as indicated by the <f> icon next to it in the user interface. 

Type

Boolean; read/write.

AVLayer environmentLayer attribute
app.projec t . item(index) . layer( index) .environmentL ayer

Description

True if this is an environment layer in a Ray-traced 3D composition. Setting this attribute to true automatically 
makes the layer 3D (threeDL ayer  becomes true).

Type

Boolean; read/write.

AVLayer frameBlending attribute
app.projec t . item(index) . layer( index) . f rameBlending

Description

True if frame blending is enabled for the layer. 

Type

Boolean; read-only.

AVLayer frameBlendingType attribute
app.projec t . item(index) . layer( index) . f rameBlendingTyp e

Description

The type of frame blending to perform when frame blending is enabled for the layer. 
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Type

A FrameBlendingType enumerated value; read/write. One of:

FrameBlendingType.FRAME_MIX
FrameBlendingType.NO_FRAME_BLEND
FrameBlendingType.PIXEL_MOTION

AVLayer guideLayer attribute
app.projec t . item(index) . layer( index) .guideL ayer

Description

True if the layer is a guide layer. 

Type

Boolean; read/write.

AVLayer hasAudio attribute
app.projec t . item(index) . layer( index) .hasAudio

Description

True if the layer contains an audio component, regardless of whether it is audio-enabled or soloed. 

Type

Boolean; read-only.

AVLayer hasTrackMatte attribute
app.projec t . item(index) . layer( index) .hasTrackMatte

Description

True if the layer in front of this layer is being used as a track matte on this layer. When true, this layer's t rack-
MatteTyp e value controls how the matte is applied.

Type

Boolean; read-only.

AVLayer height attribute
app.projec t . item(index) . layer( index) .height

Description

The height of the layer in pixels.

Type

Floating-point; read-only.
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AVLayer isNameFromSource attribute
app.projec t . item(index) . layer( index) . i sNameFromSource

Description

True if the layer has no expressly set name, but contains a named source. In this case, layer.name has the same 
value as layer. source.name. 

False if the layer has an expressly set name, or if the layer does not have a source.

Type

Boolean; read-only.

AVLayer isTrackMatte attribute
app.projec t . item(index) layer( index ) . isTrackMatte

Description

True if this layer is being used as a track matte for the layer behind it.

Type

Boolean; read-only.

AVLayer motionBlur attribute
app.projec t . item(index) . layer( index) .mot ionBlur

Description

True if motion blur is enabled for the layer.

Type

Boolean; read/write.

AVLayer openInViewer() method
app.projec t . item(index) . layer( index) .op enInViewer()

Description

Opens the layer in a Layer panel, and moves the Layer panel to front and gives it focus. 

Parameters

None.

Returns

Viewer object for the Layer panel, or null if the layer could not be opened (e.g., for text or shape layers, which 
cannot be opened in the Layer panel).
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AVLayer preserveTransparency attribute
app.projec t . item(index) . layer( index) .preser veTransparenc y

Description

True if preserve transparency is enabled for the layer.

Type

Boolean; read/write.

AVLayer quality attribute
app.projec t . item(index) . layer( index) .qual ity

Description

The quality with which this layer is displayed.

Type

A L ayerQual ity  enumerated value; read/write. One of:

L ayerQual ity.BEST 
L ayerQual ity.DRAFT
L ayerQual ity.WIREFRAME 

AVLayer replaceSource() method
app.projec t . item(index) . layer( index) .replaceSource  (newSource ,  f ixE xpressions)

Description

Replaces the source for this layer. 

Parameters

Returns

Nothing.

AVLayer source attribute
app.projec t . item(index) . layer( index) . s ource

Description

The source AVItem for this layer. The value is null in a Text layer. Use AVL ayer.replaceSource()  to change the 
value.

Type

AVItem object; read-only.

newSource The new source AVItem object.

f ixExpress ions True  to adjust expressions for the new source, fa l se  otherwise. Note that this feature can be 
resource-intensive; if replacing a large amount of footage, do this only at the end of the operation. 
See also “Project autoFixExpressions() method” on page 115.
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AVLayer sourceRectAtTime() method
app.projec t . item(index) . layer( index) .s ourceRectAtTime( t imeT,  extents)

Description

Retrieves the rectangle bounds of the layer at the specified time index, corrected for text or shape layer content. 
Use, for example, to write text that is properly aligned to the baseline.

Parameters

Returns

A JavaScript object with four attributes, [ top,  le f t ,  width ,  height].

AVLayer threeDLayer attribute
app.projec t . item(index) . layer( index) . threeDL ayer

Description

True if this is a 3D layer.

Type

Boolean; read/write.

AVLayer threeDPerChar attribute
app.projec t . item(index) . layer( index) . threeDPerChar

Description

True if this layer has the Enable Per-character 3D switch set, allowing its characters to be animated off the 
plane of the text layer. Applies only to text layers.

Type

Boolean; read/write.

AVLayer timeRemapEnabled attribute
app.projec t . item(index) . layer( index) . t imeRemapEnabled

Description

True if time remapping is enabled for this layer.

Type

Boolean; read/write.

t imeT The time index, in seconds. A floating-point value.

extents True  to include the extents, fa ls e  otherwise. Extents apply to shape layers, increasing the size of 
the layer bounds as necessary.
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AVLayer trackMatteType attribute
app.projec t . item(index) . layer( index) . t rackMatteTyp e

Description

If this layer has a track matte, specifies the way the track matte is applied.

Type

A TrackMatteType enumerated value; read/write. One of:

TrackMatteType.ALPHA 
TrackMatteType.ALPHA_INVERTED 
TrackMatteType.LUMA 
TrackMatteType.LUMA_INVERTED 
TrackMatteType.NO_TRACK_MAT TE 

AVLayer width attribute
app.projec t . item(index) . layer( index) .width

Description

The width of the layer in pixels.

Type

Floating-point; read-only.
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CameraLayer object
app.projec t . item(index) . layer( index)

Description

The CameraLayer object represents a camera layer within a composition. Create it using the LayerCollection 
object’s addCamera method; see “LayerCollection addCamera() method” on page 96. It can be accessed in an 
item’s layer collection either by index number or by a name string. 

• CameraLayer is a subclass of Layer. All methods and attributes of Layer are available when working with 
CameraLayer. See “Layer object” on page 86.

AE Properties

CameraLayer defines no additional attributes, but has different AE properties than other layer types. It has the 
following properties and property groups:

Marker  
Transform 

Point  of  Interest  
Posit ion 
S ca le  
Or ientat ion 
X Rotat ion 
Y Rotat ion  
Rotat ion 
Opacity  

Camera Opt ions  
Z oom 
Depth of  Field
Fo cus  Distance
Blur Level
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Collection object
Like an array, a collection associates a set of objects or values as a logical group and provides access to them 
by index. However, most collection objects are read-only. You do not assign objects to them yourself—their 
contents update automatically as objects are created or deleted.

The index numbering of a collection starts with 1, not 0.

Objects

Attributes

Methods

Object Reference Description

ItemC ol lec t ion “ItemCollection object” on page 82 All of the items (imported files, folders, solids, and so on) found in 
the Project panel.

L ayerC ol lect ion “LayerCollection object” on 
page 95

All of the layers in a composition.

OMC ol lect ion “OMCollection object” on page 109 All of the Output Module items in the project.

RQItemC ol lect ion “RenderQueueItem object” on 
page 163

All of the render-queue items in the project.

length The number of objects in the collection.

[] Retrieves an object in the collection by its index number. The first object is at index 1.
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CompItem object
app.projec t . item( index)
app.projec t . items[ index]

Description

The CompItem object represents a composition, and allows you to manipulate and get information about it. 
Access the objects by position index number in a project’s i tem collection.

• CompItem is a subclass of AVItem, which is a subclass of Item. All methods and attributes of AVItem and 
Item, in addition to those listed below, are available when working with CompItem. See “AVItem object” on 
page 30 and “Item object” on page 78.

Example

Given that the first item in the project is a CompItem, the following code displays two alerts. The first shows 
the number of layers in the CompItem, and the second shows the name of the last layer in the CompItem.

var  f i rs tC omp = app.project . item(1) ;
a ler t("number  of  layers  is  "  +  f i rstC omp.numL ayers) ;
a ler t( "name of  last  layer  is  "  +  f i rstC omp. layer( f irstC omp.numL ayers) .name) ;

Attributes

Attribute Reference Description

f rameDurat ion “CompItem frameDuration attribute” on 
page 55

The duration of a single frame. 

dropFrame “CompItem dropFrame attribute” on 
page 54

When true, indicates that the composi-
tion uses drop-frame timecode. 

workAreaStar t “CompItem workAreaStart attribute” on 
page 60

The work area start time.

workAreaDurat ion “CompItem workAreaDuration attribute” on 
page 59

The work area duration.

numL ayers “CompItem numLayers attribute” on page 57 The number of layers in the composi-
tion.

hideShyL ayers “CompItem hideShyLayers attribute” on 
page 55

When true, shy layers are visible in the 
Timeline panel.

motionBlur “CompItem motionBlur attribute” on 
page 56

When true, motion blur is enabled for 
this composition. 

draf t3d “CompItem draft3d attribute” on page 54 When true, Draft 3D mode is enabled 
for the Composition panel.

f rameBlending “CompItem frameBlending attribute” on 
page 55

When true, time filtering is enabled for 
this composition.

preser veNestedFrameR ate “CompItem preserveNestedFrameRate attri-
bute” on page 57

When true, the frame rate of nested 
compositions is preserved.

preser veNestedResolut ion “CompItem preserveNestedResolution attri-
bute” on page 58

When true, the resolution of nested 
compositions is preserved.

bgC olor “CompItem bgColor attribute” on page 54 The background color of the composi-
tion.

ac t iveCamera “CompItem activeCamera attribute” on 
page 53

The current active camera layer.
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Methods

CompItem activeCamera attribute
app.projec t . item(index) .act iveCamera  

Description

The active camera, which is the front-most camera layer that is enabled. The value is null if the composition 
contains no enabled camera layers.

Type

CameraLayer object; read-only.

displayStar tTime “CompItem displayStartTime attribute” on 
page 54

Changes the display of the start time in 
the Timeline panel. 

resolut ionFactor “CompItem resolutionFactor attribute” on 
page 58

The factor by which the x and y resolu-
tion of the Composition panel is 
downsampled.

shutterAngle “CompItem shutterAngle attribute” on 
page 59

The camera shutter angle.

shutterPhase “CompItem shutterPhase attribute” on 
page 59

The camera shutter phase.

motionBlurSamplesPerFrame “CompItem motionBlurSamplesPerFrame 
attribute” on page 57

The minimum number of motion blur 
samples per frame for Classic 3D layers, 
shape layers, and certain effects.

motionBlurAdaptiveSampleLimit “CompItem motionBlurAdaptiveSample-
Limit attribute” on page 56

The maximum number of motion blur 
samples of 2D layer motion.

l ayers “CompItem layers attribute” on page 56
“LayerCollection object” on page 95

The layers of the composition.

se lectedL ayers “CompItem selectedLayers attribute” on 
page 59

The selected layers of the composition.

se lectedProper t ies “CompItem selectedProperties attribute” on 
page 59

The selected properties of the compo-
sition.

renderer “CompItem renderer attribute” on page 58 The rendering plug-in module to be 
used to render this composition.

renderers “CompItem renderers attribute” on page 58 The set of available rendering plug-in 
modules.

Method Reference Description

dupl icate() “CompItem duplicate() method” on page 54 Creates and returns a duplicate of this composition.

l ayer() “CompItem layer() method” on page 55 Gets a layer from this composition.

openInViewer() “CompItem openInViewer() method” on 
page 57

Opens the composition in a Composition panel.

Attribute Reference Description
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CompItem bgColor attribute
app.projec t . item(index) .bgC olor

Description

The background color of the composition. The three array values specify the red, green, and blue components 
of the color.

Type

An array containing three floating-point values, [R, G, B], in the range [0.0..1.0]; read/write.

CompItem displayStartTime attribute
app.projec t . item(index) .displayStar tTime

Description

The time set as the beginning of the composition, in seconds. This is the equivalent of the Start Timecode or 
Start Frame setting in the Composition Settings dialog box.

Type

Floating-point value in the range [0.0...86339.0] (1 second less than 25 hours); read/write.

CompItem draft3d attribute
app.projec t . item(index) .draf t3d

Description

When true, Draft 3D mode is enabled for the Composition panel. This corresponds to the value of the Draft 
3D button in the Composition panel.

Type

Boolean; read/write.

CompItem dropFrame attribute
app.projec t . item(index) .dropFrame

Description

When true, indicates that the composition uses drop-frame timecode. When false, indicates non-drop-frame 
timecode. This corresponds to the setting in the Composition Settings dialog box.

Type

Boolean; read/write.

CompItem duplicate() method
app.projec t . item(index) .dupl icate()

Description

Creates and returns a duplicate of this composition, which contains the same layers as the original.
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Parameters

None.

Returns

CompItem object.

CompItem frameBlending attribute
app.projec t . item(index) . f rameBlending

Description

When true, frame blending is enabled for this Composition. Corresponds to the value of the Frame Blending 
button in the Composition panel.

Type

Boolean; if true, frame blending is enabled; read/write.

CompItem frameDuration attribute
app.projec t . item ( index) . f rameDurat ion  

Description

The duration of a frame, in seconds. This is the inverse of the f rameR ate value (frames-per-second). 

Type

Floating-point; read/write.

CompItem hideShyLayers attribute
app.projec t . item(index) .hideShyL ayers

Description

When true, only layers with shy set to false are shown in the Timeline panel. When false, all layers are visible, 
including those whose shy value is true. Corresponds to the value of the Hide All Shy Layers button in the 
Composition panel.

Type

Boolean; read/write.

CompItem layer() method
app.projec t . item(index) . layer( index)
app.projec t . item(index) . layer(otherL ayer,  re l Index)
app.projec t . item(index) . layer(name)

Description

Returns a Layer object, which can be specified by name, an index position in this layer, or an index position 
relative to another layer.
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Parameters

—or—
 

—or—

Returns

Layer object.

CompItem layers attribute
app.projec t . item(index) . layers

Description

A LayerCollection object that contains all the Layer objects for layers in this composition. See “LayerCol-
lection object” on page 95.

Type

LayerCollection object; read-only.

CompItem motionBlur attribute
app.projec t . item(index) .motionBlur

Description

When true, motion blur is enabled for the composition. Corresponds to the value of the Motion Blur button 
in the Composition panel.

Type

Boolean; read/write.

CompItem motionBlurAdaptiveSampleLimit attribute
app.projec t . item(index) .motionBlurAdaptiveSampleLimit

Description

The maximum number of motion blur samples of 2D layer motion. This corresponds to the Adaptive Sample 
Limit setting in the Advanced tab of the Composition Settings dialog box. 

index The index number of the desired layer in this composition. An integer in the range [1...num-
Layers], where numLayers  is the number of layers in the composition.

otherL ayer A Layer object in this composition. The rel Index  value is added to the index value of this 
layer to find the position of the desired layer.

re l Index The position of the desired layer, relative to otherL ayer. An integer in the range [1–other-
L ayer. index . . . numLayers–otherL ayer. index ], where numLayers  is the number of 
layers in the composition.

This value is added to the otherL ayer  value to derive the absolute index of the layer to 
return.

name The string containing the name of the desired layer.
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Type

Integer (between 16 and 256); read/write.

CompItem motionBlurSamplesPerFrame attribute
app.projec t . item(index) .motionBlurSamplesPerFrame

Description

The minimum number of motion blur samples per frame for Classic 3D layers, shape layers, and certain 
effects. This corresponds to the Samples Per Frame setting in the Advanced tab of the Composition Settings 
dialog box. 

Type

Integer (between 2 and 64); read/write.

CompItem numLayers attribute
app.projec t . item(index) .numL ayers

Description

The number of layers in the composition.

Type

Integer; read-only.

CompItem openInViewer() method
app.projec t . item(index) .openInViewer()

Description

Opens the composition in a Composition panel, and moves the Composition panel to front and gives it focus. 

Parameters

None.

Returns

Viewer object for the Composition panel, or null if the composition could not be opened.

CompItem preserveNestedFrameRate attribute
app.projec t . item(index) .preser veNestedFrameR ate

Description

When true, the frame rate of nested compositions is preserved in the current composition. Corresponds to the 
value of the “Preserve frame rate when nested or in render queue” option in the Advanced tab of the Compo-
sition Settings dialog box.

Type

Boolean; read/write.
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CompItem preserveNestedResolution attribute
app.projec t . item(index) .preser veNestedResolut ion

Description

When true, the resolution of nested compositions is preserved in the current composition. Corresponds to the 
value of the “Preserve Resolution When Nested” option in the Advanced tab of the Composition Settings 
dialog box.

Type

Boolean; read/write.

CompItem renderer attribute
app.projec t . item(index) .renderer

Description

The current rendering plug-in module to be used to render this composition, as set in the Advanced tab of the 
Composition Settings dialog box. Allowed values are the members of compItem . renderers .

Type

String; read/write.

CompItem renderers attribute
app.projec t . item(index) .renderers

Description

The available rendering plug-in modules. Member strings reflect installed modules, as seen in the Advanced 
tab of the Composition Settings dialog box.

Type

Array of strings; read-only. 

CompItem resolutionFactor attribute
app.projec t . item(index) .resolut ionFactor

Description

The x and y downsample resolution factors for rendering the composition. 

The two values in the array specify how many pixels to skip when sampling; the first number controls 
horizontal sampling, the second controls vertical sampling. Full resolution is [1,1], half resolution is [2,2], and 
quarter resolution is [4,4]. The default is [1,1]. 

Type

Array of two integers in the range [1..99]; read/write.
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CompItem selectedLayers attribute
app.projec t . item(index) .se lec tedL ayers

Description

All of the selected layers in this composition. This is a 0-based array (the first object is at index 0).

Type

Array of Layer objects; read-only.

CompItem selectedProperties attribute
app.projec t . item(index) .se lec tedProper t ies

Description

All of the selected properties (Property and PropertyGroup objects) in this composition. The first property is 
at index position 0.

Type

Array of Property and PropertyGroup objects; read-only.

CompItem shutterAngle attribute
app.projec t . item(index) .shutterAngle

Description

The shutter angle setting for the composition. This corresponds to the Shutter Angle setting in the Advanced 
tab of the Composition Settings dialog box. 

Type

Integer in the range [0...720]; read/write.

CompItem shutterPhase attribute
app.projec t . item(index) .shutterPhase

Description

The shutter phase setting for the composition. This corresponds to the Shutter Phase setting in the Advanced 
tab of the Composition Settings dialog box. 

Type

Integer in the range [–360...360]; read/write. 

CompItem workAreaDuration attribute
app.projec t . item ( index) .workAreaDurat ion

Description

The duration of the work area in seconds. This is the difference of the start-point and end-point times of the 
Composition work area.
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Type

Floating-point; read/write.

CompItem workAreaStart attribute
app.projec t . item ( index) .workAreaStar t

Description

The time when the Composition work area begins, in seconds. 

Type

Floating-point; read/write.
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FileSource object
app.projec t . item ( index) .mainS ource
app.projec t . item ( index) .proxySource

Description

The FileSource object describes footage that comes from a file. 

• FileSource is a subclass of FootageSource. All methods and attributes of FootageSource, in addition to those 
listed below, are available when working with FileSource. See “FootageSource object” on page 69.

Attributes

Methods

FileSource file attribute
app.projec t . item( index) .mainS ource. f i le
app.projec t . item( index) .proxySource. f i le

Description

The ExtendScript File object for the file that defines this asset. To change the value:

• If this FileSource is a proxyS ource of an AVItem, call setProxy()  or setProxyWithS equence() .

• If this FileSource is a mainSource of a FootageItem, call replace()  or replaceWithSequence() .

Type

File object; read-only.

FileSource missingFootagePath attribute
app.projec t . item( index) .mainS ource . f i le .miss ingFootagePath
app.projec t . item( index) .proxySource. f i le .miss ingFootagePath

Description

The path and filename of footage that is missing from this asset. See also “AVItem footageMissing attribute” 
on page 31.

Type

String; read-only.

Attribute Reference Description

f i le “FileSource file attribute” on page 61 The file that defines this asset.

missingFo otagePath “FileSource missingFootagePath attribute” 
on page 61

The file that contains footage missing from this asset.

Method Reference Description

re load() “FileSource reload() method” on page 62 Reloads the asset from the file, if it is a mainSource  of 
a FootageItem.
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FileSource reload() method
app.projec t . item( index) .mainS ource . f i le .mainSource.reload()

Description

Reloads the asset from the file. This method can be called only on a mainS ource, not a proxyS ource.

Parameters

None.

Returns

Nothing.
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FolderItem object
app.projec t .FolderItem

Description

The FolderItem object corresponds to a folder in your Project panel. It can contain various types of items 
(footage, compositions, solids) as well as other folders.

Example

Given that the second item in the project is a FolderItem, the following code puts up an alert for each top-level 
item in the folder, showing that item’s name.

var  secondItem = app.projec t . i tem(2) ;
i f  (  ! (secondItem instanceof  FolderItem) )  {

a ler t( "problem: second item is  not  a  folder") ;
}  e ls e  {

for  ( i  = 1 ;  i  <= s econdItem.numItems;  i++)  {
a ler t( " item number "  +  i  +  "  within the  folder  is  named "

+ s econdItem.item(i) .name) ;
}

}

Attributes

Methods

FolderItem item() method
app.projec t . item( index) . i tem

Description

Returns the top-level item in this folder at the specified index position. Note that “top-level” here means top-
level within the folder, not necessarily within the project.

Parameters

Returns

Item object.

Attribute Reference Description

i tems “FolderItem items attribute” on page 64 The contents of this folder.

numItems “FolderItem numItems attribute” on page 64 The number of items contained in the folder.

Method Reference Description

i tem() “FolderItem item() method” on page 63 Gets an item from the folder.

index An integer, the position index of the item to retrieve. The first item is at index 1.
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FolderItem items attribute 
app.projec t . item( index) . i tems

Description 

An ItemCollection object containing Item object that represent the top-level contents of this folder.

Unlike the ItemCollection in the Project object, this collection contains only the top-level items in the folder. 
Top-level within the folder is not the same as top-level within the project. Only those items that are top-level 
in the root folder are also top-level in the Project.

Type 

ItemCollection object; read only.

FolderItem numItems attribute 
app.projec t . item( index) .numItems

Description 

The number of items contained in the items collection (folderItem . i tems. length).

If the folder contains another folder, only the FolderItem for that folder is counted, not any subitems contained 
in it.

Type 

Integer; read only.
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FootageItem object
app.projec t . item( index)
app.projec t . items[ index]

Description

The FootageItem object represents a footage item imported into a project, which appears in the Project panel. 
These are accessed by position index number in a project’s i tem collection.

• FootageItem is a subclass of AVItem, which is a subclass of Item. All methods and attributes of AVItem and 
Item, in addition to those listed below, are available when working with FootageItem. See “AVItem object” 
on page 30 and “Item object” on page 78.

Attributes

Methods

FootageItem file attribute 
app.projec t . item( index) . f i le

Description 

The ExtendScript File object for the footage's source file.

If the FootageItem's mainS ource is a FileSource, this is the same as FootageItem .mainSource. f i le . Otherwise 
it is null.

Type 

File object; read only.

Attribute Reference Description

f i le “FootageItem file attribute” on page 65 The footage source file.

mainS ource “FootageItem mainSource attribute” on page 66 All settings related to the footage item.

Method Reference Description

replace() “FootageItem replace() method” on 
page 66

Replaces a footage file with another footage file.

replaceWithPlaceholder() “FootageItem replaceWithPlaceholder() 
method” on page 67

Replaces a footage file with a placeholder object.

replaceWithS equence() “FootageItem replaceWithSequence() 
method” on page 67

Replaces a footage file with an image sequence.

replaceWithS ol id() “FootageItem replaceWithSolid() 
method” on page 67

Replaces a footage file with a solid.

openInViewer() “FootageItem openInViewer() method” 
on page 66

Opens the footage in a Footage panel.
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FootageItem mainSource attribute
app.projec t . item ( index) .mainS ource

Description

The footage source, an object that contains all of the settings related to that footage item, including those that 
are normally accessed through the Interpret Footage dialog box. The attribute is read-only. To change its value, 
call one of the FootageItem “replace” methods.

See the “FootageSource object” on page 69, and its three types:

• “SolidSource object” on page 179

• “FileSource object” on page 61

• “PlaceholderSource object” on page 113

If this is a FileSource object, and the fo otageMiss ing value is true, the path to the missing footage file is in the 
Fi leSource.miss ingFootagePath attribute. See “AVItem footageMissing attribute” on page 31 and “FileSource 
missingFootagePath attribute” on page 61.

Type

FootageSource object; read-only.

FootageItem openInViewer() method
app.projec t . item(index) .openInViewer()

Description

Opens the footage in a Footage panel, and moves the Footage panel to front and gives it focus. 

NOTE: Missing and placeholder footage can be opened using this method, but cannot manually (via double-
clicking it).

Parameters

None.

Returns

Viewer object for the Footage panel, or null if the footage could not be opened.

FootageItem replace() method 
app.projec t . item ( index) . replace( f i le)

Description 

Changes the source of this FootageItem to the specified file. In addition to loading the file, the method creates 
a new FileSource object for the file and sets mainS ource to that object. In the new source object, it sets the 
name, width, height , f rameDurat ion, and durat ion attributes (see “AVItem object” on page 30) based on the 
contents of the file.

The method preserves interpretation parameters from the previous mainS ource object. If the specified file has 
an unlabeled alpha channel, the method estimates the alpha interpretation.
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Parameters

FootageItem replaceWithPlaceholder() method 
app.projec t . item ( index) . replaceWithPlaceholder(name,  w idth,  he ight ,  f rameRate ,  duration )

Description 

Changes the source of this FootageItem to the specified placeholder. Creates a new PlaceholderSource object, 
sets its values from the parameters, and sets mainSource to that object. 

Parameters

FootageItem replaceWithSequence() method 
app.projec t . item ( index) . replaceWithSequence( f i le ,  forceAlphabetical)

Description 

Changes the source of this FootageItem to the specified image sequence. In addition to loading the file, the 
method creates a new FileSource object for the file and sets mainSource to that object. In the new source 
object, it sets the name, width, height , f rameDurat ion, and durat ion attributes (see “AVItem object” on 
page 30) based on the contents of the file.

The method preserves interpretation parameters from the previous mainS ource object. If the specified file has 
an unlabeled alpha channel, the method estimates the alpha interpretation.

Parameters

FootageItem replaceWithSolid() method 
app.projec t . item ( index) . replaceWithSol id(color,  name,  width ,  height,  pixelAspec t)

Description 

Changes the source of this FootageItem to the specified solid. Creates a new SolidSource object, sets its values 
from the parameters, and sets mainSource to that object. 

f i le An ExtendScript File object for the file to be used as the footage main source.

name A string containing the name of the placeholder.

width The width of the placeholder in pixels, an integer in the range [4..30000].

height The height of the placeholder in pixels, an integer in the range [4..30000].

f rameR ate The frame rate of the placeholder, a floating-point value in the range [1.0..99.0]

durat ion The duration of the placeholder in seconds, a floating-point value in the range [0.0..10800.0].

f i le An ExtendScript File object for the first file in the sequence to be used as the footage main source.

forceAlphabet ica l When true, use the “Force alphabetical order” option. 
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Parameters

color The color of the solid, an array of three floating-point values, [R, G, B], in the range [0.0..1.0].

name A string containing the name of the solid.

width The width of the solid in pixels, an integer in the range [4..30000].

height The height of the solid in pixels, an integer in the range [4..30000].

pixelAsp ect The pixel aspect ratio of the solid, a floating-point value in the range [0.01..100.0].
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FootageSource object
app.projec t . item ( index) .mainS ource
app.projec t . item ( index) .proxySource

Description

The FootageSource object holds information describing the source of some footage. It is used as the 
mainS ource of a FootageItem, or the proxySource of a CompItem or FootageItem. See “FootageItem object” 
on page 65 and “CompItem object” on page 52.

• FootageSource is the base class for SolidSource, so FootageSource attributes and methods are available 
when working with SolidSource objects. See “SolidSource object” on page 179.

Attributes

Methods

Attribute Reference Description

hasAlpha “FootageSource hasAlpha attribute” on 
page 72

When true, a footage clip or proxy includes an 
alpha channel.

a lphaMode “FootageSource alphaMode attribute” 
on page 70

The mode of an alpha channel.

premulC olor “FootageSource premulColor attribute” 
on page 73

The color to be premultiplied.

inver tAlpha “FootageSource invertAlpha attribute” 
on page 72

When true, an alpha channel in a footage clip or 
proxy should be inverted.

i sSt i l l “FootageSource isStill attribute” on 
page 72

When true, footage is a still image.

f ie ldS eparat ionTyp e “FootageSource fieldSeparationType 
attribute” on page 71

The field separation type.

highQual ityFie ldS eparat ion “FootageSource highQualityFieldSepa-
ration attribute” on page 72

How the fields are to be separated in non-still foot-
age.

removePul ldown “FootageSource removePulldown attri-
bute” on page 73

The pulldown type for the footage.

lo op “FootageSource loop attribute” on 
page 73

How many times an image sequence is set to loop.

nat iveFrameR ate “FootageSource nativeFrameRate attri-
bute” on page 73

The native frame rate of the footage.

displayFrameR ate “FootageSource displayFrameRate 
attribute” on page 70

The effective frame rate as displayed and rendered 
in compositions by After Effects.

conformFrameR ate “FootageSource conformFrameRate 
attribute” on page 70

The rate to which footage should conform.

Method Reference Description

guessAlphaMode() “FootageSource guessAlphaMode() 
method” on page 71

Estimates the alphaMo de  setting.

guessPul ldown() “FootageSource guessPulldown() 
method” on page 71

Estimates the pul ldownTyp e  setting.
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FootageSource alphaMode attribute
app.projec t . item ( index) .mainS ource .a lphaMode
app.projec t . item ( index) .proxySource.a lphaMode

Description

The alphaMode attribute of footageSource defines how the alpha information in the footage is to be inter-
preted. If hasAlpha is false, this attribute has no relevant meaning.

Type

An AlphaMo de enumerated value; (read/write). One of:

AlphaMo de.IGNORE 
AlphaMo de.STRAIGHT 
AlphaMo de.PREMULTIPLIED 

FootageSource conformFrameRate attribute
app.projec t . item ( index) .mainS ource .conformFrameR ate  
app.projec t . item ( index) .proxySource.conformFrameR ate

Description

A frame rate to use instead of the nat iveFrameR ate value. If set to 0, the nat iveFrameR ate is used instead. 

It is an error to set this value if FootageS ource. i sSt i l l  is true. It is an error to set this value to 0 if remove-
Pul ldown is not set to Pul ldownPhase.OFF. If this is 0 when you set removePul ldown to a value other than 
Pul ldownPhas e.OFF, then this is automatically set to the value of nat iveFrameR ate.

Type

Floating-point value in the range [0.0.. 99.0]; read/write.

FootageSource displayFrameRate attribute
app.projec t . item ( index) .mainS ource .displayFrameR ate  
app.projec t . item ( index) .proxySource.displayFrameR ate

Description

The effective frame rate as displayed and rendered in compositions by After Effects.

If removePul ldown is Pul ldownPhas e.OFF, then this is the same as the conformFrameR ate (if non-zero) or 
the nat iveFrameR ate (if conformFrameR ate is 0). If removePul ldown is not Pul ldownPhas e.OFF, this is 
conformFrameR ate * 0.8, the effective frame rate after removing 1 of every 5 frames.

Type

Floating-point value in the range [0.0.. 99.0]; read-only.
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FootageSource fieldSeparationType attribute
app.projec t . item ( index) .mainS ource . f ie ldSeparat ionTyp e 
app.projec t . item ( index) .proxySource. f ie ldS eparat ionType

Description

How the fields are to be separated in non-still footage. 

It is an error to set this attribute if i sSt i l l  is true. It is an error to set this value to FieldSeparat ionType.OFF if 
removePul ldown is not Pul ldownPhas e.OFF. 

Type 

A FieldS eparat ionTyp e enumerated value; read/write. One of:

FieldSeparat ionType.OFF
FieldSeparat ionType.UPPER_FIELD_FIRST
FieldSeparat ionType.LOWER_FIELD_FIRST

FootageSource guessAlphaMode() method
app.projec t . item ( index) .mainS ource .guessAlphaMode()
app.projec t . item ( index) .proxySource.guessAlphaMo de()

Description

Sets a lphaMode, premulC olor, and inver tAlpha to the best estimates for this footage source. If hasAlpha is 
false, no change is made.

Parameters

None.

Returns

Nothing.

FootageSource guessPulldown() method
app.projec t . item ( index) .mainS ource .guessPul ldown(method)
app.projec t . item ( index) .proxySource.guessPul ldown(method)

Description

Sets f ie ldS eparat ionType and removePul ldown to the best estimates for this footage source. If i sSt i l l  is true, 
no change is made.

Parameters

Returns

Nothing.

method The method to use for estimation. A Pul ldownMethod  enumerated value, one of:

Pul ldownMethod.PULLD OWN_3_2
Pul ldownMethod.ADVANCE_24P
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FootageSource hasAlpha attribute
app.projec t . item ( index) .mainS ource.hasAlpha
app.projec t . item ( index) .proxySource.hasAlpha

Description

When true, the footage has an alpha component. In this case, the attributes a lphaMo de, inver tAlpha, and 
premulC olor have valid values. When false, those attributes have no relevant meaning for the footage.

Type

Boolean; read-only.

FootageSource highQualityFieldSeparation attribute
app.projec t . item ( index) .mainS ource .highQual ityFie ldSeparat ion
app.projec t . item ( index) .proxySource.highQual ityFieldSeparat ion

Description

When true, After Effects uses special algorithms to determine how to perform high-quality field separation.

It is an error to set this attribute if i sSt i l l  is true, or if f ie ldSeparat ionType is FieldSeparat ionType.OFF.

Type

Boolean; read/write.

FootageSource invertAlpha attribute
app.projec t . item ( index) .mainS ource . inver tAlpha 
app.projec t . item ( index) .proxySource. inver tAlpha

Description

When true, an alpha channel in a footage clip or proxy should be inverted. 

This attribute is valid only if an alpha is present. If hasAlpha is false, or if a lphaMode is AlphaMo de.IGNORE, 
this attribute is ignored.

Type

Boolean; read/write.

FootageSource isStill attribute
app.projec t . item ( index) .mainS ource . i sSt i l l  
app.projec t . item ( index) .proxySource. isSt i l l

Description

When true the footage is still; when false, it has a time-based component. 

Examples of still footage are JPEG files, solids, and placeholders with duration of 0. Examples of non-still 
footage are movie files, sound files, sequences, and placeholders of non-zero duration.

Type

Boolean; read-only.
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FootageSource loop attribute
app.projec t . item ( index) .mainS ource . lo op 
app.projec t . item ( index) .proxySource. loop

Description

The number of times that the footage is to be played consecutively when used in a composition. 

It is an error to set this attribute if i sSt i l l  is true.

Type

Integer in the range [1.. 9999]; default is 1; read/write.

FootageSource nativeFrameRate attribute
app.projec t . item ( index) .mainS ource .nat iveFrameR ate  
app.projec t . item ( index) .proxySource.nat iveFrameR ate

Description

The native frame rate of the footage.

Type

Floating-point; read/write.

FootageSource premulColor attribute
app.projec t . item ( index) .mainS ource .premulC olor
app.projec t . item ( index) .proxySource.premulC olor

Description

The color to be premultiplied. This attribute is valid only if the a lphaMode is a lphaMode.PREMULTIPLIED.

Type

Array of three floating-point values [R ,  G,  B], in the range [0.0..1.0]; read/write.

FootageSource removePulldown attribute
app.projec t . item ( index) .mainS ource .removePul ldown 
app.projec t . item ( index) .proxySource.removePul ldown

Description

How the pulldowns are to be removed when field separation is used. 

It is an error to set this attribute if i sSt i l l  is true. It is an error to attempt to set this to a value other than 
Pul ldownPhas e.OFF in the case where f ie ldS eparat ionTyp e is FieldS eparat ionType.OFF. 

Type 

A Pul ldownPhase enumerated value; read/write. One of:

Pul ldownPhas e .RemovePul ldown.OFF
Pul ldownPhas e .RemovePul ldown.WSSWW
Pul ldownPhas e .RemovePul ldown.SSWWW
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Pul ldownPhas e .RemovePul ldown.SWWWS
Pul ldownPhas e .RemovePul ldown.WWWSS
Pul ldownPhas e .RemovePul ldown.WWSSW
Pul ldownPhas e .RemovePul ldown.WSSWW_24P_ADVANCE
Pul ldownPhas e .RemovePul ldown.SSWWW_24P_ADVANCE
Pul ldownPhas e .RemovePul ldown.SWWWS_24P_ADVANCE
Pul ldownPhas e .RemovePul ldown.WWWSS_24P_ADVANCE
Pul ldownPhas e .RemovePul ldown.WWSSW_24P_ADVANCE
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ImportOptions object
new ImportOpt ions() ;
new ImportOpt ions( f i le) ;

Description

The ImportOptions object encapsulates the options used to import a file with the Project . importFi le  
methods. See “Project importFile() method” on page 118.

The constructor takes an optional parameter, an ExtendScript File object for the file. If it is not supplied, you 
must explicitly set the value of the f i le  attribute before using the object with the importFi le  method. For 
example:

new ImportOpt ions() . f i le  =  new Fi le( "myf i le .psd") ;

Attributes

Methods

ImportOptions canImportAs() method
impor tOptions .canImportAs( type)

Description

Reports whether the file can be imported as the source of a particular object type. If this method returns true, 
you can set the given type as the value of the importAs attribute. See “ImportOptions importAs attribute” on 
page 76.

Parameters

Attributes Reference Description

imp ortAs “ImportOptions importAs attribute” on 
page 76

The type of file to be imported.

sequence “ImportOptions sequence attribute” on 
page 77

When true, import a sequence of files, rather than an individ-
ual file.

forceAlphabet ica l “ImportOptions forceAlphabetical attri-
bute” on page 76

When true, the “Force alphabetical order” option is set.

f i le “ImportOptions file attribute” on 
page 76

The file to import, or the first file of the sequence to import.

Method Reference Description

canImportAs() “ImportOptions canImportAs() method” 
on page 75

Restricts input to a particular file type.

type The type of file that can be imported. An ImportAsType enumerated value; one of:

Imp or tAsTyp e.COMP
Imp or tAsTyp e.FO OTAGE
Imp or tAsTyp e.COMP_CROPPED_LAYERS
Imp or tAsTyp e.PROJECT
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Returns

Boolean.

Example

var  io  = new ImportOpt ions(Fi le(“c : \ \myFi le .psd”)) ;
i f  io.canImp ortAs(ImportAsType.COMP);

io. imp or tAs = Imp or tAsTyp e.COMP;

ImportOptions file attribute
impor tOptions . f i le

Description

The file to be imported. If a file is set in the constructor, you can access it through this attribute.

Type

ExtendScript File object; read/write.

ImportOptions forceAlphabetical attribute
impor tOptions . forceAlphabet ica l

Description

When true, has the same effect as setting the “Force alphabetical order” option in the File > Import > File 
dialog box.

Type

Boolean; read/write.

ImportOptions importAs attribute
impor tOptions . imp ortAs

Description

The type of object for which the imported file is to be the source. Before setting, use canImportAs to check 
that a given file can be imported as the source of the given object type. See “ImportOptions canImportAs() 
method” on page 75.

Type 

An ImportAsType enumerated value; read/write. One of:

ImportAsType.COMP_CROPPED_L AYERS
ImportAsType.FO OTAGE
ImportAsType.COMP
ImportAsType.PROJECT
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ImportOptions sequence attribute
impor tOptions . s equence

Description

When true, a sequence is imported; otherwise, an individual file is imported.

Type

Boolean; read/write.
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Item object
app.projec t . item(index)
app.projec t . items[index]

Description

The Item object represents an item that can appear in the Project panel.

The first item is at index 1.

• Item is the base class for AVItem and for FolderItem, which are in turn the base classes for various other 
item types, so Item attributes and methods are available when working with all of these item types. See 
“AVItem object” on page 30 and “FolderItem object” on page 63.

Attributes

Methods

Example

This example gets the second item from the project and checks that it is a folder. It then removes from the 
folder any top-level item that is not currently selected. It also checks to make sure that, for each item in the 
folder, the parent is properly set to the correct folder.

var  myFolder  =  app.projec t . item(2) ;
i f  (myFolder. typ eName != "Folder")  {

a ler t( "error :  s econd item is  not  a  folder") ;
}
e ls e  {

var  numInFolder  =  myFolder.numItems;
//  Always  run lo ops  backwards  when delet ing  things :
for( i  =  numInFolder ;  i  >= 1 ;  i --)  {

var  curItem = myFolder. i tem(i) ;
i f  (  curItem.parentFolder  !=  myFolder)  {

a ler t( "error  within  AE:  the  parentFolder  i s  not  set  correc t ly") ;
}
e ls e  {

i f  (  !curItem.se lected && curItem.typ eName == "Footage")  {

Attributes Reference Description

name “Item name attribute” on page 79 The name of the object as shown in the Project panel. 

comment “Item comment attribute” on page 79 A descriptive string.

id “Item id attribute” on page 79 A unique identifier for this item.

parentFolder “Item parentFolder attribute” on page 80 The parent folder of this item.

se lec ted “Item selected attribute” on page 80 When true, this item is currently selected.

typeName “Item typeName attribute” on page 81 The type of item.

l ab el “Item label attribute” on page 79 The label color for the item.

Method Reference Description 

remove() “Item remove() method” on page 80 Deletes the item from the project.
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/ / found an uns elected  s ol id .
curItem.remove() ;

}
}

}
}

Item comment attribute
app.projec t . item ( index) . comment

Description

A string that holds a comment, up to 15,999 bytes in length after any encoding conversion. The comment is 
for the user's purpose only; it has no effect on the item's appearance or behavior.

Type

String; read/write.

Item id attribute
app.projec t . item ( index) . id

Description

A unique and persistent identification number used internally to identify an item between sessions. The value 
of the ID remains the same when the project is saved to a file and later reloaded. However, when you import 
this project into another project, new IDs are assigned to all items in the imported project. The ID is not 
displayed anywhere in the user interface.

Type

Integer; read-only.

Item label attribute
app.projec t . item(index) . label

Description

The label color for the item. Colors are represented by their number (0 for None, or 1 to 16 for one of the preset 
colors in the Labels preferences).

Custom label colors cannot be set programmatically.

Type

Integer (0 to 16); read/write.

Item name attribute
app.projec t . item(index) .name

Description

The name of the item as displayed in the Project panel.
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Type

String; read/write.

Item parentFolder attribute
app.projec t . item ( index) .parentFolder

Description

The FolderItem object for the folder that contains this item. If this item is at the top level of the project, this is 
the project's root folder (app.project . ro otFolder). You can use the ItemCollection’s addFolder method to add 
a new folder, and set this value to put items in the new folder. See “ItemCollection addFolder() method” on 
page 82.

Type

FolderItem object; read/write.

Example

This script creates a new FolderItem in the Project panel and moves compositions into it. 

/ /  create  a  new FolderItem in project ,  with name “comps”  
var  compFolder  =  app.project . i tems.addFolder(“comps”) ;  
/ /  move a l l  comp osit ions  into new folder  by sett ing
//  compItem’s  parentFolder  to  “comps”  folder  
for(var  i  =  1 ;  i  <= app.projec t .numItems;  i++)  {

i f (app.project . item(i )  instanceof  C ompItem) 
app.projec t . item(i) .parentFolder  =  compFolder ;  

}

Item remove() method
app.projec t . item ( index) . remove()

Description

Deletes this item from the project and from the Project panel. If the item is a FolderItem, all the items 
contained in the folder are also removed from the project. No files or folders are removed from disk.

Parameters

None.

Returns

Nothing.

Item selected attribute
app.projec t . item ( index) . s e lected

Description

When true, this item is selected. Multiple items can be selected at the same time. Set to true to select the item 
programmatically, or to false to deselect it.
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Type

Boolean; read/write.

Item typeName attribute
app.projec t . item ( index) . typ eName

Description

A user-readable name for the item type; for example, “Folder”, “Footage”, or “Composition”.

Type

String; read-only.
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ItemCollection object
app.projec t . items

Description

The ItemCollection object represents a collection of items. The ItemCollection belonging to a Project object 
contains all the Item objects for items in the project. The ItemCollection belonging to a FolderItem object 
contains all the Item objects for items in that folder.

• ItemCollection is a subclass of Collection. All methods and attributes of Collection, in addition to those 
listed below, are available when working with ItemCollection. See “Collection object” on page 51.

Methods

ItemCollection addComp() method
app.projec t . items .addC omp(name,  w idth,  he ight ,  pixelAspec t ,  duration,  f rameRate)

Description

Creates a new composition. Creates and returns a new CompItem object and adds it to this collection. 

If the ItemCollection belongs to the project or the root folder, then the new item’s parentFolder  is the root 
folder. If the ItemCollection belongs to any other folder, the new item’s parentFolder is that FolderItem.

Parameters

Returns

CompItem object.

ItemCollection addFolder() method
app.projec t . items .addFolder(name )

Description

Creates a new folder. Creates and returns a new FolderItem object and adds it to this collection. 

Method Reference Description 

addC omp() “ItemCollection addComp() method” on 
page 82

Creates a new CompItem object and adds it to the collection.

addFolder() “ItemCollection addFolder() method” on 
page 82

Creates a new FolderItem object and adds it to the collection.

name A string containing the name of the composition.

width The width of the composition in pixels, an integer in the range [4..30000].

height The height of the composition in pixels, an integer in the range [4..30000].

pixelAsp ect The pixel aspect ratio of the composition, a floating-point value in the range [0.01..100.0].

durat ion The duration of the composition in seconds, a floating-point value in the range [0.0..10800.0].

f rameR ate The frame rate of the composition, a floating-point value in the range [1.0..99.0]
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If the ItemCollection belongs to the project or the root folder, then the new folder’s parentFolder  is the root 
folder. If the ItemCollection belongs to any other folder, the new folder’s parentFolder is that FolderItem.

To put items in the folder, set the item object’s parentFolder  attribute; see “Item parentFolder attribute” on 
page 80.

Parameters

Returns

FolderItem object.

Example

This script creates a new FolderItem in the Project panel and moves compositions into it. 

/ /  create  a  new FolderItem in project ,  with name “comps”  
var  compFolder  =  app.project . i tems.addFolder(“comps”) ;  
/ /  move a l l  comp osit ions  into new folder  by sett ing
//  compItem’s  parentFolder  to  “comps”  folder  
for(var  i  =  1 ;  i  <= app.projec t .numItems;  i++)  {

i f (app.project . item(i )  instanceof  C ompItem) 
app.projec t . item(i) .parentFolder  =  compFolder ;  

}

name A string containing the name of the folder.
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KeyframeEase object
myKey = new KeyframeE ase(speed,  inf luence ) ;

Description

The KeyframeEase object encapsulates the keyframe ease settings of a layer’s AE property. Keyframe ease is 
determined by the speed and influence values that you set using the property’s setTemp ora lEaseAtKey 
method. See “Property setTemporalEaseAtKey() method” on page 144.

The constructor creates a KeyframeEase object. Both parameters are required. 

• speed: A floating-point value. Sets the sp eed attribute.

• inf luence: A floating-point value in the range [0.1..100.0]. Sets the inf luence attribute.

Example

This example assumes that the Position, a spatial property, has more than two keyframes.

var  eas eIn  = new KeyframeE ase(0 .5 ,  50) ;
var  eas eOut  =  new KeyframeEase(0 .75 ,  85) ;
var  myPosit ionProper ty  = app.projec t . i tem(1) . layer(1) .proper ty( "Posit ion ")
myPosit ionProper ty.setTemporalE as eAtKey(2 ,  [easeIn] ,  [easeOut]) ;

This example sets the Scale, a temporal property with either two or three dimensions. For 2D and 3D 
properties you must set an eas eIn and easeOut value for each dimension:

var  eas eIn  = new KeyframeE ase(0 .5 ,  50) ;
var  eas eOut  =  new KeyframeEase(0 .75 ,  85) ;
var  myScaleProper ty  = app.projec t . item(1) . layer(1) .prop er ty("Sca le")
myScaleProper ty.s etTemporalE aseAtKey(2 ,  [easeIn,  eas eIn ,  easeIn] ,  [eas eOut ,  easeOut,  easeOut]) ;

Attributes

KeyframeEase influence attribute
myKey. inf luence

Description

The influence value of the keyframe, as shown in the Keyframe Velocity dialog box. 

Type

Floating-point value in the range [0.1..100.0]; read/write.

Attribute Reference Description

speed “KeyframeEase speed attribute” on page 85 The speed setting for a keyframe.

inf luence “KeyframeEase influence attribute” on page 84 The influence setting for a keyframe.
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KeyframeEase speed attribute
myKey. speed

Description

The speed value of the keyframe. The units depend on the type of keyframe, and are displayed in the Keyframe 
Velocity dialog box.

Type

Floating-point value; read/write.
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Layer object
app.projec t . item(index) . layer( index)

Description

The Layer object provides access to layers within compositions. It can be accessed from an item’s layer 
collection either by index number or by a name string. 

• Layer is the base class for CameraLayer, LightLayer, and AVLayer, so Layer attributes and methods are 
available when working with all layer types. See “AVLayer object” on page 38, 
“CameraLayer object” on page 50, and “LightLayer object” on page 100.

Layers contain AE properties, in addition to their JavaScript attributes and methods. For examples of how to 
access properties in layers, see “PropertyBase object” on page 148.

Example

If the first item in the project is a CompItem, this example disables the first layer in that composition and 
renames it. This might, for example, turn an icon off in the composition.

var  f i rs tL ayer  = app.project . item(1) . layer(1) ;
f i rs tL ayer.enabled = fa lse ;
f i rs tL ayer.name = "Disabled L ayer" ;

Attributes 

Attribute Reference Description

index “Layer index attribute” on page 90 The index position of the layer.

name “Layer name attribute” on page 92 The name of the layer.

parent “Layer parent attribute” on page 92 The parent of this layer.

t ime “Layer time attribute” on page 94 The current time of the layer.

star tTime “Layer startTime attribute” on page 94 The start time of the layer.

stretch “Layer stretch attribute” on page 94 The time stretch percentage of the layer.

inPoint “Layer inPoint attribute” on page 90 The “in” point of the layer.

outPoint “Layer outPoint attribute” on page 92 The “out” point of the layer.

enabled “Layer enabled attribute” on page 89 When true, the layer is enabled.

solo “Layer solo attribute” on page 94 When true, the layer is soloed.

shy “Layer shy attribute” on page 93 When true, the layer is shy.

lo cked “Layer locked attribute” on page 90 When true, the layer is locked.

hasVideo “Layer hasVideo attribute” on page 89 When true, the layer contains a video component.

ac t ive “Layer active attribute” on page 87 When true, the layer is active at the current time.

nul lL ayer “Layer nullLayer attribute” on page 92 When true, this is a null layer.

se lectedProper t ies  “Layer selectedProperties attribute” on page 93 All selected AE properties in the layer.

comment “Layer comment attribute” on page 88 A descriptive comment for the layer.

containingC omp “Layer containingComp attribute” on page 88 The composition that contains this layer.
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Methods

Layer active attribute
app.projec t . item(index) . layer( index) .ac t ive

Description

When true, the layer's video is active at the current time. 

For this to be true, the layer must be enabled, no other layer may be soloing unless this layer is soloed too, and 
the time must be between the inPoint  and outPoint  values of this layer.

This value is never true in an audio layer; there is a separate audioAct ive attribute in the AVLayer object.

Type

Boolean; read-only.

Layer activeAtTime() method
app.projec t . item(index) . layer( index) .ac t iveAtTime( t ime)

Description

Returns true if this layer will be active at the specified time. To return true, the layer must be enabled, no other 
layer may be soloing unless this layer is soloed too, and the time must be between the inPoint  and outPoint 
values of this layer.

isNameS et “Layer isNameSet attribute” on page 90 When true, the layer’s name has been explicitly set.

Method Reference Description

remove() “Layer remove() method” on page 93 Deletes the layer from the composition.

moveToB eginning() “Layer moveToBeginning() method” on 
page 91

Moves the layer to the top of the composition (makes it the 
first layer).

moveToEnd() “Layer moveToEnd() method” on 
page 91

Moves the layer to the bottom of the composition (makes it 
the last layer).

moveAfter() “Layer moveAfter() method” on page 90 Moves the layer below another layer.

moveB efore() “Layer moveBefore() method” on 
page 91

Moves the layer above another layer.

dupl icate() “Layer duplicate() method” on page 89 Duplicates the layer.

copyToC omp() “Layer copyToComp() method” on 
page 89

Copies the layer to the top (beginning) of another compo-
sition.

ac t iveAtTime() “Layer activeAtTime() method” on 
page 87

Reports whether this layer will be active at a specified time.

setParentWithJump() “Layer setParentWithJump() method” 
on page 93

Sets a new parent for this layer.

applyPreset( ) “Layer applyPreset() method” on 
page 88

Applies a named collection of animation settings to the 
layer.

Attribute Reference Description
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Parameters

Returns

Boolean.

Layer applyPreset() method
appapp.projec t . item(index) . layer( index) .applyPreset(presetName) ;

Description

Applies the specified collection of animation settings (an animation preset) to the layer. Predefined animation 
preset files are installed in the Presets folder, and users can create new animation presets through the user 
interface.

Parameters

Returns

Nothing.

Layer comment attribute
app.projec t . item(index) . layer( index) .comment

Description

A descriptive comment for the layer. 

Type

String; read/write.

Layer containingComp attribute
app.projec t . item(index) . layer( index) .containingC omp

Description

The composition that contains this layer.

Type

CompItem object; read-only.

t ime The time in seconds, a floating-point value. 

presetName An ExtendScript File object for the file containing the animation preset.
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Layer copyToComp() method
app.projec t . item(index) . layer( index) .copyToC omp( intoComp)

Description

Copies the layer into the specified composition. The original layer remains unchanged. Creates a new Layer 
object with the same values as this one, and prepends the new object to the layers  collection in the target 
CompItem. Retrieve the copy using intoComp. layer(1) . 

Copying in a layer changes the index positions of previously existing layers in the target composition. This is 
the same as copying and pasting a layer through the user interface.

Parameters

Returns

Nothing.

Layer duplicate() method
app.projec t . item(index) . layer( index) .dupl icate()

Description

Duplicates the layer. Creates a new Layer object in which all values are the same as in this one. This has the 
same effect as selecting a layer in the user interface and choosing Edit > Duplicate, except the selection in the 
user interface does not change when you call this method.

Parameters

None.

Returns

Layer object.

Layer enabled attribute
app.projec t . item(index) . layer( index) .enabled

Description

When true, the layer is enabled; otherwise false. This corresponds to the video switch state of the layer in the 
Timeline panel.

Type

Boolean; read/write.

Layer hasVideo attribute
app.projec t . item(index) . layer( index) .hasVideo

Description

When true, the layer has a video switch (the eyeball icon) in the Timeline panel; otherwise false. 

intoC omp The target composition, and CompItem object.
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Type

Boolean; read-only.

Layer index attribute
app.projec t . item(index) . layer( index) . index

Description

The index position of the layer.

Type

Integer in the range [1..numL ayers]; read-only.

Layer inPoint attribute
app.projec t . item(index) . layer( index) . inPoint

Description

The “in” point of the layer, expressed in composition time (seconds). 

Type

Floating-point value in the range [-10800.0..10800.0] (minus or plus three hours); read/write.

Layer isNameSet attribute
app.projec t . item(index) . layer( index) . i sNameSet

Description

True if the value of the name attribute has been set explicitly, rather than automatically from the source.

Type

Boolean; read-only.

Layer locked attribute
app.projec t . item(index) . layer( index) . lo cked

Description

When true, the layer is locked; otherwise false. This corresponds to the lock toggle in the Layer panel.

Type

Boolean; read/write.

Layer moveAfter() method
app.projec t . item(index) . layer( index) .moveAfter( layer)

Description

Moves this layer to a position immediately after (below) the specified layer.
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Parameters

Returns

Nothing.

Layer moveBefore() method
app.projec t . item(index) . layer( index) .moveB efore( layer)

Description

Moves this layer to a position immediately before (above) the specified layer.

Parameters

Returns

Nothing.

Layer moveToBeginning() method
app.projec t . item(index) . layer( index) .moveToB eginning()

Description

Moves this layer to the topmost position of the layer stack (the first layer).

Parameters

None.

Returns

Nothing.

Layer moveToEnd() method
app.projec t . item(index) . layer( index) .moveToEnd()

Description

Moves this layer to the bottom position of the layer stack (the last layer).

Parameters

None.

Returns

Nothing.

layer The target layer, a layer object in the same composition.

l ayer The target layer, a layer object in the same composition.



92

After Effects scripting reference Layer object 

92 

Layer name attribute
app.projec t . item(index) . layer( index) .name

Description

The name of the layer. By default, this is the same as the Source name (which cannot be changed in the Layer 
panel), but you can set it to be different.

Type

String; read/write.

Layer nullLayer attribute
app.projec t . item(index) . layer( index) .nul lL ayer

Description

When true, the layer was created as a null object; otherwise false.

Type

Boolean; read-only.

Layer outPoint attribute
app.projec t . item(index) . layer( index) .outPoint

Description

The “out” point of the layer, expressed in composition time (seconds). 

Type

Floating-point value in the range [-10800.0..10800.0] (minus or plus three hours); read/write.

Layer parent attribute
app.projec t . item(index) . layer( index) .parent

Description

The parent of this layer; can be null. 

Offset values are calculated to counterbalance any transforms above this layer in the hierarchy, so that when 
you set the parent there is no apparent jump in the layer's transform. For example, if the new parent has a 
rotation of 30 degrees, the child layer is assigned a rotation of -30 degrees. 

To set the parent without changing the child layer's transform values, use the setParentWithJump method.

Type

Layer object or null; read/write.
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Layer remove() method
app.projec t . item(index) . layer( index) .remove()

Description

Deletes the specified layer from the composition.

Parameters

None.

Returns

Nothing.

Layer selectedProperties attribute
app.projec t . item(index) . layer( index) .s electedProper t ies

Description

An array containing all of the currently selected Property and PropertyGroup objects in the layer.

Type

Array of PropertyBase objects; read-only.

Layer setParentWithJump() method
app.projec t . item(index) . layer( index) .s etParentWithJump()
app.projec t . item(index) . layer( index) .s etParentWithJump(newParent)

Description

Sets the parent of this layer to the specified layer, without changing the transform values of the child layer. 
There may be an apparent jump in the rotation, translation, or scale of the child layer, as this layer’s transform 
values are combined with those of its ancestors.

If you do not want the child layer to jump, set the parent  attribute directly. In this case, an offset is calculated 
and set in the child layer's transform fields, to prevent the jump from occurring.

Parameters

Returns

Nothing.

Layer shy attribute
app.projec t . item(index) . layer( index) .shy

Description

When true, the layer is “shy,” meaning that it is hidden in the Layer panel if the composition’s “Hide all shy 
layers” option is toggled on.

newParent Optional, a layer object in the same composition. If not specified, it sets the parent to None.
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Type

Boolean; read/write.

Layer solo attribute
app.projec t . item(index) . layer( index) .s olo

Description

When true, the layer is soloed, otherwise false.

Type

Boolean; read/write.

Layer startTime attribute
app.projec t . item(index) . layer( index) .s tar tTime

Description

The start time of the layer, expressed in composition time (seconds). 

Type

Floating-point value in the range [-10800.0..10800.0] (minus or plus three hours); read/write.

Layer stretch attribute
app.projec t . item(index) . layer( index) .s t retch

Description

The layer’s time stretch, expressed as a percentage. A value of 100 means no stretch. Values between 0 and 1 
are set to 1, and values between -1 and 0 (not including 0) are set to -1. 

Type

Floating-point value in the range [-9900.0..9900.0]; read/write.

Layer time attribute
app.projec t . item(index) . layer( index) . t ime

Description

The current time of the layer, expressed in composition time (seconds).

Type

Floating-point value; read-only.
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LayerCollection object
app.projec t . item(index) . layers

Description

The LayerCollection object represents a set of layers. The LayerCollection belonging to a CompItem object 
contains all the layer objects for layers in the composition. The methods of the collection object allow you to 
manipulate the layer list.

• LayerCollection is a subclass of Collection. All methods and attributes of Collection, in addition to those 
listed below, are available when working with LayerCollection. See “Collection object” on page 51.

Example

Given that the first item in the project is a CompItem and the second item is an AVItem, this example shows 
the number of layers in the CompItem's layer collection, adds a new layer based on an AVItem in the project, 
then displays the new number of layers.

var  f i rs tC omp = app.project . item(1) ;
var  layerC ol lec t ion = f i rs tC omp.layers ;
a ler t( "number  of  l ayers  before  is  "  +  layerC ol lec t ion . length) ;
var  anAVItem = app.project . i tem(2) ;
layerC ol lec t ion.add(anAVItem);
a ler t( "number  of  l ayers  af ter  i s  "  +  layerC ol lec t ion. length) ;

Methods

Method Reference Description

add() “LayerCollection add() method” on 
page 96

Creates a new AVLayer and adds it to this collection.

addNul l() “LayerCollection addNull() method” on 
page 97

Creates a new, null layer and adds it to this collection.

addS ol id() “LayerCollection addSolid() method” on 
page 98

Creates a new layer, a FootageItem with a SolidSource, and adds it 
to this collection.

addText() “LayerCollection addText() method” on 
page 98

Creates a new point text layer and adds it to this collection.

addB oxText() “LayerCollection addBoxText() method” 
on page 96

Creates a new paragraph (box) text layer and adds it to this collec-
tion.

addC amera() “LayerCollection addCamera() method” 
on page 96

Creates a new camera layer and adds it to this collection.

addLight() “LayerCollection addLight() method” on 
page 97

Creates a new light layer and adds it to this collection.

addShap e() “LayerCollection addShape() method” 
on page 97

Creates a new shape layer and adds it to this collection.

byName() “LayerCollection byName() method” on 
page 99

Retrieves the layer object with a specified name.

precompos e() “LayerCollection precompose() 
method” on page 99

Collects specified layers into a new composition.
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LayerCollection add() method
app.projec t . item(index) . layers .add( i tem,  duration)

Description

Creates a new AVLayer object containing the specified item, and adds it to this collection.

The new layer honors the Create Layers at Composition Start Time preference.

This method generates an exception if the item cannot be added as a layer to this CompItem.

Parameters

Returns

AVLayer object.

LayerCollection addBoxText() method
app.projec t . item(index) . layers .addB oxText(sourceText)

Description

Creates a new paragraph (box) text layer and adds the new TextLayer object to this collection. 

To create a point text layer, use the addText()  method. For more information, see “LayerCollection addText() 
method” on page 98.

Parameters

Returns

TextLayer object.

LayerCollection addCamera() method
app.projec t . item(index) . layers .addC amera(name,  centerPoint)

Description

Creates a new camera layer and adds the CameraLayer object to this collection.

The new layer honors the Create Layers at Composition Start Time preference.

Parameters

i tem The AVItem object for the item to be added.

durat ion Optional, the length of a still layer in seconds, a floating-point value. Used only if the item contains a piece of 
still footage. Has no effect on movies, sequences or audio. 

If supplied, sets the durat ion  value of the new layer. Otherwise, the duration  value is set according to user 
preferences. By default, this is the same as the duration of the containing CompItem. To set another preferred 
value, choose Edit > Preferences > Import (Windows) or After Effects > Preferences > Import (Mac OS), and spec-
ify options under Still Footage.

sourceText Optional; a string containing the source text of the new layer, or a TextDocument object contain-
ing the source text of the new layer. See “TextDocument object” on page 182.

name A string containing the name of the new layer.
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Returns

CameraLayer object.

LayerCollection addLight() method
app.projec t . item(index) . layers .addLight(name,  centerPoint )

Description

Creates a new light layer and adds the LightLayer object to this collection.

The new layer honors the Create Layers at Composition Start Time preference.

Parameters

Returns

LightLayer object.

LayerCollection addNull() method
app.projec t . item(index) . layers .addNul l(duration)

Description

Creates a new null layer and adds the AVLayer object to this collection. This is the same as choosing
Layer > New > Null Object. 

Parameters

Returns

AVLayer object.

LayerCollection addShape() method
app.projec t . item(index) . layers .addShape()

Description

Creates a new ShapeLayer object for a new, empty Shape layer. Use the ShapeLayer object to add properties, 
such as shape, fill, stroke, and path filters. 

centerPoint The center of the new camera, a floating-point array [x, y]. This is used to set the initial x and y values of the 
new camera’s Point of Interest property. The z value is set to 0.

name A string containing the name of the new layer.

centerPoint The center of the new light, a floating-point array [x, y]. 

durat ion Optional, the length of a still layer in seconds, a floating-point value. 

If supplied, sets the durat ion  value of the new layer. Otherwise, the durat ion  value is set according to user 
preferences. By default, this is the same as the duration of the containing CompItem. To set another preferred 
value, choose Edit > Preferences > Import (Windows) or After Effects > Preferences > Import (Mac OS), and specify 
options under Still Footage.
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This is the same as using a shape tool in "Tool Creates Shape" mode. Tools automatically add a vector group 
that includes Fill and Stroke as specified in the tool options.

Parameters

None.

Returns

ShapeLayer object.

LayerCollection addSolid() method
app.projec t . item(index) . layers .addS ol id(color,  name,  w idth ,  height ,  pixelAspec t ,  duration )

Description

Creates a new SolidSource object, with values set as specified; sets the new SolidSource as the mainS ource 
value of a new FootageItem object, and adds the FootageItem to the project. Creates a new AVLayer object, 
sets the new FootageItem as its source, and adds the layer to this collection.

Parameters

Returns

AVLayer object.

LayerCollection addText() method
app.projec t . item(index) . layers .addText( sourceText)

Description

Creates a new point text layer and adds the new TextLayer object to this collection. 

To create a paragraph (box) text layer, use the addB oxText()  method. For more information, see “LayerCol-
lection addBoxText() method” on page 96.

Parameters

color The color of the solid, an array of three floating-point values, [R, G, B], in the range [0.0..1.0].

name A string containing the name of the solid.

width The width of the solid in pixels, an integer in the range [4..30000].

height The height of the solid in pixels, an integer in the range [4..30000].

pixelAsp ect The pixel aspect ratio of the solid, a floating-point value in the range [0.01..100.0].

durat ion Optional, the length of a still layer in seconds, a floating-point value. 

If supplied, sets the durat ion  value of the new layer. Otherwise, the durat ion  value is set according to 
user preferences. By default, this is the same as the duration of the containing CompItem. To set another 
preferred value, choose Edit > Preferences > Import (Windows) or After Effects > Preferences > Import (Mac 
OS), and specify options under Still Footage.

sourceText Optional; a string containing the source text of the new layer, or a TextDocument object contain-
ing the source text of the new layer. See “TextDocument object” on page 182.
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Returns

TextLayer object.

LayerCollection byName() method
app.projec t . item(index) . layers .byName(name)

Description

Returns the first (topmost) layer found in this collection with the specified name, or null if no layer with the 
given name is found.

Parameters

Returns

Layer object or null.

LayerCollection precompose() method
app.projec t . item(index) . layers .precompos e( layerIndicies ,  name,  moveAllAttr ibutes )

Description

Creates a new CompItem object and moves the specified layers into its layer collection. It removes the 
individual layers from this collection, and adds the new CompItem to this collection.

Parameters

Returns

CompItem object.

name A string containing the name.

l ayerIndices The position indexes of the layers to be collected. An array of integers.

name The name of the new CompItem object.

moveAl lAttr ibutes Optional. When true (the default), retains all attributes in the new composition. 
This is the same as selecting the “Move all attributes into the new composition” 
option in the Pre-compose dialog box. 

You can only set this to false if there is just one index in the l ayerIndices  array. 
This is the same as selecting the “Leave all attributes in” option in the Pre-com-
pose dialog box.
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LightLayer object
app.projec t . item(index) . layer( index)

Description

The LightLayer object represents a light layer within a composition. Create it using the LayerCollection 
object’s addLight  method; see “LayerCollection addLight() method” on page 97. It can be accessed in an item’s 
layer collection either by index number or by a name string. 

• LightLayer is a subclass of Layer. All methods and attributes of Layer are available when working with Light-
Layer. See “Layer object” on page 86. 

AE Properties

LightLayer defines no additional attributes, but has different AE properties than other layer types. It has the 
following properties and property groups:

Marker  
Transform 

Point  of  Interest  
Posit ion 
S ca le  
Or ientat ion 
X Rotat ion 
Y Rotat ion  
Rotat ion 
Opacity  

L ight  Opt ions  
Intensity  
C olor  
C one Angle  
C one Feather  
Casts  Shadows 
Shadow Darkness  
Shadow Dif fusion

Attributes 

LightLayer lightType attribute
app.projec t . item(index) . layer( index) . l ightTyp e

Description

For a light layer, its light type.

Trying to set this attribute for a non-light layer produces an error.

Attribute Reference Description

l ightTyp e “LightLayer lightType attribute” on page 100 For light layers, the type of light.



101

After Effects scripting reference LightLayer object 

101 

Type

A LightTyp e enumerated value; read/write. One of:

L ightType.PARALLEL
LightType.SPOT
LightType.POINT
LightType.AMBIENT
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MarkerValue object
new MarkerValue(comment ,  chapter,  url ,  f rameTarget ,  cuePointName,  params)

Description

The MarkerValue object represents a layer marker, which associates a comment, and optionally a chapter 
reference point, Web-page link, or Flash Video cue point with a particular point in a layer. Create it with the 
constructor; all arguments except comment are optional. All arguments are strings that set in the corre-
sponding attributes of the returned MarkerValue object, except params. This is an array containing key-value 
pairs., which can then be accessed with the getParameters()  and s etParameters()  methods. A script can set 
any number of parameter pairs; the order does not reflect the order displayed in the application.

To associate a marker with a layer, set the MarkerValue object in the Marker  AE property of the layer:

layerObjec t .proper ty( "Marker") . setValueAtTime( t ime ,  markerValueObjec t) ;

For information on the usage of markers see “Using markers” in After Effects Help.

Attributes

Methods

Examples

• To set a marker that says “Fade Up” at the 2 second mark:
var  myMarker  =  new MarkerValue("Fade Up") ;
myL ayer.prop er ty("Marker") .s etValueAtTime(2 ,  myMarker) ;

Attribute Reference Description

comment “MarkerValue comment attribute” on 
page 103

A comment on the associated layer.

durat ion “MarkerValue duration attribute” on 
page 103

The amount of time represented by the marker.

chapter “MarkerValue chapter attribute” on 
page 103

A chapter link reference point for the associated layer. 

cuePointName “MarkerValue cuePointName attribute” 
on page 103

The Flash Video cue point name.

eventCuePoint “MarkerValue eventCuePoint attribute” 
on page 104

Whether the Flash Video cue point is for an event or navigation.

url “MarkerValue url attribute” on page 105 A URL for Web page to be associated with the layer. 

f rameTarget “MarkerValue frameTarget attribute” on 
page 104

A specific frame target within the Web page specified by url . 

Method Reference Description

getParameters() “MarkerValue getParameters() method” 
on page 104

Retrieves the key-value pairs associated with the marker value.

setParameters() “MarkerValue setParameters() method” 
on page 104

Sets the key-value pairs associated with the marker value.
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• To get comment values from a particular marker:

var  commentOfFirstMarker  = app.projec t . item(1) . layer(1) .proper ty( "Marker") .keyValue(1) .comment ;
var  commentOfMarkerAtTime4  = 

app.projec t . item(1) . layer(1) .proper ty("Marker") .va lueAtTime(4.0 , t rue) .comment
var  markerProp er ty  = app.projec t . item(1) . layer(1) .prop er ty("Marker") ;
var  markerValueAtTimeClos estToTime4 =

markerProper ty.keyValue(markerProp er ty.nearestKeyIndex(4 .0)) ;
var  commentOfMarkerClosestToTime4 = markerValueAtTimeClos estToTime4.comment ;

MarkerValue chapter attribute
app.projec t . item( index) . l ayer( index) .proper ty("Marker") .keyValue( index) .chapter

Description

A text chapter link for this marker. Chapter links initiate a jump to a chapter in a QuickTime movie or in other 
formats that support chapter marks.

Type

String; read/write.

MarkerValue comment attribute
app.projec t . item( index) . l ayer( index) .proper ty("Marker") .keyValue( index) .comment

Description

A text comment for this marker. This comment appears in the Timeline panel next to the layer marker.

Type

String; read/write.

MarkerValue cuePointName attribute
app.projec t . item( index) . l ayer( index) .proper ty("Marker") .keyValue( index) .cuePointName

Description

The Flash Video cue point name, as shown in the Marker dialog box.

Type

String; read/write.

MarkerValue duration attribute
app.projec t . item( index) . l ayer( index) .proper ty("Marker") .keyValue( index) .durat ion

Description

The marker’s duration, in seconds. The duration appears in the Timeline panel as a short bar extending from 
the marker location.

Type

Floating point; read/write.
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MarkerValue eventCuePoint attribute
app.projec t . item( index) . l ayer( index) .proper ty("Marker") .keyValue( index) .eventCuePoint

Description

When true, the FlashVideo cue point is for an event; otherwise, it is for navigation.

Type

Boolean; read/write.

MarkerValue frameTarget attribute
app.projec t . item( index) . l ayer( index) .proper ty("Marker") .keyValue( index) . f rameTarget

Description

A text frame target for this marker. Together with the URL value, this targets a specific frame within a Web 
page.

Type

String; read/write.

MarkerValue getParameters() method
app.projec t . item( index) . l ayer( index) .proper ty("Marker") .keyValue( index) .getParameters()

Description

Returns the key-value pairs for Flash Video cue-point parameters, for a cue point associated with this marker 
value.

Parameters

None.

Returns

An object with an attribute matching each parameter name, containing that parameter’s value.

MarkerValue setParameters() method
app.projec t . item( index) . l ayer( index) .proper ty("Marker") .keyValue( index) . setParameters(keyValuePairs )

Description

Associates a set of key-value pairs for Flash Video cue-point parameters, for a cue point associated with this 
marker value. A cue point can have any number of parameters, but you can add only three through the user 
interface; use this method to add more than three parameters.

Parameters

keyValuePairs An object containing the key-value pairs as attributes and values. The object’s toStr ing()  
method is called to assign the string value of each attribute to the named key.
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Returns

Nothing.

Example

var  mv = new MarkerValue("My Marker") ;

var  parms = new Objec t ;
parms.t imeToBlink = 1 ;
parms.ass ignMe = "A st r ing"

mv.setParameters(parms) ;

myL ayer.prop er ty("Marker") .s etValueAtTime(2 ,  mv) ;

MarkerValue url attribute
app.projec t . item( index) . l ayer( index) .proper ty("Marker") .keyValue( index) .ur l

Description

A URL for this marker. This URL is an automatic link to a Web page.

Type

String; read/write.
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MaskPropertyGroup object
app.projec t . item(index) . layer( index) .mask

Description

The MaskPropertyGroup object encapsulates mask attributes in a layer.

• MaskPropertyGroup is a subclass of PropertyGroup. All methods and attributes of PropertyBase and 
PropertyGroup, in addition to those listed below, are available when working with MaskPropertyGroup. See 
“PropertyBase object” on page 148 and “PropertyGroup object” on page 155.

Attributes

MaskPropertyGroup color attribute
app.projec t . item(index) . layer( index) .mask( index) . co lor

Description

The color used to draw the mask outline as it appears in the user interface (Composition panel, Layer panel, 
and Timeline panel).

Type

Array of three floating-point values, [R, G, B], in the range [0.0..1.0]; read/write.

MaskPropertyGroup inverted attribute
app.projec t . item(index) . layer( index) .mask( index) . inver ted

Description

When true, the mask is inverted; otherwise false.

Type

Boolean; read/write.

Attribute Reference Description

maskMo de “MaskPropertyGroup maskMode attribute” 
on page 107

The mask mode.

inver ted “MaskPropertyGroup inverted attribute” on 
page 106

When true, the mask is inverted.

rotoB ezier “MaskPropertyGroup rotoBezier attribute” 
on page 108

When true, the shape of the mask is RotoBezier.

maskMot ionBlur “MaskPropertyGroup maskMotionBlur attri-
bute” on page 107

How motion blur is applied to this mask.

lo cked “MaskPropertyGroup locked attribute” on 
page 107

When true, the mask is locked.

color “MaskPropertyGroup color attribute” on 
page 106

The color used to draw the mask outline in the user 
interface.

maskFeatherFal lof f “MaskPropertyGroup maskFeatherFalloff 
attribute” on page 107

The feather falloff mode for the mask.
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MaskPropertyGroup locked attribute
app.projec t . item(index) . layer( index) .mask( index) . lo cked

Description

When true, the mask is locked and cannot be edited in the user interface; otherwise, false.

Type

Boolean; read/write.

MaskPropertyGroup maskFeatherFalloff attribute
app.projec t . item(index) . layer( index) .mask( index) .maskFeatherFa l lof f

Description

The feather falloff mode for the mask. Equivalent to the Layer > Mask > Feather Falloff setting.

Type 

A MaskFeatherFal lof f  enumerated value; read/write. One of:

MaskFeatherFal lof f .FFO_LINEAR
MaskFeatherFal lof f .FFO_SMO OTH

MaskPropertyGroup maskMode attribute
app.projec t . item(index) . layer( index) .mask( index) .maskMode

Description

The masking mode for this mask.

Type 

A MaskMo de enumerated value; read/write. One of:

MaskMo de.NONE
MaskMo de.ADD
MaskMo de.SUBTRACT
MaskMo de.INTERSECT
MaskMo de.LIGHTEN
MaskMo de.DARKEN
MaskMo de.DIFFERENCE

MaskPropertyGroup maskMotionBlur attribute
app.projec t . item(index) . layer( index) .mask( index) .maskMotionBlur

Description

How motion blur is applied to this mask.
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Type 

A MakMotionBlur enumerated value; read/write. One of:

MaskMot ionBlur.SAME_AS_LAYER
MaskMot ionBlur.ON
MaskMot ionBlur.OFF

MaskPropertyGroup rotoBezier attribute
app.projec t . item(index) . layer( index) .mask(index) . rotoB ezier

Description

When true, the mask is a RotoBezier shape; otherwise, false.

Type

Boolean; read/write.
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OMCollection object
app.projec t . renderQueue. i tems.outputModules

Description

The OMCollection contains all of the output modules in a render queue. The collection provides access to the 
OutputModule objects, but does not provide any additional functionality. The first OutputModule object in 
the collection is at index position 1. See “OutputModule object” on page 110

• OMCollection is a subclass of Collection. All methods and attributes of Collection are available when 
working with OMCollection. See “Collection object” on page 51.
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OutputModule object
app.projec t . renderQueue. i tem( index) .outputModule( index)

Description

An OutputModule object of a RenderQueueItem generates a single file or sequence via a render operation, 
and contains attributes and methods relating to the file to be rendered.

Attributes

Methods

OutputModule applyTemplate() method
app.projec t . renderQueue. i tem( index) .outputModule( index) .applyTemplate( templateName )

Description

Applies the specified existing output-module template.

Parameters

Returns

Nothing.

Attribute Reference Description

f i le “OutputModule file attribute” on 
page 111

The path and name of the file to be rendered.

p ostRenderAct ion “OutputModule postRenderAction attri-
bute” on page 111

An action to be taken after rendering.

name “OutputModule name attribute” on 
page 111

The user-interface name of the output module.

templates “OutputModule templates attribute” on 
page 112

All templates for the output module.

includeSourceXMP “OutputModule includeSourceXMP 
attribute” on page 111

When true, writes all source footage XMP metadata to 
the output file.

Method Reference Description

remove() “OutputModule remove() method” on 
page 112

Removes this output module from the render-queue item’s list.

saveAsTemplate() “OutputModule saveAsTemplate() 
method” on page 112

Saves a new output-module template.

applyTemplate() “OutputModule applyTemplate() 
method” on page 110

Applies an output-module template.

templateName A string containing the name of the template to be applied.
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OutputModule file attribute
app.projec t . renderQueue. i tem( index) .outputModule( index) . f i le

Description

The ExtendScript File object for the file this output module is set to render.

Type

ExtendScript File object; read/write.

OutputModule includeSourceXMP attribute
app.projec t . renderQueue. i tem( index) .outputModule( index) . includeSourceXMP

Description

When true, writes all source footage XMP metadata to the output file. Corresponds to the Include Source 
XMP Metadata option in the Output Module Settings dialog box.

Type

Boolean; read/write.

OutputModule name attribute
app.projec t . renderQueue. i tem( index) .outputModule( index) .name

Description

The name of the output module, as shown in the user interface.

Type

String; read-only.

OutputModule postRenderAction attribute
app.projec t . renderQueue. i tem( index) .outputModule( index) .p ostRenderAct ion

Description

An action to be performed when the render operation is completed.

Type

A PostRenderAct ion enumerated value (read/write); one of:

p ostRenderAct ion.NONE
p ostRenderAct ion.IMPORT
p ostRenderAct ion.IMPORT_AND_REPLACE_USAGE
p ostRenderAct ion.SET_PROXY
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OutputModule remove() method
app.projec t . renderQueue. i tem( index) .outputModule( index) .remove()

Description

Removes this OutputModule object from the collection.

Parameters

None.

Returns

Nothing.

OutputModule saveAsTemplate() method
app.projec t . renderQueue. i tem( index) .outputModule( index) .saveAsTemplate(name)

Description

Saves this output module as a template and adds it to the templates  array.

Parameters

Returns

Nothing.

OutputModule templates attribute
app.projec t . renderQueue. i tem( index) .outputModule( index) . templates

Description

The names of all output-module templates available in the local installation of After Effects.

Type

Array of strings; read-only.

name A string containing the name of the new template.
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PlaceholderSource object
app.projec t . item( index) .mainS ource
app.projec t . item( index) .proxySource

Description

The PlaceholderSource object describes the footage source of a placeholder.

PlaceholderSource is a subclass of FootageSource. All methods and attributes of FootageSource are available 
when working with PlaceholderSource. See “FootageSource object” on page 69. PlaceholderSource does not 
define any additional methods or attributes.
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Project object
app.projec t

Description

The project object represents an After Effects project. Attributes provide access to specific objects within the 
project, such as imported files or footage and compositions, and also to project settings such as the timecode 
base. Methods can import footage, create solids, compositions and folders, and save changes.

Attributes

Attribute Reference Description

f i le “Project file attribute” on page 117 The file for the currently open project.

ro otFolder “Project rootFolder attribute” on 
page 121

The folder containing all the contents of the 
project; the equivalent of the Project panel

i tems “Project items attribute” on page 119 All items in the project.

ac t iveItem “Project activeItem attribute” on 
page 115

The currently active item.

bitsPerChannel “Project bitsPerChannel attribute” on 
page 116

The color depth of the current project.

t ransparenc yGridThumbnai ls “Project transparencyGridThumbnails 
attribute” on page 123

When true, thumbnail views use the transpar-
ency checkerboard pattern.

numItems “Project numItems attribute” on 
page 120 

The total number of items contained in the 
project.

se lect ion “Project selection attribute” on 
page 122

All items selected in the Project panel.

renderQueue “Project renderQueue attribute” on 
page 121

The project’s render queue.

t imeDisplayTyp e “Project timeDisplayType attribute” on 
page 122

The time display style, corresponding to the Time 
Display Style section in the Project Settings 
dialog box.

footageTimeco deDisplay-
Star tType

“Project footageTimecodeDisplayStart-
Type attribute” on page 117

The Footage Start Time setting in the Project 
Settings dialog box, which is enabled when 
Timecode is selected as the time display style.

f ramesUseFeetFrames “Project framesUseFeetFrames attri-
bute” on page 118

The Use Feet + Frames setting in the Project 
Settings dialog box. 

feetFramesFi lmType “Project feetFramesFilmType attribute” 
on page 117

The Use Feet + Frames menu setting in the 
Project Settings dialog box.

f ramesC ountType “Project framesCountType attribute” on 
page 118

The Frame Count menu setting in the Project 
Settings dialog box.

displayStar tFrame “Project displayStartFrame attribute” on 
page 117

The frame at which to start numbering when 
displaying the project.

l inearBlending “Project linearBlending attribute” on 
page 120

When true, linear blending is used for the project.

xmpPacket “Project xmpPacket attribute” on 
page 123

The project’s XMP metadata.



115

After Effects scripting reference Project object 

115 

Methods

Project activeItem attribute
app.projec t .act iveItem

Description

The item that is currently active and is to be acted upon, or a null if no item is currently selected or if multiple 
items are selected.

Type

Item object or null; read-only.

Project autoFixExpressions() method
app.projec t .autoFixExpress ions(oldText ,  newText)

Description

Automatically replaces text found in broken expressions in the project, if the new text causes the expression 
to evaluate without errors.

Parameters

Method Reference Description

i tem() “Project item() method” on page 119 Retrieves an item from the project.

consol idateFo otage() “Project consolidateFootage() method” 
on page 116 

Consolidates all footage in the project.

removeUnus edFo otage() “Project removeUnusedFootage() 
method” on page 121

Removes unused footage from the project.

reduceProjec t( ) “Project reduceProject() method” on 
page 120

Reduces the project to a specified set of items.

clos e() “Project close() method” on page 116 Closes the project with normal save options.

save() “Project save() method” on page 121 Saves the project.

saveWithDia log() “Project saveWithDialog() method” on 
page 122

Displays a Save dialog box.

imp ortPlaceholder() “Project importFileWithDialog() 
method” on page 119

Imports a placeholder into the project.

imp ortFi le() “Project importFile() method” on 
page 118

Imports a file into the project.

imp ortFi leWithDia log() “Project importFileWithDialog() 
method” on page 119

Displays an Import File dialog box.

showWindow() “Project showWindow() method” on 
page 122

Shows or hides the Project panel.

autoFixExpress ions() “Project autoFixExpressions() method” 
on page 115

Automatically replaces text in all expressions.

oldText The text to replace.

newText The new text.
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Returns

Nothing.

Project bitsPerChannel attribute
app.projec t .bitsPerChannel

Description

The color depth of the current project, either 8, 16, or 32 bits.

Type

Integer (8, 16, or 32 only); read/write.

Project close() method
app.projec t .c lose(closeOptions)

Description

Closes the project with the option of saving changes automatically, prompting the user to save changes or 
closing without saving changes.

Parameters

Returns

Boolean. True on success. False if the file has not been previously saved, the user is prompted, and the user 
cancels the save.

Project consolidateFootage() method
app.projec t .cons ol idateFootage()

Description

Consolidates all footage in the project. Same as the File > Consolidate All Footage command.

Parameters

None.

Returns

Integer; the total number of footage items removed.

clos eOpt ions Action to be performed on close. A Clos eOpt ions  enumerated value, one of:

CloseOpt ions .D O_NOT_SAVE_CHANGES : Close without saving.
CloseOpt ions .PROMPT_TO_SAVE_CHANGES : Prompt for whether to save changes before 
close.
CloseOpt ions .SAVE_CHANGES : Save automatically on close.
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Project displayStartFrame attribute
app.projec t .displayStar tFrame

Description

An alternate way of setting the Frame Count menu setting in the Project Settings dialog box to 0 or 1, and is 
equivalent to using the FramesC ountType.FC_START_0 or FramesC ountType.FC_START_1 enumerated 
values for the f ramesC ountType attribute. For more information, see “Project framesCountType attribute” on 
page 118.

Type

Integer (0 or 1); read/write.

Project feetFramesFilmType attribute
app.projec t . feetFramesFi lmTyp e

Description

The Use Feet + Frames menu setting in the Project Settings dialog box.

Use this attribute instead of the old t imecodeFi lmTyp e attribute.

Type

A FeetFramesFi lmType enumerated value; read/write. One of:

FeetFramesFi lmType.MM16
FeetFramesFi lmType.MM35

Project file attribute
app.projec t . f i le

Description

The ExtendScript File object for the file containing the project that is currently open.

Type

File object or null if project has not been saved; read-only.

Project footageTimecodeDisplayStartType attribute
app.projec t . fo otageTimecodeDisplayStar tType

Description

The Footage Start Time setting in the Project Settings dialog box, which is enabled when Timecode is selected 
as the time display style.

Type

A FootageTimeco deDisplayStar tType enumerated value; read/write. One of:

Fo otageTimeco deDisplayStar tType.FTCS_START_0
Fo otageTimeco deDisplayStar tType.FTCS_USE_SOURCE_MEDIA
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Project framesCountType attribute
app.projec t . f ramesC ountTyp e

Description

The Frame Count menu setting in the Project Settings dialog box.

Type

A FramesC ountType enumerated value; read/write. One of:

FramesC ountTyp e.FC_START_1
FramesC ountTyp e.FC_START_0
FramesC ountTyp e.FC_TIMECODE_CONVERSION

NOTE: Setting this attribute to FramesC ountTyp e.FC_TIMECODE_CONVERSION  resets the displayStar t-
Frame  attribute to 0.

Project framesUseFeetFrames attribute
app.projec t . f ramesUseFeetFrames

Description

The Use Feet + Frames setting in the Project Settings dialog box. True if using Feet + Frames; false if using 
Frames.

Type

Boolean; read/write.

Project importFile() method
app.projec t . importFi le( impor tOptions)

Description

Imports the file specified in the specified ImportOptions object, using the specified options. Same as the 
File > Import File command. Creates and returns a new FootageItem object from the file, and adds it to the 
project’s i tems array.

Parameters

Returns

FootageItem object.

Example

app.projec t . importFi le(new Imp ortOptions(Fi le(“sample.ps d”))

imp ortOptions An ImportOptions object specifying the file to import and the options for the operation. See
“ImportOptions object” on page 75. 
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Project importFileWithDialog() method
app.projec t . importFi leWithDialog()

Description

Shows an Import File dialog box. Same as the File > Import > File command. 

Returns

Array of Item objects created during import; or null if the user cancels the dialog box.

Project importPlaceholder() method
app.projec t . importPlaceholder(name,  w idth ,  height ,  f rameRate,  duration)

Description

Creates and returns a new PlaceholderItem object and adds it to the project’s i tems array. Same as the 
File > Import > Placeholder command. 

Parameters

Returns

PlaceholderItem object.

Project item() method
app.projec t . item( index)

Description

Retrieves an item at a specified index position.

Parameters

Returns

Item object.

Project items attribute
app.projec t . items

Description

All of the items in the project.

name A string containing the name of the placeholder.

width The width of the placeholder in pixels, an integer in the range [4..30000].

height The height of the placeholder in pixels, an integer in the range [4..30000].

f rameR ate The frame rate of the placeholder, a floating-point value in the range [1.0..99.0]

durat ion The duration of the placeholder in seconds, a floating-point value in the range [0.0..10800.0].

index The index position of the item, an integer. The first item is at index 1.
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Type

ItemCollection object; read-only.

Project linearBlending attribute
app.projec t . l inearBlending

Description

True if linear blending should be used for this project; otherwise false.

Type

Boolean; read/write.

Project numItems attribute
app.projec t .numItems

Description

The total number of items contained in the project, including folders and all types of footage.

Type

Integer; read-only.

Example

n = app.projec t .numItems;
a ler t( "There  are  "  +  n  + "  i tems in  this  project . " )

Project reduceProject() method
app.projec t . reduceProjec t(array_of_items)

Description

Removes all items from the project except those specified. Same as the File > Reduce Project command.

Parameters

Returns

Integer; the total number of items removed.

Example

var  theItems = new Array() ;
theItems[theItems. length]  = app.project . i tem(1) ;
theItems[theItems. length]  = app.project . i tem(3) ;
app.projec t . reduceProjec t( theItems) ;

array_of_items An array containing the Item objects that are to be kept.
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Project removeUnusedFootage() method
app.projec t . removeUnusedFootage()

Description

Removes unused footage from the project. Same as the File > Remove Unused Footage command.

Parameters

None.

Returns

Integer; the total number of FootageItem objects removed.

Project renderQueue attribute
app.projec t . renderQueue

Description

The render queue of the project.

Type

RenderQueue object; read-only.

Project rootFolder attribute
app.projec t . rootFolder

Description

The root folder containing the contents of the project; this is a virtual folder that contains all items in the 
Project panel, but not items contained inside other folders in the Project panel.

Type

FolderItem object; read-only.

Project save() method
app.projec t . save()
app.projec t . save( f i le)

Description

Saves the project. The same as the File > Save or File > Save As command. If the project has never previously 
been saved and no file is specified, prompts the user for a location and file name. Pass a File object to save a 
project to a new file without prompting. 

Parameters

Returns

None.

f i le Optional. An ExtendScript File object for the file to save.
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Project saveWithDialog() method
app.projec t . saveWithDialog()

Description

Shows the Save dialog box. The user can name a file with a location and save the project, or click Cancel to exit 
the dialog box.

Parameters

None.

Returns

Boolean; true if the project was saved.

Project selection attribute
app.projec t . selec t ion

Description

All items selected in the Project panel, in the sort order shown in the Project panel.

Type

Array of Item objects; read-only.

Project showWindow() method
app.projec t . showWindow(doShow )

Description

Shows or hides the Project panel.

Parameters

Returns

Nothing.

Project timeDisplayType attribute
app.projec t . t imeDisplayType

Description

The time display style, corresponding to the Time Display Style section in the Project Settings dialog box.

Type

A TimeDisplayTyp e enumerated value; read/write. One of:

TimeDisplayType.FRAMES
TimeDisplayType.TIMECODE

doShow When true, show the Project panel. When false, hide the Project panel.
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Project transparencyGridThumbnails attribute
app.projec t . t ransparencyGridThumbnai ls

Description

When true, thumbnail views use the transparency checkerboard pattern.

Type

Boolean; read/write.

Project xmpPacket attribute
app.projec t .xmpPacket

Description

The project’s XMP metadata, stored as RDF (XML-based). For more information on XMP, see the JavaScript 
Tools Guide.

Type

String; read/write.

Example

The following example code accesses the XMP metadata of the current project, and modifies the Label project 
metadata field.

var  proj  = app.projec t ;

/ /  load the  XMP l ibrar y as  an ExtendScr ipt  ExternalObject
i f  (Externa lObject .AdobeXMPS cr ipt  == undef ined)  {

ExternalObject .Adob eXMPScript  =  new
ExternalObject( ' l ib :Adob eXMPS cr ipt ' ) ;

}

var  mdata  = new XMPMeta(app.project .xmpPacket) ; / /  get  the  projec t’s  XMP metadata

/ /  update  the  L abel  projec t  metadata’s  va lue
var  schemaNS = XMPMeta .getNamespaceURI("xmp") ;
var  propName = "xmp:L abel" ;
t r y  {

mdata .setProper ty(schemaNS,  propName,  " f ina l  vers ion. . .no,  rea l ly ! " ) ;
}
catch(e)  {

a ler t(e) ;
}
app.projec t .xmpPacket  =  mdata .ser ia l ize() ;
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Property object
app.projec t . item( index) . l ayer( index) .proper tySpec

Description

The Property object contains value, keyframe, and expression information about a particular AE property of 
a layer. An AE property is an value, often animatable, of an effect, mask, or transform within an individual 
layer. For examples of how to access properties, see “PropertyBase object” on page 148 and “PropertyGroup 
property() method” on page 157.

• Property is a subclass of PropertyBase. All methods and attributes of PropertyBase, in addition to those 
listed below, are available when working with Property. See “PropertyBase object” on page 148.

NOTE: JavaScript objects commonly referred to as “properties” are called “attributes” in this guide, to avoid 
confusion with the After Effects definition of property.

Attributes

Attribute Reference Description

proper tyValueType “Property propertyValueType attribute” 
on page 138

Type of value stored in this property.

va lue “Property value attribute” on page 146 Current value of the property.

hasMin “Property hasMin attribute” on 
page 130

When true, there is a minimum permitted value.

hasMax “Property hasMax attribute” on 
page 130

When true, there is a maximum permitted value.

minValue “Property minValue attribute” on 
page 137

The minimum permitted value.

maxValue “Property maxValue attribute” on 
page 137

The maximum permitted value.

i sSpat ia l “Property isSpatial attribute” on 
page 132

When true, the property defines a spatial value.

canVar yO verTime “Property canVaryOverTime attribute” 
on page 129

When true, the property can be keyframed.

i sTimeVar ying “Property isTimeVarying attribute” on 
page 132

When true, the property has keyframes or an 
expression enabled that can vary its values.

numKeys “Property numKeys attribute” on 
page 138

The number of keyframes on this property.

unitsText “Property unitsText attribute” on 
page 146

A text description of the units in which the value is 
expressed.

express ion “Property expression attribute” on 
page 129

The expression string for this property.

canSetExpress ion “Property canSetExpression attribute” 
on page 128

When true, the expression can be set by a script.

express ionEnabled “Property expressionEnabled attribute” 
on page 129

When true, the expression is used to generate val-
ues for the property.

express ionError “Property expressionError attribute” on 
page 130

The error, if any, that occurred when the last expres-
sion was evaluated.
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Methods

se lectedKeys “Property selectedKeys attribute” on 
page 140

All selected keyframes of the property.

proper tyIndex “Property propertyIndex attribute” on 
page 138

The position index of this property.

dimensionsS eparated “Property dimensionsSeparated attri-
bute” on page 129

When true, the property’s dimensions are repre-
sented as separate properties.

i sSeparat ionFol lower “Property isSeparationFollower attri-
bute” on page 131

When true, the property represents one of the 
separated dimensions for a multidimensional 
property.

i sSeparat ionLeader “Property isSeparationLeader attribute” 
on page 131

When true, the property is multidimensional and 
can be separated.

s eparat ionDimension “Property separationDimension attri-
bute” on page 140

For a separated follower, the dimension it repre-
sents in the multidimensional leader.

separat ionLeader “Property separationLeader attribute” 
on page 140

The original multidimensional property for this 
separated follower.

Method Reference Description

va lueAtTime() “Property valueAtTime() method” on 
page 146

Gets the value of the property evalu-
ated at given time.

setValue() “Property setValue() method” on page 144 Sets the static value of the property.

setValueAtTime() “Property setValueAtTime() method” on 
page 145

Creates a keyframe for the property.

setValuesAtTimes() “Property setValuesAtTimes() method” on 
page 145

Creates a set of keyframes for the prop-
erty.

setValueAtKey() “Property setValueAtKey() method” on 
page 145

Finds a keyframe and sets the value of 
the property at that keyframe.

nearestKeyIndex() “Property nearestKeyIndex() method” on 
page 138

Gets the keyframe nearest to a specified 
time.

keyTime() “Property keyTime() method” on page 136 Gets the time at which a condition 
occurs.

keyValue() “Property keyValue() method” on page 137 Gets the value of a keyframe at the time 
at which a condition occurs.

addKey() “Property addKey() method” on page 128 Adds a new keyframe to the property at 
a given time.

removeKey() “Property removeKey() method” on 
page 139

Removes a keyframe from the property.

i s Interpolat ionTypeVal id() “Property isInterpolationTypeValid() 
method” on page 131

When true, this property can be inter-
polated.

setInterpolat ionTyp eAtKey() “Property setInterpolationTypeAtKey() 
method” on page 140

Sets the interpolation type for a key.

keyInInterp olat ionType() “Property keyInInterpolationType() method” 
on page 132

Gets the 'in' interpolation type for a key.

keyOutInter polat ionType() “Property keyOutInterpolationType() 
method” on page 133

Gets the 'out' interpolation type for a 
key.

Attribute Reference Description
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Example: Get and set the value of opacity

var  myProper ty  =  myL ayer.opacity ;
/ /opacity  has  proper tyValueTyp e of  OneD,  and is  s tored as  a  f loat
myProper ty.s etValue(50) ; / /  s et  opacity  to  50%
//  Var iable  myOpacity  i s  a  f loat  va lue
var  myOpacity  =  myProper ty.va lue ;

setSpat ia lTangentsAtKey() “Property setSpatialTangentsAtKey() 
method” on page 142

Sets the “in” and “out” tangent vectors 
for a key.

keyInSpat ia lTangent() “Property keyInSpatialTangent() method” on 
page 132

Gets the “in” spatial tangent for a key.

keyOutSpat ia lTangent() “Property keyOutSpatialTangent() method” 
on page 134

Gets the “out” spatial tangent for a key.

setTemporalE as eAtKey() “Property setTemporalEaseAtKey() method” 
on page 144

Sets the “in” and “out” temporal ease for 
a key.

keyInTemp ora lEase() “Property keyInTemporalEase() method” on 
page 133

Gets the “in” temporal ease for a key.

keyOutTemp ora lE ase() “Property keyOutTemporalEase() method” 
on page 134

Gets the “out” temporal ease for a key.

setTemporalC ontinuousAtKey() “Property setTemporalContinuousAtKey() 
method” on page 143

Sets whether a keyframe has temporal 
continuity.

keyTemp ora lC ont inuous() “Property keyTemporalContinuous() 
method” on page 136

Reports whether a keyframe has tem-
poral continuity.

setTemporalAutoB ezierAtKey() “Property setTemporalAutoBezierAtKey() 
method” on page 143

Sets whether a keyframe has temporal 
auto-Bezier.

keyTemp ora lAutoB ezier() “Property keyTemporalAutoBezier() 
method” on page 136

Reports whether a keyframe has tem-
poral auto-Bezier.

setSpat ia lC ont inuousAtKey() “Property setSpatialContinuousAtKey() 
method” on page 142

Sets whether a keyframe has spatial 
continuity.

keySpat ia lC ontinuous() “Property keySpatialContinuous() method” 
on page 135

Reports whether a keyframe has spatial 
continuity.

setSpat ia lAutoB ezierAtKey “Property setSpatialAutoBezierAtKey() 
method” on page 142

Sets whether a keyframe has spatial 
auto-Bezier.

keySpat ia lAutoB ezier() “Property keySpatialAutoBezier() method” 
on page 135

Reports whether a keyframe has spatial 
auto-Bezier.

setRovingAtKey() “Property setRovingAtKey() method” on 
page 141

Sets whether a keyframe is roving.

keyRoving() “Property keyRoving() method” on page 134 Reports whether a keyframe is roving.

setS elec tedAtKey() “Property setSelectedAtKey() method” on 
page 141

Sets whether a keyframe is selected.

keySelec ted() “Property keySelected() method” on 
page 135

Reports whether a keyframe is selected.

getSeparat ionFol lower() “Property getSeparationFollower() method” 
on page 130

For a separated, multidimensional 
property, retrieves a specific follower 
property.

Method Reference Description
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Example: Get and set the value of a position

var  myProper ty  =  myL ayer.posit ion;  
/ /posit ion has  prop er tyValueType of  ThreeD_SPATIAL,  and is  stored as  an array  of  3  f loats
myProper ty.s etValue([10.0 ,  30 .0 ,  0 .0]) ;
/ /  Var iable  myPosit ion is  an array  of  3  f loats
var  myPosit ion =  myProper ty.va lue ;

Example: Change the value of a mask shape to be open instead of closed

var  myMask =  mylayer.mask(1) ;
var  myProper ty  =  myMask.maskPath ;
myShap e = myProp er ty.va lue ;
myShap e.c losed =  fa lse ;
myProper ty.s etValue(myShape) ;

Example: Get the value of a color at a particular time

A color is stored as an array of four floats, [r,g,b,opacity]. This sets the value of the red component of a light's 
color at time 4 to be half of that at time 2:

var  myProper ty  =  myLight .color ;
var  colorValue  = myProp er ty.va lueAtTime(2, true) ;
colorValue[0]  =  0 .5  *  colorValue[0] ;
myProper ty.s etValueAtTime(4 ,colorValue) ;

Example: Check that a scale calculated by an expression at time 3.5 is the expected value of [10,50]

var  myProper ty  =  myL ayer.sca le ;
/ /  fa lse  va lue of  preExpress ion means  evaluate  the  express ion
var  sca leValue  = myProper ty.va lueAtTime(3.5 , fa l se) ;
i f  (sca leValue[0]  == 10  && sca leValue[1]  == 50)  {

a ler t("hurray") ;
}

e ls e  {
a ler t("oops") ;
}

Example: Keyframe a rotation from 0 to 90 and back again

The animation is 10 seconds, and the middle keyframe is at the 5 second mark. Rotation properties are stored 
as a OneD value.

myProper ty  =  myL ayer.rotat ion ;
myProper ty.s etValueAtTime(0 ,  0) ;
myProper ty.s etValueAtTime(5 ,  90) ;
myProper ty.s etValueAtTime(10,  0) ;

Example: Change the keyframe values for the first three keyframes of some source text

myProper ty  =  myTextL ayer. sourceText ;
i f  (myProper ty.numKeys  <  3)  {

a ler t( "error,  I  thought there  were  3  keyframes") ;
}

e ls e  {
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myProper ty.s etValueAtKey(1 ,  new TextD ocument("key number  1")) ;
myProper ty.s etValueAtKey(2 ,  new TextD ocument("key number  2")) ;
myProper ty.s etValueAtKey(3 ,  new TextD ocument("key number  3")) ;
}

Example: Set values using the convenience syntax for position, scale, color, or source text

/ /  These  two are  equiva lent .  The second f i l l s  in  a  defau lt  of  0 .
myL ayer.posit ion.setValue([20,  30 ,  0]) ;
myL ayer.posit ion.setValue([20,  30]) ;
/ /  These  two are  equiva lent .  The second f i l l s  in  a  defau lt  of  100 .
myL ayer.sca le . setValue([50,  50 ,  100]) ;
myL ayer.sca le . setValue([50,  50]) ;
/ /  These  two are  equiva lent .  The second f i l l s  in  a  defau lt  of  1 .0
myLight .color. setValue([ .8 ,  .3 ,  .1 ,  1 .0]) ;
myLight .color. setValue([ .8 ,  .3 ,  .1 ]) ;
/ /  These  two are  equiva lent .  The second creates  a  TextDocument
myTextL ayer. sourceText .setValue(new TextDo cument("foo")) ;
myTextL ayer. sourceText .setValue(" foo") ;

Property addKey() method
app.projec t . item(index) . layer( index) .proper tySpec . addKey( t ime)

Description

Adds a new keyframe or marker to the named property at the specified time and returns the index of the new 
keyframe.

Parameters

Returns

Integer; the index of the new keyframe or marker.

Property canSetExpression attribute
app.projec t . item(index) . layer( index) .proper tySpec . canSetExpress ion

Description

When true, the named property is of a type whose expression can be set by a script. See also “Property 
expression attribute” on page 129.

Type

Boolean; read-only.

t ime The time, in seconds, at which to add the keyframe. A floating-point value. The beginning of the composition is 0.



129

After Effects scripting reference Property object 

129 

Property canVaryOverTime attribute
app.projec t . item(index) . layer( index) .proper tySpec . canVar yO verTime

Description

When true, the named property can vary over time—that is, keyframe values or expressions can be written to 
this property.

Type

Boolean; read-only.

Property dimensionsSeparated attribute
app.projec t . item(index) . layer( index) .proper tySpec .d imensionsS eparated

Description

When true, the property’s dimensions are represented as separate properties. For example, if the layer’s 
position is represented as X Position and Y Position properties in the Timeline panel, the Position property 
has this attribute set to true.

NOTE: This attribute applies only when the i sSeparat ionLeader  attribute is t rue .

Type

Boolean; read/write.

Property expression attribute
app.projec t . item(index) . layer( index) .proper tySpec . express ion

Description

The expression for the named property. Writeable only when canSetExpress ion for the named property is 
true. When you specify a value for this attribute, the string is evaluated.

• If the string contains a valid expression, express ionEnabled becomes true.

• If the string does not contain a valid expression, an error is generated, and express ionEnabled becomes 
false.

• If you set the attribute to the empty string, express ionEnabled becomes false, but no error is generated.

Type

String; read/write if canSetExpress ion for the named property is true.

Property expressionEnabled attribute
app.projec t . item(index) . layer( index) .proper tySpec . express ionEnabled

Description

When true, the named property uses its associated expression to generate a value. When false, the keyframe 
information or static value of the property is used. This attribute can be set to true only if canSetExpress ion 
for the named property is true and express ion contains a valid expression string.
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Type

Boolean; read/write.

Property expressionError attribute
app.projec t . item(index) . layer( index) .proper tySpec . express ionError

Description

Contains the error, if any, generated by evaluation of the string most recently set in express ion. If no 
expression string has been specified, or if the last expression string evaluated without error, contains the empty 
string (""). 

Type

String; read-only.

Property getSeparationFollower() method
app.projec t . item(index) . layer( index) .proper tySpec .getSeparat ionFol lower(dim)

Description

For a separated, multidimensional property, retrieves a specific follower property. For example, you can use 
this method on the Position property to access the separated X Position and Y Position properties.

NOTE: This attribute applies only when the i sSeparat ionLeader  attribute is t rue .

Parameters

Returns

Property object, or an error if the property is not multidimensional or does not have the specified dimension.

Property hasMax attribute
app.projec t . item(index) . layer( index) .proper tySpec .hasMax

Description

When true, there is a maximum permitted value for the named property; otherwise false.

Type

Boolean; read-only.

Property hasMin attribute
app.projec t . item(index) . layer( index) .proper tySpec .hasMin

Description

When true, there is a minimum permitted value for the named property; otherwise false.

dim The dimension number (starting at 0).



131

After Effects scripting reference Property object 

131 

Type

Boolean; read-only.

Property isInterpolationTypeValid() method
app.projec t . item(index) . layer( index) .proper tySpec . i s Interp olat ionTypeVal id( type)

Description

Returns true if the named property can be interpolated using the specified keyframe interpolation type.

Parameters

Returns

Boolean.

Property isSeparationFollower attribute
app.projec t . item(index) . layer( index) .proper tySpec . i sSeparat ionFol lower

Description

When true, the property represents one of the separated dimensions for a multidimensional property. For 
example, the X Position property has this attribute set to true.

NOTE: The original, consolidated, multidimensional property is the “separation leader” and the new, separated, 
single-dimensional properties are its “separation followers”.

Type

Boolean; read-only.

Property isSeparationLeader attribute
app.projec t . item(index) . layer( index) .proper tySpec . i sSeparat ionL eader

Description

When true, the property is multidimensional and can be separated. For example, the Position property has 
this attribute set to true.

NOTE: The original, consolidated, multidimensional property is the “separation leader” and the new, separated, 
single-dimensional properties are its “separation followers”.

Type

Boolean; read-only.

type A KeyframeInterpolat ionTyp e  enumerated value; one of:

KeyframeInterpolat ionTyp e.LINEAR
KeyframeInterpolat ionTyp e.BEZIER
KeyframeInterpolat ionTyp e.HOLD
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Property isSpatial attribute
app.projec t . item(index) . layer( index) .proper tySpec . i sSpat ia l

Description

When true, the named property defines a spatial value. Examples are position and effect point controls.

Type

Boolean; read-only.

Property isTimeVarying attribute
app.projec t . item(index) . layer( index) .proper tySpec . i sTimeVar ying

Description

When true, the named property is time varying—that is, it has keyframes or an enabled expression. When this 
attribute is true, the attribute canVar yO verTime must also be true.

Type

Boolean; read-only.

Property keyInInterpolationType() method
app.projec t . item(index) . layer( index) .proper tySpec .keyInInterp olat ionType(keyIndex)

Description

Returns the 'in' interpolation type for the specified keyframe.

Parameters

Returns

A KeyframeInterp olat ionType enumerated value; one of:

KeyframeInterpolat ionTyp e.LINEAR
KeyframeInterpolat ionTyp e.BEZIER
KeyframeInterpolat ionTyp e.HOLD

Property keyInSpatialTangent() method
app.projec t . item(index) . layer( index) .proper tySpec .keyInSpat ia lTangent(keyIndex )

Description

Returns the incoming spatial tangent for the specified keyframe, if the named property is spatial (that is, the 
value type is TwoD_SPATIAL or ThreeD_SPATIAL).

Parameters

keyIndex The index for the keyframe. An integer in the range [1..numKeys], as returned by the addKey  or nearestKey-
Index method.

keyIndex The index for the keyframe. An integer in the range [1..numKeys], as returned by the addKey  or nearestKey-
Index method.



133

After Effects scripting reference Property object 

133 

Returns

Array of floating-point values:

• If the property value type is Proper tyValueTyp e.TwoD_SPATIAL, the array contains 2 floating-point 
values.

• If the property value type is Proper tyValueTyp e.ThreeD_SPATIAL, the array contains 3 floating-point 
values.

• If the property value type is neither of these types, an exception is generated.

Property keyInTemporalEase() method
app.projec t . item(index) . layer( index) .proper tySpec .keyInTemporalE ase(keyIndex)

Description

Returns the incoming temporal ease for the specified keyframe.

Parameters

Returns

Array of KeyframeEase objects: 

• If the property value type is Proper tyValueTyp e.TwoD, the array contains 2 objects.

• If the property value type is Proper tyValueTyp e.ThreeD, the array contains 3 objects.

• For any other value type, the array contains 1 object.

Property keyOutInterpolationType() method
app.projec t . item(index) . layer( index) .proper tySpec .keyOutInterp olat ionType(keyIndex )

Description

Returns the outgoing interpolation type for the specified keyframe.

Parameters

Returns

A KeyframeInterp olat ionType enumerated value; one of:

KeyframeInterpolat ionTyp e.LINEAR
KeyframeInterpolat ionTyp e.BEZIER
KeyframeInterpolat ionTyp e.HOLD

keyIndex The index for the keyframe. An integer in the range [1..numKeys], as returned by the addKey  or nearest-
KeyIndex method.

keyIndex The index for the keyframe. An integer in the range [1..numKeys], as returned by the addKey  or nearest-
KeyIndex method.
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Property keyOutSpatialTangent() method
app.projec t . item(index) . layer( index) .proper tySpec .keyOutSpat ia lTangent(keyIndex)

Description

Returns the outgoing spatial tangent for the specified keyframe.

Parameters

Returns

Array of floating-point values:

• If the property value type is Proper tyValueTyp e.TwoD_SPATIAL, the array contains 2 floating-point 
values.

• If the property value type is Proper tyValueTyp e.ThreeD_SPATIAL, the array contains 3 floating-point 
values.

• If the property value type is neither of these types, an exception is generated.

Property keyOutTemporalEase() method
app.projec t . item ( index) . l ayer( index) .proper tySpec .keyOutTemporalE as e(keyIndex)

Description

Returns the outgoing temporal ease for the specified keyframe.

Parameters

Returns

Array of KeyframeEase objects: 

• If the property value type is Proper tyValueTyp e.TwoD, the array contains 2 objects.

• If the property value type is Proper tyValueTyp e.ThreeD, the array contains 3 objects.

• For any other value type, the array contains 1 object.

Property keyRoving() method
app.projec t . item(index) . layer( index) .proper tySpec .keyRoving(keyIndex)

Description

Returns true if the specified keyframe is roving. The first and last keyframe in a property cannot rove; if you 
try to set roving for one of these, the operation is ignored, and keyRoving()  continues to return false. 

If the property value type is neither TwoD_SPATIAL nor ThreeD_SPATIAL, an exception is generated.

keyIndex The index for the keyframe. An integer in the range [1..numKeys], as returned by the addKey  or nearest-
KeyIndex method.

keyIndex The index for the keyframe. An integer in the range [1..numKeys], as returned by the addKey  or nearest-
KeyIndex method.
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Parameters

Returns

Boolean.

Property keySelected() method
app.projec t . item(index) . layer( index) .proper tySpec .keySelec ted(keyIndex )

Description

Returns true if the specified keyframe is selected.

Parameters

Returns

Boolean.

Property keySpatialAutoBezier() method
app.projec t . item(index) . layer( index) .proper tySpec .keySpat ia lAutoB ezier(keyIndex )

Description

Returns true if the specified keyframe has spatial auto-Bezier interpolation. (This type of interpolation affects 
this keyframe only if keySpat ia lC ontinuous(keyIndex)  is also true.)

If the property value type is neither TwoD_SPATIAL nor ThreeD_SPATIAL, an exception is generated.

Parameters

Returns

Boolean.

Property keySpatialContinuous() method
app.projec t . item(index) . layer( index) .proper tySpec .keySpat ia lC ont inuous(keyIndex)

Description

Returns true if the specified keyframe has spatial continuity.

If the property value type is neither TwoD_SPATIAL nor ThreeD_SPATIAL, an exception is generated.

keyIndex The index for the keyframe. An integer in the range [1..numKeys], as returned by the addKey  or nearest-
KeyIndex method.

keyIndex The index for the keyframe. An integer in the range [1..numKeys], as returned by the addKey  or nearest-
KeyIndex method.

keyIndex The index for the keyframe. An integer in the range [1..numKeys], as returned by the addKey  or nearest-
KeyIndex method.
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Parameters

Returns

Boolean.

Property keyTemporalAutoBezier() method
app.projec t . item(index) . layer( index) .proper tySpec .keyTemp oralAutoB ezier(keyIndex)

Description

Returns true if the specified keyframe has temporal auto-Bezier interpolation.

Temporal auto-Bezier interpolation affects this keyframe only if the keyframe interpolation type is Keyfra-
meInterpolat ionType.BEZIER for both keyInInterp olat ionType(keyIndex )  and keyOutInterpola-
t ionType(keyIndex) .

Parameters

Returns

Boolean.

Property keyTemporalContinuous() method
app.projec t . item(index) . layer( index) .proper tySpec .keyTemp oralCont inuous(keyIndex )

Description

Returns true if the specified keyframe has temporal continuity.

Temporal continuity affects this keyframe only if keyframe interpolation type is Keyf rameInterp ola-
t ionType.BEZIER for both keyInInterp olat ionType(keyIndex )  and keyOutInterpolat ionType(keyIndex) .

Parameters

Returns

Boolean.

Property keyTime() method
app.projec t . item(index) . layer( index) .proper tySpec .keyTime(keyIndex )
app.projec t . item(index) . layer( index) .proper tySpec .keyTime(markerComment )

Description

Finds the specified keyframe or marker and returns the time at which it occurs.

keyIndex The index for the keyframe. An integer in the range [1..numKeys], as returned by the addKey  or nearest-
KeyIndex method.

keyIndex The index for the keyframe. An integer in the range [1..numKeys], as returned by the addKey  or nearest-
KeyIndex method.

keyIndex The index for the keyframe. An integer in the range [1..numKeys], as returned by the addKey  or nearest-
KeyIndex method.
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If no keyframe or marker can be found that matches the argument, this method generates an exception, and 
an error is displayed.

Parameters
 

Returns

Floating-point value.

Property keyValue() method
app.projec t . item(index) . layer( index) .proper tySpec .keyValue(keyIndex)
app.projec t . item(index) . layer( index) .proper tySpec .keyValue(markerComment)

Description

Finds the specified keyframe or marker and returns its current value.

If no keyframe or marker can be found that matches the argument, this method generates an exception, and 
an error is displayed.

Parameters
 

Returns

Floating-point value for keyframes, MarkerValue object for markers.

Property maxValue attribute
app.projec t . item(index) . layer( index) .proper tySpec .maxValue

Description

The maximum permitted value of the named property. If the hasMax attribute is false, an exception occurs, 
and an error is generated.

Type

Floating-point value; read-only.

Property minValue attribute
app.projec t . item(index) . layer( index) .proper tySpec .minValue

Description

The minimum permitted value of the named property. If the hasMin attribute is false, an exception occurs, 
and an error is generated.

keyIndex The index for the keyframe. An integer in the range [1..numKeys], as returned by the addKey  or near-
estKeyIndex method.

markerC omment The comment string attached to a marker (see “MarkerValue comment attribute” on page 103).

keyIndex The index for the keyframe. An integer in the range [1..numKeys], as returned by the addKey  or near-
estKeyIndex method.

markerC omment The comment string attached to a marker (see “MarkerValue comment attribute” on page 103).
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Type

Floating-point value; read-only.

Property nearestKeyIndex() method
app.projec t . item(index) . layer( index) .proper tySpec .nearestKeyIndex( t ime)

Description

Returns the index of the keyframe nearest to the specified time.

Parameters

Returns

Integer.

Property numKeys attribute
app.projec t . item(index) . layer( index) .proper tySpec .numKeys

Description

The number of keyframes in the named property. If the value is 0, the property is not being keyframed.

Type

Integer; read-only.

Property propertyIndex attribute
app.projec t . item(index) . layer( index) .proper tySpec .prop er tyIndex

Description

The position index of the named property. The first property is at index position 1.

Type

Integer; read-only.

Property propertyValueType attribute
app.projec t . item(index) . layer( index) .proper tySpec .prop er tyValueType

Description

The type of value stored in the named property. The Proper tyValueTyp e enumeration has one value for each 
type of data that can be stored in or retrieved from a property. Each type of data is stored and retrieved in a 
different kind of structure. All property objects store data according to one of these categories. 

For example, a 3D spatial property (such as a layer's position) is stored as an array of three floating point 
values. When setting a value for position, pass in such an array, as follows:

mylayer.proper ty("p osit ion") . setValue([10 ,20,0]) ;

t ime The time in seconds; a floating-point value. The beginning of the composition is 0.
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In contrast, a shape property (such as a layer's mask shape) is stored as a Shape object. When setting a value 
for a shape, pass a Shape object, as follows:

var  myShap e =  new Shap e() ;
myShap e.ver t ices  = [[0 ,0] , [0 ,100] , [100,100] , [100,0]] ;
var  myMask =  mylayer.proper ty( "ADBE Mask Parade") .prop er ty(1) ;
myMask.proper ty("ADBE Mask  Shap e") . setValue(myShap e) ;

Type 

A Prop er tyValueType enumerated value; read/write. One of:
E

Property removeKey() method
app.projec t . item(index) . layer( index) .proper tySpec . removeKey(keyIndex )

Description

Removes the specified keyframe from the named property. If no keyframe with the specified index exists, 
generates an exception and displays an error.

When a keyframe is removed, the remaining index numbers change. To remove more than one keyframe, you 
must start with the highest index number and work down to the lowest to ensure that the remaining indices 
reference the same keyframe after each removal.

Parameters

Prop er tyValueType.NO_VALUE Stores no data.

Prop er tyValueType.ThreeD_SPATIAL Array of three floating-point positional values. For example, an Anchor 
Point value might be [10.0, 20.2, 0.0]

Prop er tyValueType.ThreeD Array of three floating-point quantitative values. For example, a Scale 
value might be [100.0, 20.2, 0.0]

Prop er tyValueType.TwoD_SPATIAL Array of 2 floating-point positional values For example, an Anchor Point 
value might be [5.1, 10.0]

Prop er tyValueType.TwoD Array of 2 floating-point quantitative values. For example, a Scale value 
might be [5.1, 100.0]

Prop er tyValueType.OneD A floating-point value.

Prop er tyValueType.COLOR Array of 4 floating-point values in the range [0.0..1.0]. For example, [0.8, 
0.3, 0.1, 1.0]

Prop er tyValueType.CUSTOM_VALUE Custom property value, such as the Histogram property for the Levels 
effect.

Prop er tyValueType.MARKER MarkerValue object; see “MarkerValue object” on page 102.

Prop er tyValueType.LAYER_INDEX Integer; a value of 0 means no layer.

Prop er tyValueType.MASK_INDEX Integer; a value of 0 means no mask.

Prop er tyValueType.SHAPE Shape object; see “Shape object” on page 172.

Prop er tyValueType.TEXT_D O CUMENT TextDocument object; see “TextDocument object” on page 182.

keyIndex The index for the keyframe. An integer in the range [1..numKeys], as returned by the addKey  or nearest-
KeyIndex method.
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Returns

Nothing.

Property selectedKeys attribute
app.projec t . item(index) . layer( index) .proper tySpec . se lec tedKeys

Description

The indices of all the selected keyframes in the named property. If no keyframes are selected, or if the property 
has no keyframes, returns an empty array.

Type

Array of integers; read-only.

Property separationDimension attribute
app.projec t . item(index) . layer( index) .proper tySpec . separat ionDimension

Description

For a separated follower, the dimension number it represents in the multidimensional leader. The first 
dimension starts at 0. For example, the Y Position property has a separat ionDimension value of 1; X Position 
has a value of 0.

Type

Integer; read-only.

Property separationLeader attribute
app.projec t . item(index) . layer( index) .proper tySpec . separat ionL eader

Description

The original multidimensional property for this separated follower. For example, if the current property is 
Y Position, this attribute’s value points to the Position property.

NOTE: The original, consolidated, multidimensional property is the “separation leader” and the new, separated, 
single-dimensional properties are its “separation followers”.

Type

Property object; read-only.

Property setInterpolationTypeAtKey() method
app.projec t . item(index) . layer( index) .proper tySpec . se tInterpolat ionTyp eAtKey(keyIndex ,  inType,  
outType)

Description

Sets the ‘in’ and ‘out’ interpolation types for the specified keyframe.
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Parameters

Returns

Nothing.

Property setRovingAtKey() method
app.projec t . item(index) . layer( index) .proper tySpec . se tRovingAtKey(keyIndex,  newVal)

Description

Turns roving on or off for the specified keyframe. The first and last keyframe in a property cannot rove; if you 
try to set roving for one of these, the operation is ignored, and keyRoving()  continues to return false.

If the property value type is neither TwoD_SPATIAL nor ThreeD_SPATIAL, an exception is generated.

Parameters

Returns

Nothing.

Property setSelectedAtKey() method
app.projec t . item(index) . layer( index) .proper tySpec . se tS electedAtKey(keyIndex ,  onOff )

Description

Selects or deselects the specified keyframe.

Parameters

keyIndex The index for the keyframe. An integer in the range [1..numKeys], as returned by the addKe y  
or nearestKeyIndex method.

inType The incoming interpolation type. A KeyframeInterpolat ionType  enumerated value; one 
of:

KeyframeInterpolat ionTyp e.LINEAR
KeyframeInterpolat ionTyp e.BEZIER
KeyframeInterpolat ionTyp e.HOLD

outType (Optional) The outgoing interpolation type. If not supplied, the ‘out’ type is set to the inType  
value. A KeyframeInterp olat ionType  enumerated value; one of:

KeyframeInterpolat ionTyp e.LINEAR
KeyframeInterpolat ionTyp e.BEZIER
KeyframeInterpolat ionTyp e.HOLD

keyIndex The index for the keyframe. An integer in the range [1..numKeys], as returned by the addKey  or nearestKey-
Index  method.

newVal True to turn roving on, false to turn roving off.

keyIndex The index for the keyframe. An integer in the range [1..numKeys], as returned by the addKey  or nearest-
KeyIndex method.

onOff True to select the keyframe, false to deselect it.
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Returns

Nothing.

Property setSpatialAutoBezierAtKey() method
app.projec t . item(index) . layer( index) .proper tySpec . se tSpat ia lAutoB ezierAtKey(keyIndex,  newVal)

Description

Turns spatial auto-Bezier interpolation on or off for the specified keyframe.

If the property value type is neither TwoD_SPATIAL nor ThreeD_SPATIAL, an exception is generated.

Parameters

Returns

Nothing.

Property setSpatialContinuousAtKey() method
app.projec t . item(index) . layer( index) .proper tySpec . se tSpat ia lC ont inuousAtKey(keyIndex,  newVal)

Description

Turns spatial continuity on or off for the specified keyframe.

If the property value type is neither TwoD_SPATIAL nor ThreeD_SPATIAL, an exception is generated.

Parameters

Returns

Nothing.

Property setSpatialTangentsAtKey() method
app.projec t . item(index) . layer( index) .proper tySpec . se tSpat ia lTangentsAtKey(keyIndex,  inTangent ,  
outTangent)

Description

Sets the incoming and outgoing tangent vectors for the specified keyframe.

If the property value type is neither TwoD_SPATIAL nor ThreeD_SPATIAL, an exception is generated.

keyIndex The index for the keyframe. An integer in the range [1..numKeys], as returned by the addKey  or nearest-
KeyIndex method.

newVal True to turn spatial auto-Bezier on, false to turn it off.

keyIndex The index for the keyframe. An integer in the range [1..numKeys], as returned by the addKey  or nearest-
KeyIndex method.

newVal True to turn spatial continuity on, false to turn it off.
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Parameters

Returns

Nothing.

Property setTemporalAutoBezierAtKey() method
app.projec t . item(index) . layer( index) .proper tySpec . se tTempora lAutoB ezierAtKey(keyIndex ,  newVal )

Description

Turns temporal auto-Bezier interpolation on or off for the specified keyframe. When this is turned on, it 
affects this keyframe only if ke ySpat ia lC ontinuous(keyIndex)  is also true.

Parameters

Returns

Nothing.

Property setTemporalContinuousAtKey() method
app.projec t . item(index) . layer( index) .proper tySpec . se tTempora lC ont inuousAtKey(keyIndex,  newVal )

Description

Turns temporal continuity on or off for the specified keyframe.

When temporal continuity is turned on, it affects this keyframe only if the keyframe interpolation type is 
KeyframeInterpolat ionTyp e.BEZIER for both keyInInterpolat ionType(keyIndex)  and keyOutInterpola-
t ionType(keyIndex) .

Parameters

keyIndex The index for the keyframe. An integer in the range [1..numKeys], as returned by the addKey  or nearest-
KeyIndex method.

inTangent The incoming tangent vector. An array of 2 or 3 floating-point values.

• If the property value type is Prop er tyValueType.TwoD_SPATIAL , the array contains 2 values.

• If the property value type is Prop er tyValueType.ThreeD_SPATIAL , the array contains 3 values.

outTangent (Optional) The outgoing tangent vector. If not supplied, the ‘out’ tangent is set to the inTangent  value. An 
array of 2 or 3 floating-point values.

• If the property value type is Prop er tyValueType.TwoD_SPATIAL , the array contains 2 values.

• If the property value type is Prop er tyValueType.ThreeD_SPATIAL , the array contains 3 values.

keyIndex The index for the keyframe. An integer in the range [1..numKeys], as returned by the addKey  or nearest-
KeyIndex method.

newVal True to turn temporal auto-Bezier on, false to turn it off.

keyIndex The index for the keyframe. An integer in the range [1..numKeys], as returned by the addKey  or nearest-
KeyIndex method.

newVal True to turn temporal continuity on, false to turn it off.
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Returns

Nothing.

Property setTemporalEaseAtKey() method
app.projec t . item(index) . layer( index) .proper tySpec . se tTempora lE as eAtKey(keyIndex,  inTemporalEase ,  
outTemporalEase)

Description

Sets the incoming and outgoing temporal ease for the specified keyframe. See “KeyframeEase object” on 
page 84.

Parameters

Returns

Nothing.

Property setValue() method
app.projec t . item(index) . layer( index) .proper tySpec . se tVa lue(newValue)

Description

Sets the static value of a property that has no keyframes.

If the named property has keyframes, this method generates an exception and displays an error. To set the 
value of a property with keyframes, use “Property setValueAtTime() method” on page 145 or “Property setVal-
ueAtKey() method” on page 145. 

Parameters

Returns

Nothing.

keyIndex The index for the keyframe. An integer in the range [1..numKeys], as returned by the addKey  or near-
estKeyIndex method.

inTemporalE as e The incoming temporal ease. An array of 1, 2, or 3 KeyframeEase objects.

• If the property value type is Proper tyValueType.TwoD , the array contains 2 objects.

• If the property value type is Proper tyValueType.ThreeD , the array contains 3 objects.

• For all other value types, the array contains 1 object.

outTemporalE as e (Optional) The outgoing temporal ease. If not supplied, the outgoing ease is set to the inTempora-
lE ase  value. An array of 1, 2, or 3 KeyframeEase objects.

• If the property value type is Proper tyValueType.TwoD , the array contains 2 objects.

• If the property value type is Proper tyValueType.ThreeD , the array contains 3 objects.

• For all other value types, the array contains 1 object.

newValue A value appropriate for the type of property being set; see “Property propertyValueType attribute” on page 138.
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Property setValueAtKey() method
app.projec t . item(index) . layer( index) .proper tySpec . se tVa lueAtKey(keyIndex ,  newValue)

Description

Finds the specified keyframe and sets its value.

If the named property has no keyframes, or no keyframe with the specified index, this method generates an 
exception and displays an error.

Parameters

Returns

Nothing.

Property setValueAtTime() method
app.projec t . item(index) . layer( index) .proper tySpec . se tVa lueAtTime( t ime,  newValue)

Description

Sets the value of a keyframe at the specified time. Creates a new keyframe for the named property, if one does 
not currently exist for the specified time, and sets its value.

Parameters

Returns

Nothing.

Property setValuesAtTimes() method
app.projec t . item(index) . layer( index) .proper tySpec . se tVa luesAtTimes( t imes ,  newValues )

Description

Sets values for a set of keyframes at specified of times. Creates a new keyframe for the named property, if one 
does not currently exist for a specified time, and sets its value.

Times and values are expressed as arrays; the arrays must be of the same length.

Parameters

keyIndex The index for the keyframe. An integer in the range [1..numKeys], as returned by the addKey  or nearest-
KeyIndex method.

newValue A value appropriate for the type of property being set; see “Property propertyValueType attribute” on 
page 138.

t ime The time in seconds, a floating-point value. The beginning of the composition is 0.

newValue A value appropriate for the type of property being set; see “Property propertyValueType attri-
bute” on page 138.

t imes An array of times, in seconds. Each time is a floating-point value. The beginning of the compo-
sition is 0.
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Returns

Nothing.

Property unitsText attribute
app.projec t . item(index) . layer( index) .proper tySpec .unitsText

Description

The text description of the units in which the value is expressed.

Type

String; read-only.

Property value attribute
app.projec t . item(index) . layer( index) .proper tySpec .va lue

Description

The value of the named property at the current time.

• If express ionEnabled is true, returns the evaluated expression value.

• If there are keyframes, returns the keyframed value at the current time.

• Otherwise, returns the static value. 

The type of value returned depends on the property value type. See examples for “Property object” on 
page 124.

Type

A value appropriate for the type of the property (see “Property propertyValueType attribute” on page 138); 
read-only.

Property valueAtTime() method
app.projec t . item(index) . layer( index) .proper tySpec .va lueAtTime( t ime,  preE xpression)

Description

The value of the named property as evaluated at the specified time. 

Note that the type of value returned is not made explicit; it will be of a different type, depending on the 
property evaluated.

Parameters

newValues A array of values appropriate for the type of property being set; see “Property propertyValu-
eType attribute” on page 138. 

t ime The time in seconds; a floating-point value. The beginning of the composition is 0.

preExpress ion If the property has an expression and this is true, return the value for the specified time without 
applying the expression to it. When false, return the result of evaluating the expression for the 
specified time.

Ignored if the property does not have an associated expression.
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Returns

A value appropriate for the type of the property (see “Property propertyValueType attribute” on page 138).
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PropertyBase object
app.projec t . item( index) . l ayer( index) .proper tySpec

Description

Properties are accessed by name through layers, using various kinds of expression syntax, as controlled by 
application preferences. For example, the following are all ways of access properties in the Effects group:

var  e f fec t1  = app.projec t . item(1) . layer(1) .e f fec t( "Add Grain")( "Viewing Mode") ;  
var  e f fec t1again = app.projec t . item(1) . layer(1) .e f fect .addGrain .v iewingMo de;  
var  e f fec t1againtoo  = app.project . item(1) . layer(1)("Ef fects ") .addGrain.v iewingMode;  
var  e f fec t1againtoo2 = app.projec t . i tem(1) . layer(1)( "Ef fec ts" )("Add Grain")( "Viewing Mo de") ;

See also “PropertyGroup property() method” on page 157.

• PropertyBase is the base class for both Property and PropertyGroup, so PropertyBase attributes and 
methods are available when working with properties and property groups. See “Property object” on 
page 124 and “PropertyGroup object” on page 155.

Reference invalidation

When something occurs that changes an object sufficiently for the reference to become invalid, script refer-
ences to that object can generate errors. In simple cases this is straightforward. For example, if you delete an 
object, a reference to the deleted object generates the warning "Object is Invalid":

var  layer1  =  app.project . item(1) . layer(1) ;
l ayer1 .remove() ;  
a ler t( layer1 .name) ;  / /  inva l id  reference  to  deleted object

Similarly, if you reference an AE property in a deleted object, the warning occurs:

var  layer1  =  app.project . item(1) . layer(1) ;  
var  l ayer1posit ion  = layer1 .t ransform.posit ion;
layer1 .remove() ;  
a ler t( layer1posit ion .va lue) ;  / /  inval id  reference  to  proper ty  in  s elec ted object

A less straightforward case is when a property is removed from a property group. In this case, After Effects 
generates the "Object is Invalid" error when you subsequently reference that item or other items in the group, 
because their index positions have changed. For example:

var  e f fec t1  = app.projec t . item(1) . layer(1) .e f fec t(1) ;  
var  e f fec t2  = app.projec t . item(1) . layer(1) .e f fec t(2) ;  
var  e f fec t2param = app.project . i tem(1) . layer(1) .e f fec t(2) .blendWithOrigina l ;
e f fec t1 .remove() ;  
a ler t(ef fect2 .name) ;  / /  inval id reference  b ecaus e  group index posit ions  have  changed

Attributes

Attribute Reference Description

name “PropertyBase name attribute” on 
page 152

Name of the property.

matchName “PropertyBase matchName attribute” 
on page 152

A special name for the property used to build unique naming paths.
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Methods

PropertyBase active attribute
app.projec t . item(index) . layer( index) .proper tySpec . ac t ive

Description

When true, this property is active. For a layer, this corresponds to the setting of the eyeball icon and if the 
current time is between the layer’s in and out points. For an effect and all properties, it is the same as the 
enabled attribute, except that it’s read-only.

proper tyIndex “PropertyBase propertyIndex attribute” 
on page 153

Index of this property within its parent group.

proper tyDepth “PropertyBase propertyDepth attribute” 
on page 153

The number of levels of parent groups between this property and 
the containing layer.

proper tyTyp e “PropertyBase propertyType attribute” 
on page 154

The property type.

parentProp er ty “PropertyBase parentProperty attri-
bute” on page 153

The immediate parent group of this property.

i sModif ied “PropertyBase isModified attribute” on 
page 151

When true, the property has been changed since its creation.

canSetEnabled “PropertyBase canSetEnabled attribute” 
on page 150

When true, the user interface displays an eyeball icon for this prop-
erty.

enabled “PropertyBase enabled attribute” on 
page 151

When true, this property is enabled.

ac t ive “PropertyBase active attribute” on 
page 149

When true, this property is active.

el ided “PropertyBase elided attribute” on 
page 150

When true, this property is not displayed in the user interface.

i sEf fec t “PropertyBase isEffect attribute” on 
page 151

When true, this property is an effect.

i sMask “PropertyBase isMask attribute” on 
page 151

When true, this property is a mask.

se lec ted “PropertyBase selected attribute” on 
page 154

When true, this property is selected.

Method Reference Description

proper tyGroup() “PropertyBase propertyGroup() 
method” on page 153

Gets the parent group for this property.

remove() “PropertyBase remove() method” on 
page 154

Removes this from the project.

moveTo() “PropertyBase moveTo() method” on 
page 152

Moves this property to a new position in its parent group.

dupl icate() “PropertyBase duplicate() method” on 
page 150

Duplicates this property object.

Attribute Reference Description
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Type

Boolean; read-only.

PropertyBase canSetEnabled attribute
app.projec t . item(index) . layer( index) .proper tySpec . canSetEnabled

Description

When true, you can set the enabled attribute value. Generally, this is true if the user interface displays an 
eyeball icon for this property; it is true for all layers.

Type

Boolean; read-only.

PropertyBase duplicate() method
app.projec t . item(index) . layer( index) .proper tySpec .dupl icate()

Description

If this property is a child of an indexed group, creates and returns a new PropertyBase object with the same 
attribute values as this one. 

If this property is not a child of an indexed group, the method generates an exception and displays an error.

An indexed group has the type Prop er tyType.INDEXED_GROUP; see “PropertyBase propertyType attribute” 
on page 154.

Parameters

None.

Returns

PropertyBase object.

PropertyBase elided attribute
app.projec t . item(index) . layer( index) .proper tySpec . e l ided

Description

When true, this property is a group used to organize other properties. The property is not displayed in the user 
interface and its child properties are not indented in the Timeline panel. 

For example, for a text layer with two animators and no properties twirled down, you might see:

Text
Path Opt ions
More Opt ions
Animator 1
Animator 2

In this example, “Animator 1” and “Animator 2” are contained in a PropertyBase called “Text Animators.” This 
parent group is not displayed in the user interface, and so the two child properties are not indented in the 
Timeline panel.
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Type

Boolean; read-only.

PropertyBase enabled attribute
app.projec t . item(index) . layer( index) .proper tySpec . enabled

Description

When true, this property is enabled. It corresponds to the setting of the eyeball icon, if there is one; otherwise, 
the default is true.

Type

Boolean; read/write if canS etEnabled is true, read-only if canSetEnabled is false.

PropertyBase isEffect attribute
app.projec t . item(index) . layer( index) .proper tySpec . i sEf fec t

Description

When true, this property is an effect PropertyGroup.

Type

Boolean; read-only.

PropertyBase isMask attribute
app.projec t . item(index) . layer( index) .proper tySpec . i sMask

Description

When true, this property is a mask PropertyGroup.

Type

Boolean; read-only.

PropertyBase isModified attribute
app.projec t . item(index) . layer( index) .proper tySpec . i sMo dif ied

Description

When true, this property has been changed since its creation.

Type

Boolean; read-only.
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PropertyBase matchName attribute
app.projec t . item(index) . layer( index) .proper tySpec .matchName

Description

A special name for the property used to build unique naming paths. The match name is not displayed, but you 
can refer to it in scripts. Every property has a unique match-name identifier. Match names are stable from 
version to version regardless of the display name (the name attribute value) or any changes to the application. 
Unlike the display name, it is not localized. 

An indexed group may not have a name value, but always has a matchName value. (An indexed group has the 
type Proper tyType.INDEXED_GROUP; see “PropertyBase propertyType attribute” on page 154.) 

Type

String; read-only.

PropertyBase moveTo() method
app.projec t . item(index) . layer( index) .proper tySpec .moveTo(newIndex)

Description

Moves this property to a new position in its parent property group.

This method is valid only for children of indexed groups; if it is not, or if the index value is not valid, the 
method generates an exception and displays an error. (An indexed group has the type Proper-
tyTyp e.INDEXED_GROUP; see “PropertyBase propertyType attribute” on page 154.)

NOTE: Using this method invalidates existing references to other children in the same indexed group. For 
example, if you have three effects on a layer, each effect assigned to a different variable, moving one of the effects 
invalidates the references for all of these variables. You will need to reassign them.

Parameters

Returns

Nothing.

PropertyBase name attribute
app.projec t . item(index) . layer( index) .proper tySpec .name

Description

The display name of the property. (Compare “PropertyBase matchName attribute” on page 152.)

It is an error to set the name value if the property is not a child of an indexed group (that is, a property group 
that has the type Proper tyTyp e.INDEXED_GROUP; see “PropertyBase propertyType attribute” on page 154).

Type

String; read/write for a child of an indexed group; otherwise read-only.

newIndex The new index position at which to place this property in its group. An integer.
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PropertyBase parentProperty attribute
app.projec t . item(index) . layer( index) .proper tySpec .parentProp er ty

Description

The property group that is the immediate parent of this property, or null if this PropertyBase is a layer.

Type

PropertyGroup object or null; read-only.

PropertyBase propertyDepth attribute
app.projec t . item(index) . layer( index) .proper tySpec .prop er tyDepth

Description

The number of levels of parent groups between this property and the containing layer. The value 0 for a layer. 

Type

Integer; read-only.

PropertyBase propertyGroup() method
app.projec t . item(index) . layer( index) .proper tySpec .prop er tyGroup()
app.projec t . item(index) . layer( index) .proper tySpec .prop er tyGroup(countUp)

Description

Gets the PropertyGroup object for an ancestor group of this property at a specified level of the parent-child 
hierarchy. 

Parameters

Returns

PropertyGroup object, or null if the count reaches the containing layer.

PropertyBase propertyIndex attribute
app.projec t . item(index) . layer( index) .proper tySpec .prop er tyIndex

Description

The position index of this property within its parent group, if it is a child of an indexed group (a property 
group that has the type Prop er tyType.INDEXED_GROUP; see “PropertyBase propertyType attribute” on 
page 154). 

Type

Integer; read-only.

countUp Optional. The number of levels to ascend within the parent-child hierarchy. An integer in the 
range [1..prop er tyDepth ]. Default is 1, which gets the immediate parent.
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PropertyBase propertyType attribute
app.projec t . item(index) . layer( index) .proper tySpec .prop er tyType

Description

The type of this property. 

Type 

A Prop er tyType enumerated value; read/write. One of:

PropertyBase remove() method
app.projec t . item(index) . layer( index) .proper tySpec . remove()

Description

Removes this property from its parent group. If this is a property group, it removes the child properties as well.

This method is valid only for children of indexed groups; if it is not, or if the index value is not valid, the 
method generates an exception and displays an error. (An indexed group has the type Proper-
tyTyp e.INDEXED_GROUP; see “PropertyBase propertyType attribute” on page 154.)

This method can be called on a text animation property (that is, any animator that has been set to a text layer).

Parameters

None.

Returns

Nothing.

PropertyBase selected attribute
app.projec t . item(index) . layer( index) .proper tySpec . se lec ted

Description

When true, this property is selected. Set to true to select the property, or to false to deselect it.

Sampling this attribute repeatedly for a large number of properties can slow down system performance. To 
read the full set of selected properties of a composition or layer, use the s electedProper t ies  attribute of a Comp 
or Layer object.

Type

Boolean; read/write.

Prop er tyType.PROPERT Y A single property such as position or zoom.

Prop er tyType.INDEXED_GROUP A property group whose members have an editable name and an index. Effects 
and masks are indexed groups. For example, the masks  property of a layer 
refers to a variable number of individual masks by index number.

Prop er tyType.NAMED_GROUP A property group in which the member names are not editable. Layers are 
named groups.
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PropertyGroup object
app.projec t . item(index) . layer( index) .proper tyGroupSpec

Description

The PropertyGroup object represents a group of properties. It can contain Property objects and other 
PropertyGroup objects. Property groups can be nested to provide a parent-child hierarchy, with a Layer object 
at the top (root) down to a single Property object, such as the mask feather of the third mask. To traverse the 
group hierarchy, use PropertyBase methods and attributes; see “PropertyBase propertyGroup() method” on 
page 153. 

For examples of how to access properties and property groups, see “PropertyBase object” on page 148.

• PropertyGroup is a subclass of PropertyBase. All methods and attributes of PropertyBase, in addition to 
those listed below, are available when working with PropertyGroup. See “PropertyBase object” on page 148.

• PropertyGroup is a base class for MaskPropertyGroup. PropertyGroup attributes and methods are available 
when working with mask groups. See “MaskPropertyGroup object” on page 106.

Attributes

Methods

PropertyGroup addProperty() method
app.projec t . item(index) . layer( index) .proper tyGroupSpec .addProper ty(name)

Description

Creates and returns a PropertyBase object with the specified name, and adds it to this group.

In general, you can only add properties to an indexed group (a property group that has the type
Prop er tyType.INDEXED_GROUP; see “PropertyBase propertyType attribute” on page 154) The only 
exception is a text animator property, which can be added to a named group (a property group that has the 
type Proper tyType.NAMED_GROUP). 

If this method cannot create a property with the specified name, it generates an exception. To check that you 
can add a particular property to this group, call canAddProper ty  before calling this method. (See “Property-
Group canAddProperty() method” on page 156.) 

Attribute Reference Description

numProp er t ies “PropertyGroup numProperties attribute” on page 156 The number of indexed properties in the group.

Method Reference Description

proper ty() “PropertyGroup property() method” on 
page 157

Gets a member property or group.

canAddProper ty() “PropertyGroup canAddProperty() method” 
on page 156

Reports whether a property can be added to the group.

addProp er ty() “PropertyGroup addProperty() method” on 
page 155

Adds a property to the group.
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Parameters

Returns

PropertyBase object.

PropertyGroup canAddProperty() method
app.projec t . item(index) . layer( index) .proper tyGroupSpec . canAddProper ty(name)

Description

Returns true if a property with the given name can be added to this property group. For example, you can only 
add mask to a mask group. The only legal input arguments are “mask” or “ADBE Mask Atom”.

maskGroup.canAddProper ty( "mask") ;  / / returns  t rue
maskGroup.canAddProper ty( "ADBE Mask Atom") ;  / /returns  tr ue
maskGroup.canAddProper ty( "blend") ;  / /  returns  fa ls e

Parameters

Returns

Boolean.

PropertyGroup numProperties attribute
app.projec t . item(index) . layer( index) .proper tyGroupSpec .numProper t ies

Description

The number of indexed properties in this group. 

For layers, this method returns a value of 3, corresponding to the mask, effect, and motion tracker groups, 
which are the indexed groups within the layer. However, layers also have many other properties available only 
by name; see the “PropertyGroup property() method” on page 157.

Type

Integer; read-only.

name The display name or match name of the property to add. (See “PropertyBase matchName attribute” on page 152).

The following names are supported:

• Any match name for a property that can be added through the user interface. For example, “ADBE Mask Atom”, 
“ADBE Paint Atom”, “ADBE Text Position”, “ADBE Text Anchor Point”.

• When adding to an ADBE Mask Parade: “ADBE Mask Atom”, “Mask”.

• When adding to an ADBE Effect Parade, any effect by match name, such as “ADBE Bulge”, “ADBE Glo2”, “APC Vegas”.

• Any effect by display name, such as “Bulge”, “Glow”, “Vegas”.

• For text animators, “ADBE Text Animator”.

• For selectors, Range Selector has the name “ADBE Text Selector”, Wiggly Selector has the name “ADBE Text Wiggly 
Selector”, and Expression Selector has the name “ADBE Text Expressible Selector”.

name The display name or match name of the property to be checked. (See “PropertyGroup addProp-
erty() method” on page 155). 
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PropertyGroup property() method
app.projec t . item(index) . layer( index) .proper tyGroupSpec .proper ty( index)
app.projec t . item(index) . layer( index) .proper tyGroupSpec .proper ty(name)

Description

Finds and returns a child property of this group, as specified by either its index or name. 

A name specification can use the same syntax that is available with expressions. The following are all allowed 
and are equivalent:

mylayer.p osit ion
mylayer("p osit ion")
mylayer.proper ty( "p osit ion")
mylayer(1)
mylayer.proper ty(1)

Some properties of a layer, such as position and zoom, can be accessed only by name. 

When using the name to find a property that is multiple levels down, you must make more than one call to 
this method. For example, the following call searches two levels down, and returns the first mask in the mask 
group:

myL ayer.prop er ty("ADBE Masks") .prop er ty(1)

Parameters
 

Returns

PropertyBase object or null if no child property with the specified string name is found.

Properties accessible by name

index The index for the child property, in this is an indexed group. An integer in the range [0..numProper-
t ies ].

name The name of the child property. This can be:

• Any match name

• Any name in expression “parenthesis style” syntax, meaning the display name or the compact English 
name

• Any name in expression “intercap style” syntax 

For supported property names, see the table below.

From any Layer • "ADBE Mask Parade", or “Masks”

• "ADBE Effect Parade", or “Effects”

• "ADBE MTrackers", or “Motion Trackers”



158

After Effects scripting reference PropertyGroup object 

158 

From an AVLayer • "Anchor Point" or "anchorPoint"

• "Position" or "position"

• "Scale" or "scale"

• "Rotation" or "rotation"

• "Z Rotation" or "zRotation" or "Rotation Z" or "rotationZ"

• "Opacity" or "opacity"

• "Marker" or "marker"

From an AVLayer with a non-still source • "Time Remap" or "timeRemapEnabled"

From an AVLayer with an audio component • "Audio Levels" or "audioLevels"

From a camera layer • "Zoom" or "zoom"

• "Depth of Field" or "depthOfField"

• "Focus Distance" or "focusDistance"

• "Aperture" or "aperture"

• "Blur Level" or "blurLevel"

From a light layer • "Intensity" or "intensity"

• "Color" or "color"

• "Cone Angle" or "coneAngle"

• "Cone Feather" or "coneFeather"

• "Shadow Darkness" or "shadowDarkness"

• "Shadow Diffusion" or "shadowDiffusion"

• "Casts Shadows" or "castsShadows"

From a 3D layer • "Accepts Shadows" or "acceptsShadows"

• "Accepts Lights" or "acceptsLights"

• "Ambient" or "ambient"

• "Diffuse" or "diffuse"

• "Specular" or "specular" (these are for the Specular Intensity property)

• "Shininess" or "shininess" (these are for the Specular Shininess property)

• "Casts Shadows" or "castsShadows"

• "Light Transmission" or "lightTransmission"

• "Metal" or "metal"

From a camera, light or 3D layer • "X Rotation" or "xRotation" or "Rotation X" or "rotationX"

• "Y Rotation" or "yRotation" or "Rotation Y" or "rotationY"

• "Orientation" or "orientation"

From a text layer • "Source Text" or "sourceText" or "Text" or "text"

From a PropertyGroup "ADBE Mask Parade" • "ADBE Mask Atom"

From a PropertyGroup "ADBE Mask Atom" • "ADBE Mask Shape", or “maskShape”, or “maskPath”

• "ADBE Mask Feather", or “maskFeather”

• "ADBE Mask Opacity", or “maskOpacity”

• "ADBE Mask Offset", or “maskOffset”



159

After Effects scripting reference PropertyGroup object 

159 

Examples

1 If a layer named “myLayer” has a Box Blur effect, you can retrieve the effect in any of the following ways:
myL ayer.prop er ty(“Ef fec ts”) .proper ty(“B ox  Blur”) ;
myL ayer.prop er ty(“Ef fec ts”) .proper ty(“boxBlur”) ;
myL ayer.prop er ty(“Ef fec ts”) .proper ty(“ADBE B ox Blur”) ;

2 If a layer named “myLayer” has a mask named “Mask 1” you can retrieve it as follows:

myL ayer.prop er ty(“Masks”) .proper ty(“Mask 1”) ;

3 To get a Bulge Center value from a Bulge effect, you can use either of the following:

myL ayer.prop er ty(“Ef fec ts”) .proper ty(“Bulge”) .proper ty(“Bulge  C enter”) ;
myL ayer.prop er ty(“Ef fec ts”) .proper ty(“Bulge”) .proper ty(“bulgeC enter”) ;
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RenderQueue object
app.projec t . renderQueue

Description

The RenderQueue object represents the render automation process, the data and functionality that is available 
through the Render Queue panel of a particular After Effects project. Attributes provide access to items in the 
render queue and their render status. Methods can start, pause, and stop the rendering process.

The RenderQueueItem object provides access to the specific settings for an item to be rendered. See “Render-
QueueItem object” on page 163.

Attributes

Methods

RenderQueue item() method
app.projec t . renderQueue. i tem( index )

Description

Gets a specified item from the items collection.

Parameters

Returns

RenderQueueItem object.

Attribute Reference Description

rendering “RenderQueue rendering attribute” on page 162 When true, a render is in progress.

numItems “RenderQueue numItems attribute” on page 161 The total number of items in the render queue.

i tems “RenderQueue items attribute” on page 161 The collection of items in the render queue.

Method Reference Description

showWindow() “RenderQueue showWindow() method” 
on page 162

Show or hides the Render Queue panel.

render() “RenderQueue render() method” on 
page 161

Starts the rendering process; does not return until render is 
complete.

pauseRender ing() “RenderQueue pauseRendering() 
method” on page 161

Pauses or restarts the rendering process.

stopRendering() “RenderQueue stopRendering() 
method” on page 162

Stops the rendering process.

i tem() “RenderQueue item() method” on 
page 160

Gets a render-queue item from the collection.

index The position index of the item. An integer in the range [0..numItems ].
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RenderQueue items attribute
app.projec t . renderQueue. i tems

Description

A collection of all items in the render queue. See “RenderQueueItem object” on page 163.

Type

RQItemCollection object; read-only.

RenderQueue numItems attribute
app.projec t . renderQueue.numItems

Description

The total number of items in the render queue.

Type

Integer; read-only.

RenderQueue pauseRendering() method
app.projec t . renderQueue.pauseRender ing(pause)

Description

Pauses the current rendering process, or continues a paused rendering process. This is the same as clicking 
Pause in the Render Queue panel during a render. You can call this method from an onStatusChanged or 
onError callback. See “RenderQueueItem onStatusChanged attribute” on page 165 and “Application onError 
attribute” on page 24.

Parameters

Returns

Nothing.

RenderQueue render() method
app.projec t . renderQueue.render()

Description

Starts the rendering process. This is the same as clicking Render in the Render Queue panel. The method does 
not return until the render process is complete. To pause or stop the rendering process, call pauseRender ing()  
or stopRender ing()  from an onError or onStatusChanged callback.

• To respond to errors during the rendering process, define a callback function in app.onError ; see “Appli-
cation onError attribute” on page 24.

• To respond to changes in the status of a particular item while the render is progressing, define a callback 
function in RenderQueueItem.onStatusChanged in the associated RenderQueueItem object; see “Render-
QueueItem onStatusChanged attribute” on page 165.

pause True to pause a current render process, false to continue a paused render.
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Parameters

None.

Returns

Nothing.

RenderQueue rendering attribute
app.projec t . renderQueue.rendering

Description

When true, the rendering process is in progress or paused. When false, it is stopped. 

Type

Boolean; read-only.

RenderQueue showWindow() method
app.projec t . renderQueue.showWindow(doShow)

Description

Shows or hides the Render Queue panel.

Parameters

Returns

Nothing.

RenderQueue stopRendering() method
app.projec t . renderQueue.s topRendering()

Description

Stops the rendering process. This is the same as clicking Stop in the Render Queue panel during a render. You 
can call this method from an onStatusChanged or onError callback. See “RenderQueueItem onStatus-
Changed attribute” on page 165 and “Application onError attribute” on page 24.

Parameters

None.

Returns

Nothing.

doShow When true, show the Render Queue panel. When false, hide it.
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RenderQueueItem object
app.projec t . renderQueue. i tem( index )

Description

The RenderQueueItem object represents an individual item in the render queue. It provides access to the 
specific settings for an item to be rendered. Create the object by adding a composition to the Render Queue 
with the RQItemCollection object; see “RQItemCollection add() method” on page 169.

Attributes

Methods

Attribute Reference Description

numOutputModules “RenderQueueItem numOutputModules 
attribute” on page 165

The total number of Output Modules assigned to the 
item.

render “RenderQueueItem render attribute” on 
page 166

When true, this item is rendered when the queue is 
started.

star tTime “RenderQueueItem startTime attribute” on 
page 167

The time when rendering began for the item.

e lapsedS econds “RenderQueueItem elapsedSeconds attri-
bute” on page 164

The time elapsed in the current rendering of this item.

t imeSpanStar t “RenderQueueItem timeSpanStart attri-
bute” on page 168

The start time in the composition to be rendered.

t imeSpanDurat ion “RenderQueueItem timeSpanDuration 
attribute” on page 168

The duration of the composition to be rendered.

sk ipFrames “RenderQueueItem skipFrames attribute” 
on page 167

The number of frames to skip when rendering this item.

comp “RenderQueueItem comp attribute” on 
page 164

The composition to be rendered by this item.

outputModules “RenderQueueItem outputModules attri-
bute” on page 166

The collection of Output Modules for this item.

templates “RenderQueueItem templates attribute” on 
page 168

A set of Render Settings templates.

status “RenderQueueItem status attribute” on 
page 167

The current rendering status of the item.

onStatusChanged “RenderQueueItem onStatusChanged attri-
bute” on page 165

A callback function that is called during the rendering 
process when the status of the item changes.

logType “RenderQueueItem logType attribute” on 
page 165

A log type for this item.

Method Reference Description

outputModule() “RenderQueueItem outputModule() method” on 
page 166

Gets an Output Module for the item.

remove() “RenderQueueItem remove() method” on page 166 Removes the item from the render queue.

saveAsTemplate() “RenderQueueItem saveAsTemplate() method” on 
page 167

Saves a new Render Settings template.
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RenderQueueItem applyTemplate() method
app.projec t . renderQueue. i tem( index) .applyTemplate( templateName )

Description

Applies a Render Settings template to the item. See also “RenderQueueItem saveAsTemplate() method” on 
page 167 and “RenderQueueItem templates attribute” on page 168.

Parameters

Returns

Nothing.

RenderQueueItem comp attribute
app.projec t . renderQueue. i tem( index) .comp

Description

The composition that will be rendered by this render-queue item. To change the composition, you must delete 
this render-queue item and create a new one.

Type

CompItem object; read-only.

RenderQueueItem duplicate() method
app.projec t . renderQueue. i tem( index) .dupl icate()

Description

Creates a duplicate of this item and adds it this render queue.

NOTE: Duplicating an item whose status is “Done” sets the new item’s status to “Queued”.

Parameters

None.

Returns

RenderQueueItem object.

RenderQueueItem elapsedSeconds attribute
app.projec t . renderQueue. i tem( index) .elapsedSeconds

applyTemplate() “RenderQueueItem applyTemplate() method” on 
page 164

Applies a Render Settings template.

dupl icate “RenderQueueItem duplicate() method” on page 164 Duplicates this item.

templateName A string containing the name of the template to apply.

Method Reference Description
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Description

The number of seconds spent rendering this item.

Type

Integer, or null if item has not been rendered; read-only.

RenderQueueItem logType attribute
app.projec t . renderQueue. i tem( index) . logTyp e

Description

A log type for this item, indicating which events should be logged while this item is being rendered.

Type

A L ogType enumerated value; (read/write). One of:

LogType.ERRORS_ONLY
LogType.ERRORS_AND_SET TINGS
LogType.ERRORS_AND_PER_FRAME_INFO

RenderQueueItem numOutputModules attribute
app.projec t . renderQueue. i tem( index) .numOutputModules

Description

The total number of Output Modules assigned to this item.

Type

Integer; read-only.

RenderQueueItem onStatusChanged attribute
app.projec t . renderQueue. i tem( index) .onStatusChanged

Description

The name of a callback function that is called whenever the value of the RenderQueueItem.status attribute 
changes. See “RenderQueueItem status attribute” on page 167.

You cannot make changes to render queue items or to the application while rendering is in progress or paused; 
you can, however, use this callback to pause or stop the rendering process. See “RenderQueue pauseRen-
dering() method” on page 161 and “RenderQueue stopRendering() method” on page 162.

See also “Application onError attribute” on page 24.

Type

A function name string, or null if no function is assigned.

Example

funct ion myStatusChanged()  {
a ler t(app.projec t . renderQueue. i tem(1) .s tatus)

}
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app.projec t . renderQueue. i tem(1) .onStatusChanged = myStatusChanged() ;
app.projec t . renderQueue. i tem(1) .render = fa lse ;  / /changes  status  and shows dia log

RenderQueueItem outputModules attribute
app.projec t . renderQueue. i tem( index) .outputModules

Description

The collection of Output Modules for the item.

Type

OMCollection object; read-only.

RenderQueueItem outputModule() method
app.projec t . renderQueue. i tem( index) .outputModule( index)

Description

Gets an output module with the specified index position.

Parameters

Returns

OutputModule object.

RenderQueueItem remove() method
app.projec t . renderQueue. i tem( index) .remove()

Description

Removes this item from the render queue.

Parameters

None.

Returns

Nothing.

RenderQueueItem render attribute
app.projec t . renderQueue. i tem( index) .render

Description

When true, the item will be rendered when the render queue is started. When set to true, the Render-
QueueItem.status  is set to RQItemStatus .QUEUED. When set to false, status is set to RQItem-
Status .UNQUEUED.

index The position index of the output module. An integer in the range [1..numOutputModules ].
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Type

Boolean; read/write.

RenderQueueItem saveAsTemplate() method
app.projec t . renderQueue. i tem( index) .saveAsTemplate(name)

Description

Saves the item’s current render settings as a new template with the specified name.

Parameters

Returns

Nothing.

RenderQueueItem skipFrames attribute
app.projec t . renderQueue. i tem( index) .sk ipFrames

Description

The number of frames to skip when rendering this item. Use this to do rendering tests that are faster than a 
full render. 

A value of 0 skip no frames, and results in regular rendering of all frames. A value of 1 skips every other frame. 
This is equivalent to "rendering on twos." Higher values skip a larger number of frames.

The total length of time remains unchanged. For example, if skip has a value of 1, a sequence output would 
have half the number of frames and in movie output, each frame would be double the duration. 

Type

Integer in the range [0..99]. Read/write.

RenderQueueItem startTime attribute
app.projec t . renderQueue. i tem( index) .star tTime

Description

The day and time that this item started rendering.

Type

Date object, or null if the item has not started rendering; read-only.

RenderQueueItem status attribute
app.projec t . renderQueue. i tem( index) .status

Description

The current render status of the item.

name A string containing the name of the new template.
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Type

An RQItemStatus enumerated value; read-only. One of:

RenderQueueItem templates attribute
app.projec t . renderQueue. i tem( index) . templates

Description

The names of all Render Settings templates available for the item. See also “RenderQueueItem saveAsTem-
plate() method” on page 167.

Type

Array of strings; read-only.

RenderQueueItem timeSpanDuration attribute
app.projec t . renderQueue. i tem( index) . t imeSpanDurat ion

Description

The duration in seconds of the composition to be rendered. The duration is determined by subtracting the 
start time from the end time. Setting this value is the same as setting a custom end time in the Render Settings 
dialog box. 

Type

Floating-point value; read/write.

RenderQueueItem timeSpanStart attribute
app.projec t . renderQueue. i tem( index) . t imeSpanStar t

Description

The time in the composition, in seconds, at which rendering will begin. Setting this value is the same as setting 
a custom start time in the Render Settings dialog box.

Type

Floating-point value; read/write.

RQItemStatus .WILL_CONTINUE Rendering process has been paused.

RQItemStatus .NEEDS_OUTPUT Item lacks a valid output path.

RQItemStatus .UNQUEUED Item is listed in the Render Queue panel but composition is not ready to render.

RQItemStatus .QUEUED Composition is ready to render.

RQItemStatus .RENDERING Composition is rendering

RQItemStatus .USER_STOPPED Rendering process was stopped by user or script.

RQItemStatus .ERR_STOPPED Rendering process was stopped due to an error.

RQItemStatus .D ONE Rendering process for the item is complete.
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RQItemCollection object
app.projec t . renderQueue. i tems

Description

The RQItemCollection contains all of the render-queue items in a project, as shown in the Render Queue 
panel of the project. The collection provides access to the RenderQueueItem objects, and allows you to create 
them from compositions. The first RenderQueueItem object in the collection is at index position 1. See 
“RenderQueueItem object” on page 163

• RQItemCollection is a subclass of Collection. All methods and attributes of Collection are available when 
working with RQItemCollection. See “Collection object” on page 51.

Methods

RQItemCollection add() method
app.projec t . renderQueue. i tems.add(comp)

Description

Adds a composition to the Render Queue, creating a RenderQueueItem.

Parameters

Returns

RenderQueueItem object.

Method Reference Description

add() “RQItemCollection add() method” on page 169 Adds a composition to the Render Queue.

comp The CompItem object for the composition to be added.
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Settings object

Description

The Settings object provides an easy way to manage settings for scripts. The settings are saved in the After 
Effects preferences file and are persistent between application sessions. Settings are identified by section and 
key within the file, and each key name is associated with a value. In the preferences file, section names are 
enclosed in brackets and quotation marks, and key names are listing in quotation marks below the section 
name. All values are strings.

You can create new settings with this object, as well as accessing existing settings.

Methods

Settings getSetting() method
app.set t ings .getS ett ing(sectionName,  keyName)

Description

Retrieves a scripting preferences item value from the preferences file.

Parameters

Returns

String.

Example

If you have saved a setting named with the key name “Aligned Clone” in the “Eraser - Paint Settings” section, 
you can retrieve the value with this script:

var  n  = app.s ett ings .getS ett ing("Eraser  -  Paint  Sett ings" ,  "Al igned Clone") ;
a ler t( "The sett ing is  "  +  n) ;

Settings haveSetting() method
app.set t ings .haveSett ing(sec tionName,  keyName )

Description

Returns true if the specified scripting preferences item exists and has a value.

Method Reference Description

saveSett ing() “Settings saveSetting() method” on page 171 Saves a default value for a setting.

getSett ing() “Settings getSetting() method” on page 170 Retrieves a setting value.

haveSett ing() “Settings haveSetting() method” on page 170 Reports whether a specified setting is assigned.

sec t ionName A string containing the name of a settings section

keyName A string containing the key name of the setting item.
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Parameters

Returns

Boolean.

Settings saveSetting() method
app.set t ings . saveSett ing(sec tionName,  keyName,  value)

Description

Saves a default value for a scripting preferences item.

Parameters

Returns

Nothing.

sec t ionName A string containing the name of a settings section

keyName A string containing the key name of the setting item.

sec t ionName A string containing the name of a settings section

keyName A string containing the key name of the setting item.

va lue A string containing the new value.
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Shape object
app.projec t . item(index) . layer( index) .proper ty( index) .proper ty( "maskShap e") .va lue  

Description

The Shape object encapsulates information describing a shape in a shape layer, or the outline shape of a Mask. 
It is the value of the “Mask Path” AE properties, and of the "Path" AE property of a shape layer. Use the 
constructor, new Shape() , to create a new, empty Shape object, then set the attributes individually to define 
the shape.

A shape has a set of anchor points, or vertices, and a pair of direction handles, or tangent vectors, for each 
anchor point. A tangent vector (in a non-RotoBezier mask) determines the direction of the line that is drawn 
to or from an anchor point. There is one incoming tangent vector and one outgoing tangent vector associated 
with each vertex in the shape. 

A tangent value is a pair of x,y coordinates specified relative to the associated vertex. For example, a tangent 
of [-1,-1] is located above and to the left of the vertex and has a 45 degree slope, regardless of the actual location 
of the vertex. The longer a handle is, the greater its influence; for example, an incoming shape segment stays 
closer to the vector for an inTangent of [-2,-2] than it does for an inTangent of 
[-1,-1], even though both of these come toward the vertex from the same direction.

If a shape is not closed, the inTangent for the first vertex and the outTangent for the final vertex are ignored. 
If the shape is closed, these two vectors specify the direction handles of the final connecting segment out of 
the final vertex and back into the first vertex.

RotoBezier masks calculate their tangents automatically. (See “MaskPropertyGroup rotoBezier attribute” on 
page 108.) If a shape is used in a RotoBezier mask, the tangent values are ignored. This means that, for 
RotoBezier masks, you can construct a shape by setting only the ver t ices  attribute and setting both inTangents 
and outTangents  to null. When you access the new shape, its tangent values are filled with the automatically 
calculated tangent values.

For closed mask shapes, variable-width mask feather points can exist anywhere along the mask path. Feather 
points are part of the Mask Path property. Reference a specific feather point by the number of the mask path 
segment (portion of the path between adjacent vertices) where it appears.

NOTE: The feather points on a mask are listed in an array in the order that they were created.

Example: Create a square mask

A square is a closed shape with 4 vertices. The inTangents  and outTangents  for connected straight-line 
segments are 0, the default, and do not need to be explicitly set.

var  myShap e =  new Shap e() ;
myShap e.ver t ices  = [[0 ,0] ,  [0 ,100] ,  [100,100] ,  [100,0]] ;
myShap e.c losed =  t rue;

Example: Create a “U” shaped mask

A "U" is an open shape with the same 4 vertices used in the square:

var  myShap e =  new Shap e() ;
myShap e.ver t ices  = [[0 ,0] ,  [0 ,100] ,  [100,100] ,  [100,0]] ;
myShap e.c losed =  fa lse ;
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Example: Create an oval

An oval is a closed shape with 4 vertices and with inTangent and outTangent values:

var  myShap e =  new Shap e() ;
myShap e.ver t ices  = [[300,50] , [200,150] ,[300 ,250] ,[400 ,150]] ;
myShap e. inTangents  =  [[55.23 ,0] , [0 ,-55.23] , [-55.23 ,0] , [0 ,55 .23]] ;
myShap e.outTangents  =  [[ -55.23,0] , [0 ,55.23] , [55 .23,0] , [0 ,-55 .23]] ;
myShap e.c losed =  t rue;  

Example: Create a square mask with two feather points

A large square mask with two feather points, one closer to the left end the second mask segment (off the 
bottom edge) with a radius of 30 pixels and the other one centered the third mask segment (off the right edge) 
with a larger radius of 100 pixels.

var  myShap e =  new Shap e() ;
myShap e.ver t ices  = [[100,100] ,  [100,400] ,  [400,400] ,  [400 ,100]] ; / /  s egments  drawn counterclockwis e
myShap e.c losed =  t rue;

myShap e.featherSegLocs  = [1 ,2] ; / /  s egments  are  numbered star t ing at  0 ,  s o  second segment  is  1
myShap e.featherRelSegLocs  = [0 .15,  0 .5] ; / /  0 .15 i s  c loser  to  the  lower- le f t  corner  of  the  square
myShap e. featherR adi i  =  [30,  100] ; / /  s econd feather  p oint  (on r ight-s ide  segment)  has  a  l arger  radius

Attributes

Shape closed attribute
shapeObjec t .va lue.c losed

Attribute Reference Description

clos ed “Shape closed attribute” on page 173 When true, the shape is a closed curve.

ver t ices “Shape vertices attribute” on page 177 The anchor points of the shape.

inTangents “Shape inTangents attribute” on page 176 The tangent vectors coming into the shape vertices.

outTangents “Shape outTangents attribute” on 
page 176

The tangent vectors coming out of the shape vertices.

featherS egL ocs “Shape featherSegLocs attribute” on 
page 175

The mask path segment (sections of a mask path 
between vertices) containing each feather point.

featherRelS egL ocs “Shape featherRelSegLocs attribute” on 
page 175

The relative position of each feather point on its mask 
path segment.

featherR adi i “Shape featherRadii attribute” on 
page 174

The feather amount (radius) for each feather point.

featherInterps “Shape featherInterps attribute” on 
page 174

The feather radius interpolation type for each feather 
point.

featherTensions “Shape featherTensions attribute” on 
page 176

The feather tension at each feather point.

featherTypes “Shape featherTypes attribute” on 
page 176

The direction (inner or outer) of each feather point.

featherRelC ornerAngles “Shape featherRelCornerAngles attribute” 
on page 174

The relative angle between the two normals on either 
side of a curved outer feather boundary at a corner on 
a mask path.
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Description

When true, the first and last vertices are connected to form a closed curve. When false, the closing segment is 
not drawn.

Type

Boolean; read/write.

Shape featherInterps attribute
shapeObjec t .va lue. featherInter ps

Description

An array containing each feather point’s radius interpolation type (0 for non-Hold feather points, 1 for Hold 
feather points).

NOTE: Values are stored in the array in the order that feather points are created.

Type

Array of integers (0 or 1); read/write.

Shape featherRadii attribute
shapeObjec t .va lue. featherR adi i

Description

An array containing each feather point’s radius (feather amount); inner feather points have negative values.

NOTE: Values are stored in the array in the order that feather points are created.

Type

Array of floating-point values; read/write.

Shape featherRelCornerAngles attribute
shapeObjec t .va lue. featherRelC ornerAngles

Description

An array containing each feather point’s relative angle percentage between the two normals on either side of 
a curved outer feather boundary at a corner on a mask path. The angle value is 0% for feather points not at 
corners.

NOTE: Values are stored in the array in the order that feather points are created.

Type

Array of floating-point percentage values (0 to 100); read/write.
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Shape featherRelSegLocs attribute
shapeObjec t .va lue. featherRelSegLo cs

Description

An array containing each feather point’s relative position, from 0 to 1, on its mask path segment (section of 
the mask path between vertices, numbered starting at 0).

NOTE: Values are stored in the array in the order that feather points are created.

To move a feather point to a different mask path segment, first change the featherSegLocs attribute value, then 
this attribute.

Type

Array of floating-point values (0 to 1); read/write.

Shape featherSegLocs attribute
shapeObjec t .va lue. featherSegLo cs

Description

An array containing each feather point’s mask path segment number (section of the mask path between 
vertices, numbered starting at 0).

NOTE: Values are stored in the array in the order that feather points are created.

Move a feather point to a different segment by changing both its segment number (this attribute) and, 
optionally, its featherRelS egL ocs attribute value.

Type

Array of integers; read/write.

Example

/ /  Assuming a  rec tang le  c losed mask  (segments  numbered 0-3)  has  3  mask feather  points ,
/ /  move a l l  3  feather  points  to  the  f i rst  mask s egment .

/ /  Get  the  Shap e objec t  for  the  mask ,  assumed here  to  b e  the  f i rst  mask on the  layer.
var  my_maskShape = layer.mask(1) .prop er ty("ADBE Mask Shap e") .va lue ;

/ /  Check where  mask feather  points  are  located.
/ /  Note :  They  are  stored  in  the  order  that  they are  added.
var  where_are_myMaskFeatherPoints  =  my_maskShape. featherSegLo cs ;

/ /  Move a l l  3  feather  p oints  to  the  f i rs t  mask segment  (numbered 0) .
my_maskShape. featherS egLo cs  = [0 ,  0 ,  0] ;

/ /  Update  the  mask path.
layer.mask(1) .proper ty("ADBE Mask  Shap e") . setValue(my_maskShape) ;
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Shape featherTensions attribute
shapeObjec t .va lue. featherTensions

Description

An array containing each feather point’s tension amount, from 0 (0% tension) to 1 (100% tension).

NOTE: Values are stored in the array in the order that feather points are created.

Type

Array of floating-point values (0 to 1); read/write.

Shape featherTypes attribute
shapeObjec t .va lue. featherTyp es

Description

An array containing each feather point’s direction, either 0 (outer feather point) or 1 (inner feather point).

NOTE: You cannot change the direction of a feather point after it has been created.

NOTE: Values are stored in the array in the order that feather points are created.

Type

Array of integers (0 or 1); read/write.

Shape inTangents attribute
shapeObjec t .va lue. inTangents

Description

The incoming tangent vectors, or direction handles, associated with the vertices of the shape. Specify each 
vector as an array of two floating-point values, and collect the vectors into an array the same length as the 
ver t ices  array. 

Each tangent value defaults to [0,0]. When the mask shape is not RotoBezier, this results in a straight line 
segment. 

If the shape is in a RotoBezier mask, all tangent values are ignored and the tangents are automatically calcu-
lated. 

Type

Array of floating-point pair arrays; read/write.

Shape outTangents attribute
shapeObjec t .va lue.outTangents

Description

The outgoing tangent vectors, or direction handles, associated with the vertices of the shape. Specify each 
vector as an array of two floating-point values, and collect the vectors into an array the same length as the 
ver t ices  array. 
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Each tangent value defaults to [0,0]. When the mask shape is not RotoBezier, this results in a straight line 
segment. 

If the shape is in a RotoBezier mask, all tangent values are ignored and the tangents are automatically calcu-
lated. 

Type

Array of floating-point pair arrays; read/write.

Shape vertices attribute
shapeObjec t .va lue.ver t ices

Description

The anchor points of the shape. Specify each point as an array of two floating-point values, and collect the 
point pairs into an array for the complete set of points. For example:

myShap e.ver t ices  = [[0 ,0] ,  [0 ,1] ,  [1 ,1] ,  [1 ,0]] ;

Type

Array of floating-point pair arrays; read/write.
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ShapeLayer object
app.projec t . item(index) . layer( index)

Description

The ShapeLayer object represents a shape layer within a composition. Create it using the LayerCollection 
object’s addShape()  method; see “LayerCollection addShape() method” on page 97. It can be accessed in an 
item’s layer collection either by index number or by a name string. 

• ShapeLayer is a subclass of AVLayer, which is a subclass of Layer. All methods and attributes of AVLayer 
and Layer are available when working with ShapeLayer. See “Layer object” on page 86 and “AVLayer object” 
on page 38.
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SolidSource object
app.projec t . item(index) .mainSource
app.projec t . item(index) .proxySource

Description

The SolidSource object represents a solid-color footage source. 

• SolidSource is a subclass of FootageSource. All methods and attributes of FootageSource, in addition to 
those listed below, are available when working with SolidSource. See “FootageSource object” on page 69.

Attributes

SolidSource color attribute
sol idSource.color  

Description

The color of the solid, expressed as red, green, and blue values.

Type

Array of three floating-point values, [R, G, B], in the range [0.0..1.0]; read/write.

Attribute Reference Description

color  “SolidSource color attribute” on page 179 The color of the solid.
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System object
system

Description

The System object provides access to attributes found on the user’s system, such as the user name and the name 
and version of the operating system. It is available through the system global variable.

Example

a ler t  ( "Your  OS is  "  +  system.osName + "  running vers ion "  +  system.osVers ion) ;
conf irm("You are :  "  +  system.userName + "  running on "  + system.machineName + " . " ) ;

Attributes

Methods

System callSystem() method
system .cal lSystem (cmdLineToExecute) ;

Description

Executes a system command, as if you had typed it on the operating system’s command line. Returns whatever 
the system outputs in response to the command, if anything.

In Windows, you can invoke commands using the /c  switch for the cmd.exe command, passing the command 
to run in escaped quotes (\ " . . . \ "). For example, the following retrieves the current time and displays it to the 
user:

var  t imeStr  =  system.ca l lSystem("cmd.exe  /c  \ " t ime / t \" " ) ;
a ler t( "Current  t ime is  "  +  t imeStr) ;

Parameters

Returns

The output from the command.

Attribute Reference Description

userName “System userName attribute” on page 181 The current user name.

machineName “System machineName attribute” on page 181 The name of the host computer.

osName “System osName attribute” on page 181 The name of the operating system.

osVersion “System osVersion attribute” on page 181 The version of the operating system.

Method Reference Description

ca l lSystem() “System callSystem() method” on page 180 Execute’s a command on the system’s command line.

cmdLineToExecute A string containing the command and its parameters.
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System machineName attribute
system .machineName

Description

The name of the computer on which After Effects is running.

Type

String; read-only.

System osName attribute
system .osName

Description

The name of the operating system on which After Effects is running.

NOTE: As of Windows 7, this attribute returns a blank value. Use $.os  instead.

Type

String; read-only.

System osVersion attribute
system .osVers ion

Description

The version of the current local operating system.

Type

String; read-only.

System userName attribute
system .us erName

Description

The name of the user currently logged on to the system.

Type

String; read-only.
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TextDocument object
new TextDocument(docText)
app.projec t . item(index) . layer( index) .proper ty( "S ource  Text") .va lue 

Description

The TextDocument object stores a value for a TextLayer's Source Text property. Create it with the constructor, 
passing the string to be encapsulated. 

Examples

This sets a value of some source text and displays an alert showing the new value:

var  myTextDocument  =  new TextDo cument("Happy C ake") ;
myTextL ayer.prop er ty( "Source  Text") . setValue(myTextDocument) ;
a ler t(myTextL ayer.prop er ty("Source  Text") .va lue) ;

This sets keyframe values for text that show different words over time:

var  textProp = myTextL ayer.proper ty("Source  Text") ;
textProp.setValueAtTime(0,  new TextDocument("Happy")) ;
textProp.setValueAtTime( .33,  new TextDocument("cake")) ;
textProp.setValueAtTime( .66,  new TextDocument(" is ") ) ;
textProp.setValueAtTime(1,  new TextDocument("yummy!")) ;

This sets various character and paragraph settings for some text:

var  textProp = myTextL ayer.proper ty("Source  Text") ;
var  textDocument =  textProp.va lue ;
myStr ing  = "Happy hol idays! " ;
textDocument .res etCharSty le() ;
textDocument . fontSize  = 60 ;
textDocument . f i l lC olor  =  [1 ,  0 ,  0] ;
textDocument .s trokeC olor  =  [0 ,  1 ,  0] ;
textDocument .s trokeWidth  =  2 ;
textDocument . font  = "TimesNewRomanPSMT";
textDocument .s trokeO verFi l l  =  tr ue ;
textDocument .applyStroke  = true;
textDocument .applyFi l l  =  t rue ;
textDocument . text  =  myStr ing ;
textDocument . just i f icat ion = ParagraphJust i f icat ion.CENTER_JUSTIFY;
textDocument . t racking  = 50 ;
textProp.setValue(textD ocument) ;

Attributes

Attribute Reference Description

text “TextDocument text attribute” on page 187 The text layer’s Source Text value.

font “TextDocument font attribute” on page 184 The text layer’s font specified by its PostScript 
name.

fontSize “TextDocument fontSize attribute” on page 185 The text layer’s font size in pixels.

applyFi l l “TextDocument applyFill attribute” on page 183 When true, the text layer shows a fill.
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Methods

TextDocument applyFill attribute
textDocument .applyFi l l

Description

When true, the text layer shows a fill. Access the f i l lColor attribute for the actual color. When false, only a 
stroke is shown.

Type

Boolean; read/write.

TextDocument applyStroke attribute
textDocument .applyStroke

Description

When true, the text layer shows a stroke. Access the st rokeC olor attribute for the actual color and st rokeWidth 
for its thickness. When false, only a fill is shown.

Type

Boolean; read/write.

applyStroke “TextDocument applyStroke attribute” on page 183 When true, the text layer shows a stroke.

f i l lC olor “TextDocument fillColor attribute” on page 184 The text layer’s fill color.

strokeC olor “TextDocument strokeColor attribute” on page 186 The text layer’s stroke color.

s trokeO verFi l l “TextDocument strokeOverFill attribute” on page 186 Indicates the rendering order for the fill and stroke 
of a text layer.

strokeWidth “TextDocument strokeWidth attribute” on page 186 The text layer’s stroke thickness.

just i f icat ion “TextDocument justification attribute” on page 185 The paragraph justification for the text layer.

t racking “TextDocument tracking attribute” on page 187 The text layer’s spacing between characters.

p ointText “TextDocument pointText attribute” on page 185 When true, the text layer is point (unbounded) 
text.

boxText “TextDocument boxText attribute” on page 184 When true, the text layer is paragraph (bounded) 
text.

boxTextSize “TextDocument boxTextSize attribute” on page 184 For box text, the pixel dimensions for the text 
bounds.

Method Reference Description

resetCharSty le() “TextDocument resetCharStyle() method” on 
page 185

Restores the default character settings in the 
Character panel.

resetParagraphSty le() “TextDocument resetParagraphStyle() method” 
on page 186

Restores the default paragraph settings in the 
Paragraph panel.

Attribute Reference Description
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TextDocument boxText attribute
textDocument .b oxText

Description

True if a text layer is a layer of paragraph (bounded) text; otherwise false.

Type

Boolean; read-only.

TextDocument boxTextSize attribute
textDocument .b oxTextSize

Description

The size of a paragraph (box) text layer as a [width, height] array of pixel dimensions.

Type

Array of two integers (minimum value of 1); read/write.

TextDocument fillColor attribute
textDocument . f i l lC olor

Description

The text layer’s fill color, as an array of [r, g, b] floating-point values. For example, in an 8-bpc project, a red 
value of 255 would be 1.0, and in a 32-bpc project, an overbright blue value can be something like 3.2.

NOTE: If the text layer has different fill color settings for each character, this attribute returns the setting for the 
first character. Also, if you change the value, it resets all characters in the text layer to the specified setting.

Type

Array [r, g, b] of floating-point values; read/write.

TextDocument font attribute
textDocument . font

Description

The text layer’s font specified by its PostScript name.

NOTE: If the text layer has different font settings for each character, this attribute returns the setting for the first 
character. Also, if you change the value, it resets all characters in the text layer to the specified setting.

Type

String; read/write.
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TextDocument fontSize attribute
textDocument . fontSize

Description

The text layer’s font size in pixels.

NOTE: If the text layer has different font size settings for each character, this attribute returns the setting for the 
first character. Also, if you change the value, it resets all characters in the text layer to the specified setting.

Type

Floating-point value (0.1 to 1296, inclusive); read/write.

TextDocument justification attribute
textDocument . just i f icat ion

Description

The paragraph justification for the text layer.

Type

A ParagraphJust i f icat ion enumerated value; read-only. One of:

ParagraphJust i f icat ion.LEFT_JUSTIFY
ParagraphJust i f icat ion.RIGHT_JUSTIFY
ParagraphJust i f icat ion.CENTER_JUSTIFY
ParagraphJust i f icat ion.FULL_JUSTIFY_LASTLINE_LEFT
ParagraphJust i f icat ion.FULL_JUSTIFY_LASTLINE_RIGHT
ParagraphJust i f icat ion.FULL_JUSTIFY_LASTLINE_CENTER
ParagraphJust i f icat ion.FULL_JUSTIFY_LASTLINE_FULL

TextDocument pointText attribute
textDocument .p ointText

Description

True if a text layer is a layer of point (unbounded) text; otherwise false.

Type

Boolean; read-only.

TextDocument resetCharStyle() method
textDocument . res etCharSty le()

Description

Restores the default text character characteristics in the Character panel.

Parameters

None.
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Returns

Nothing.

TextDocument resetParagraphStyle() method
textDocument . res etParagraphSty le()

Description

Restores the default text paragraph characteristics in the Paragraph panel.

Parameters

None.

Returns

Nothing.

TextDocument strokeColor attribute
textDocument . s t rokeC olor

Description

The text layer’s stroke color, as an array of [r, g, b] floating-point values. For example, in an 8-bpc project, a 
red value of 255 would be 1.0, and in a 32-bpc project, an overbright blue value can be something like 3.2.

NOTE: If the text layer has different stroke color settings for each character, this attribute returns the setting for 
the first character. Also, if you change the value, it resets all characters in the text layer to the specified setting.

Type

Array [r, g, b] of floating-point values; read/write.

TextDocument strokeOverFill attribute
textDocument . s t rokeO verFi l l

Description

Indicates the rendering order for the fill and stroke of a text layer. When true, the stroke appears over the fill.

NOTE: If the text layer has different fill/stroke rendering order settings for each character, this attribute returns 
the setting for the first character. Also, if you change the value, it resets all characters in the text layer to the 
specified setting.

Type

Boolean; read/write.

TextDocument strokeWidth attribute
textDocument . s t rokeWidth

Description

The text layer’s stroke thickness in pixels.
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NOTE: If the text layer has different stroke width settings for each character, this attribute returns the setting for 
the first character. Also, if you change the value, it resets all characters in the text layer to the specified setting.

Type

Floating-point value (0 to 1000, inclusive); read/write.

TextDocument text attribute
textDocument . text

Description

The text value for the text layer’s Source Text property.

Type

String; read/write.

TextDocument tracking attribute
textDocument . t racking

Description

The text layer’s spacing between characters.

NOTE: If the text layer has different tracking settings for each character, this attribute returns the setting for the 
first character. Also, if you change the value, it resets all characters in the text layer to the specified setting.

Type

Floating-point value; read/write.
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TextLayer object
app.projec t . item(index) . layer( index)

Description

The TextLayer object represents a text layer within a composition. Create it using the LayerCollection object’s 
addText  method; see “LayerCollection addText() method” on page 98. It can be accessed in an item’s layer 
collection either by index number or by a name string. 

• TextLayer is a subclass of AVLayer, which is a subclass of Layer. All methods and attributes of AVLayer and 
Layer are available when working with TextLayer. See “Layer object” on page 86 and “AVLayer object” on 
page 38.

AE Properties

TextLayer defines no additional attributes, but has the following AE properties and property groups, in 
addition to those inherited from AVLayer:

Text  
S ource  Text
Path Opt ions

Path
Reverse  Path
Perp endicular  To Path 
Force  Al ignment  
First  Marg in 
L ast  Margin  

More Opt ions  
Anchor  Point  Grouping 
Grouping Al ignment  
Fi l l  & Stroke 
Inter-Charac ter  Blending 

Animators

Unused Properties and Attributes

The Time Remap and Mot ion Trackers properties, inherited from AVLayer, are not applicable to text layers, 
and their related AVLayer attributes are not used: 

canSetTimeRemapEnabled 
t imeRemapEnabled 
t rackMatteType 
isTrackMatte  
hasTrackMatte
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Viewer object
app.ac t iveViewer 

Description

The Viewer object represents a Composition, Layer, or Footage panel. 

Example

This maximizes the active viewer panel, and displays its type if it contains a composition:

var  ac t iveViewer = app.ac t iveViewer ;
ac t iveViewer.maximized = true ;
i f  (act iveViewer. typ e  == ViewerTyp e.VIEWER_COMPOSITION)

aler t("C omposit ion panel  i s  act ive. " ) ;

Attributes

Methods

Viewer active attribute
v iewer.ac t ive

Description

When true, indicates if the viewer panel is focused, and thereby frontmost.

Type

Boolean; read-only.

Viewer maximized attribute
v iewer.maximized

Description

When true, indicates if the viewer panel is at its maximized size.

Type

Boolean; read/write.

Attribute Reference Description

type “Viewer type attribute” on page 190 The type of content in the viewer.

ac t ive “Viewer active attribute” on page 189 When true, the viewer is focused.

maximized “Viewer maximized attribute” on page 189 When true, the viewer is at its maximized size.

Method Reference Description

setAct ive() “Viewer setActive() method” on page 190 Moves the viewer to front and places focus on it.
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Viewer setActive() method
v iewer. s e tAct ive()

Description

Moves the viewer panel to the front and places focus on it, making it active. Calling this method will set the 
viewer’s ac t ive attribute to true.

Parameters

None.

Returns

Boolean indicating if the viewer panel was made active.

Viewer type attribute
v iewer. typ e

Description

The content in the viewer panel.

Type

A ViewerType enumerated value; read-only. One of:

ViewerTyp e.VIEWER_COMPOSITION
ViewerTyp e.VIEWER_LAYER
ViewerTyp e.VIEWER_FO OTAGE
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Examples

This section describes some of the sample scripts available from the File > Scripts menu, giving an overview of 
what they do and a description of how they work. 

This set of examples is by no means exhaustive, but it does demonstrate some of scripting’s more complex 
features in action. It also shows some typical programming constructions from JavaScript that apply to 
scripting.

For more examples from Adobe and from other After Effects users, visit Adobe Exchange at http://
www.adobe.com/go/exchange/, and choose the Scripts category in the Adobe After Effects section.

New render locations
This script, Change Render Locat ions . jsx , allows the user to select queued items in the render queue and 
assign a new render destination for them.

This script does the following:

• Prompts the user for a new folder to use as a render destination.

• Checks that the user entered a new location (and didn’t cancel), then creates a loop for each selected render 
queue item, and for each output module in it.

• If an item is queued, gives the current render location a new name and location, and displays an alert stating 
the new file path.

Smart import
This script, Smart  Import . j sx, allows the user to import the full, nested contents of a folder just by selecting it. 
It attempts to detect whether each item is a still, moving footage, or an image sequence. The user still has to 
make other choices in dialog boxes, such as which layer of a multi-layer image (such as a PSD file) to import.

This script does the following:

• Prompts the user for a folder whose contents are to be imported, and checks that the user chooses a folder 
rather than cancelling. 

• Defines a function, processFolder() , to import each of the files in the chosen folder, which uses several 
helper functions.

• Defines a helper function, testForSequence() , to test whether a given file is part of a sequence. This uses 
regular expressions, which are a special type of JavaScript designed to reduce the number of steps required 
to evaluate a string. 

The first one tests for the presence of sequential numbers anywhere in the file name, followed by another 
making certain that the sequential files aren’t of a type that can’t be imported as a sequence (moving image 
files). The function then checks adjacent files to see if a sequence exists, stopping after we’ve evaluated ten 
files to save processing time.

http://www.adobe.com/go/exchange/
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If no match is found for a number string, assumes there is no image sequence and checks for an array 
consisting of the matched string and its location within the file name.

If all files are part of a numbered sequence, assumes a sequence and returns the first file of that sequence. 

• Defines a helper function to pop up error dialog boxes if there is a problem with any file we are attempting 
to import.

• Defines a helper function to actually import any image sequence discovered using testForSequence() . 
There is an option for forcing alphabetical order in sequences, which is commented out in the script as 
written. If you want to force alphabetical order, uncomment the line imp ortOptions . forceAlphabet ica l  =  
t rue.

• Calls the main function, processFolder() .

Render and e-mail
This script, Render and Emai l . j sx , renders all queued items in an open project and sends an e-mail report to 
indicate when the render has completed. It makes use of two other scripts that follow, emai l_metho ds . j sx (to 
send the e-mail properly) and Change Emai l  S ett ings . jsx (which establishes the sender, recipient, and e-mail 
server); these two scripts are in the (support) subfolder of the Scripts folder on disk.

This script does the following:

• Establishes conditions under which the script will run. An open project with at least one item queued is 
required.

• Checks whether e-mail settings are already saved in the preferences. If not, run the Change Emai l  
S ett ings . jsx script (via File > Scripts > Run Script File), which prompts the user for the mail gateway and 
sender and recipient addresses. (If there are saved settings that you need to change, you can always run the 
script to make new settings that overwrite the existing ones.)

• Render the items in the render queue. 

• When rendering is complete, creates a text string for the e-mail message that contains the start time of the 
render, the render time of each item in the queue, and the total render time.

• E-mails the message, using the settings (such as the server) from the emai l_metho ds . j sx script 

• Displays an error if for any reason it is unable to send the mail.

A helper script, emai l_metho ds . j sx , creates an e-mail object, using the ExtendScript Socket object. For details 
of that utility, see the Creative Suite 6 JavaScript Tools Guide.

Another helper script, emai l_setup. jsx , prompts the user for the server name, e-mail sender, and e-mail 
recipient that are saved as Settings. You can run this script as standalone any time you want to change the 
settings. This script is a good example of how to create settings that are saved in preferences for the sole use of 
scripting (as opposed to altering existing After Effects preferences settings).

Convert selected properties to markers
This script, C onver t  S elected Proper t ies  to  Markers . j sx , goes through the properties in each layer that are 
currently selected in the Timeline panel, and converts the value of each property at each frame time to a Flash 
Video event cue point in a marker. 



193

Examples Convert selected properties to markers 

193 

This script adds a layer-time marker on the layer at the same time as each keyframe for each selected property. 
Each marker is associated with an event-type Flash Video cue point, and the cue point is given a parameter 
whose name is the name of the property and whose value is the property’s value at that time. If the selected 
property has an expression, a marker is created for each frame, with the values sampled at each frame. 

Note: This script does not convert properties that have complex value types, such as the Path property for a paint 
stroke, the Curves property of a Curve effect, or a gradient property. 

When you render the composition as Flash video, all markers that contain cue-point data are converted to 
Flash Video cue points.
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